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1 General

 

Overview

The  FAG  Detector  III  is  a  vibration  measuring  device,  data  collector  and
operational  balancing  device  in  one.  Together  with  the  FIS  Trendline  3
software,  the  device  allows  improved  planning  of  maintenance  and  increased
machine availability.

Machine vibrations are a good indicator of a  machine's  condition. With  the aid  of
Detector III, you can monitor machine vibrations according to ISO 10816 and roller
bearing  condition  by means  of  the  demodulation  detection  method.  The  base
curve  and  demodulation  signals  stored  in  the  system  can  then  be  used  to
analyze the  signals  in  the  time  and  frequency range.  This  permits  detection  of
alignment errors and imbalance as  reliably as  roller bearing damage or gearing
problems. Other process  parameters  that can be recorded are temperature and
rotational speed.

Applications

Measuring and analyzing machine condition
The FAG Detector III records vibration signals at pre-defined measuring points  by
means  of  a  sensor  and  then  calculates  the  effective  values  for  velocity,
acceleration  and  demodulation.  These  characteristic  values  describe  the
condition of the machine and component.

You can define and monitor frequency bands  of any frequency width in  the range
from 0.1 Hz to 20 kHz. FAG Detector III can save up to 1600 measuring points  and
up  to  270  time  signals.  Once  a  measuring  round  has  been  finished,  all  data
recorded  are  transferred  to  the  Trendline  software,  where  they  are  evaluated,
analyzed and displayed.

214

22

269
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Balancing with the Detector III (available as accessory function)

There  are  many  and  diverse  reasons  for  unscheduled  machine  standstills.
However,  a  considerable  number  of  these  is  due,  directly  or  indirectly,  to
imbalance or alignment errors. During operation,  imbalance  may cause  severe
vibrations that can lead to consequential damage, for example premature bearing
wear  or  fatigue-induced  breaks.  The  result  is  machine  failure  and  thus
unscheduled production downtime.

The FAG Detector III is  a  tool  with  which you cannot only detect but also  remedy
such  conditions  easily  and  efficiently.  The  easy  user  interface  provides  good
support during the balancing process. Step by step, the  device  software  guides
the user through the balancing process. The user can create a configuration  for
each balancing process  with  the Trendline software. Furthermore, he can define
templates that can be adapted on site on the machine. The balancing results  are
sent to  the Trendline software. You can display them  there in  table  form  or as  a
diagram.

Analyzing data with the Trendline bearing database

The  integrated  bearing  database  (approx.  20,000  bearings  from  various
manufacturers)  simplifies  and  speeds  up  analysis  of  measured  data  in
combination with  the FIS Viewer. It allows  you to  detect  any irregularities  at  first
glance and assign the appropriate  components. You can save multiple  bearings
per  measuring  point.  This  allows  you  to  check  multiple  bearing  ball-pass
frequencies at a measuring point. Every user can add new entries  to  the bearing
database to suit individual needs.
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1.1 Safety information
The  Detector  hardware  is  manufactured  in  accordance  with  the  approved
standards  and guidelines  (see  Declaration  of  Conformity in  the  PDF  appendix)
and  is  safe  for  operation.  Nevertheless,  the  device  may  pose  certain
unpreventable residual risks to users and third  parties  or objects. Therefore, it is
essential  that  all  safety information  contained  in  this  manual  is  complied  with.
Moreover,  the  universal  safety  and  accident  prevention  regulations  must  be
considered.  Non-compliance  can  endanger  the  health  and  life  of  persons  or
cause material  damage.  The  safety information  in  this  manual  are  valid  in  the
Federal  Republic of Germany. In  other  countries  are  the  relevant  national  rules
valid.

Please  note  the  special  security  information,  which  can  be  found  at  the
beginning of the corresponding chapter or next to the individual steps.

Operating staff

Certain  features  of  the  Detector,  e.g.  balancing,  may  be  performed  only  by
accordingly trained staff.
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1.2 Hazard symbols and signal words

Hazard symbols used

Safety and hazard  information  is  characterized  by standardized,  specific  hazard
symbols. If no specific symbol applies, a general hazard symbol is used instead.

General hazard symbol

DANGER Type and source of the danger are described here

Measures to prevent the danger are explained here.

Specific hazard symbols

DANGER ELECTRICAL SHOCK HAZARD!

This symbol represents the electrical  shock  hazard which
can  lead  to  personal  injury  including  death  or  material
damage.

Signal words used

Signal  words  indicate the severity of danger  given  if  the  measures  for  reducing
damage are not observed.

Caution: Slight material damage can occur.

Warning: Slight personal injury or severe material damage can occur.

Danger: Personal injury can occur. In especially serious  cases  there is  danger
to life.
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1.3 About this documentation
This  documentation  describes  the  functionality  of  the  Detector III  and  the
Trendline software. It explains:

how to  create configurations  or  measuring  routes  on  a  computer  and
transfer these to the Detector;

how to use the device to perform measurements;

how to transfer data from the Detector to the computer and 

how data can be analyzed and stored.

The PDF appendix also contains  a brief description  of  the  subject  Temperature
measurement  with  the  Detector III.  An  introduction  to  the  basic  principles  of
vibration  monitoring  as  PDF  is  on  the  delivered  CD-Rom  (see  "General
information on vibration monitoring").

Please read these instructions  carefully prior to  the start-up and keep them  in  a
safe place. Ensure that 

these instructions are available to all the users,

these instructions are included when the product is transferred to other users,

any  additions  and  changes  provided  by  the  manufacturer  are  always
included. 

Symbols used

This symbol indicates

helpful additional information and

device settings or application tips that help  you perform
tasks more efficiently.

Cross  reference  symbol :  This  symbol  refers  to  a  manual  page  containing
further  information.  When  reading  the  manual  in  PDF-format  on  the  computer
screen you can jump to  that page by simply clicking on the word to  the left of the
symbol.

53 112

277

12
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Product description

2 Product description

Detector III is  a  hand-held measuring instrument with  data recording function for
offline  monitoring  of  systems  and  machinery  (condition  monitoring).  For  this
purpose, the instrument senses  vibrations  at  pre-determined  measuring  points
using a Detector and works  out the RMS values  of vibration velocity, acceleration
in  vibration  and  demodulation,  the  so-called  characteristic  values,  for
characterizing  machine  or  component  condition.  In  addition,  Detector can
measure temperatures using an infra-red sensor.

Once  a  round  of  measurements  is  complete,  the  measured  characteristic
values and any recorded time signals are transferred to a computer where they
are evaluated, analyzed and graphed using the Trendline software .

The exact location of the measuring point within  the system  to be monitored is
stored in the configuration . There, the sensor sensitivity for each measuring
point and the threshold values for main or preliminary alarm are stored as  well.
The configuration is created using the Trendline software  and transferred to
the Detector prior to measuring.

For  the  measurement,  the  vibration  sensor  is  attached  to  a  pre-determined
measuring point with the help of a magnet footing. If this  is  not possible  due to
the housing material (e.g. aluminum), attach an iron plate or a  washer the size
of the magnetic at the measuring point. This  is  easiest done with  the help of a
fast-curing superglue (e.g. cyan acrylate glue).

The configuration of the measuring point  is  selected  on  the  Detector and  the
measuring started. Detector records the sensor signals  broadband and works
out  the  characteristic  values.  These  characteristic  values  are  stored  and
transferred to the computer once the measuring round is finished.

For  each  measuring  point,  the  newly  measured  characteristic  values  are
compared with  the threshold values  determined for this  measuring point for a
main  alarm  and  pre-alarm.  The  Detector  (main  alarms)  and  the  Trendline
software  (main  and  pre-alarms)  display  the  threshold  events.  New
characteristic  values  are  stored.  You  can  depict  them  graphically  in  the
Trendline software depending on time of measuring.

In addition to the condition monitoring measurement (subsequently referred to  as
 CM measurement ) the Detector III also masters  what is  known as  operation
balancing. During this  process  the Detector helps  you find the optimum  position
of  balancing  weights  when  performing  the  balancing  measurement .  These
weights  serve  to  compensate  for  imbalances  in  rotating  parts  and  therefore
extend their service life.

22

53

22

223

234
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2.1 Intended use

The  Detector  as  well  as  the  associated  components  are  not
admitted for the use in residential areas!

Detector  devices  must  only  be  operated  within  the  limits  specified  in  the
Technical  data  to  the  extent  provided,  the  limits  of  use  of  the  individual
components must always be taken into consideration too.

Any other use exceeding the above is  deemed unintended and the user will  bear
the full risk associated with it. The user is  responsible  for the intended use. This
includes the compliance with these instructions.

Information to the user

Changes  or  modifications  not  expressly approved  by the  party  responsible  for
compliance could void the user's authority to operate the equipment.

Note: This  equipment has  been tested and found to  comply with  the limits  for  a
Class  A digital  device,  pursuant  to  part  15  of  the  FCC  Rules.  These  limits  are
designed to provide reasonable protection against harmful  interference when the
equipment is operated in a commercial  environment. This  equipment generates,
uses, and can  radiate  radio  frequency energy and,  if  not  installed  and  used  in
accordance with the instruction manual, may cause harmful  interference to  radio
communications.  Operation  of  this  equipment  in  a  residential  area  is  likely  to
cause harmful interference in  which case the user will  be required to  correct the
interference at his own expense.

Industry Canada

This Class A digital apparatus complies with Canadian ICES-003.

2.2 Modifications by the user
The  user  may not  carry out  any modifications  to  the  hardware  of  the  Detector
device.  The  user  is  merely allowed  to  make  setting  changes  to  the  device  by
means  of the Trendline software.  For  modifications  in  exceeds  to  this  the  user
bears  all  responsibility!  Should  you  encounter  a  defect  in  your  Detector  please
contact your customer adviser .

15

277
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2.3 Technical data

Device name FAG DETECTOR III, DETECT3-KIT

Inputs 2 * BNC connectors (multiplex er)

ICP (4,7 mA), arbitrary  configurable sensitiv ity

AC/DC ±5 V, impedance >100 kOhm

1 * AUX

Tachometer input 5 up to 24 V, 30-9999 RPM (rising or falling edge

selectable)

IR-temperature sensor ±5 V, impedance >100 kOhm (freely

configurable)

Battery  charger

Vibration measurements

Outputs Headset (env elope signal)

RS 232 for data transfer (38,4 kbps; 57,6 kbps)

AUX: supply  trigger sensor (5 V max . 200 mA, 12 V max . 50 mA)

Measuring ranges Acceleration / v elocity  0,1 Hz to low pass

0.1 Hz to 200 Hz; 0.1 Hz to 500 Hz; …

Demodulation 0 Hz until low pass

Low passes 200 Hz, 500 Hz, 1 kHz, 2 kHz, 5 kHz, 10 kHz, 20 kHz

Highpass (demodulation branch) 750 Hz

Temperature -20 °C to +550 °C (temperature range depends on the

used sensor, freely  configurable input)

Characteristic values A
eff

 (2 kHz to low pass), RMS v alue of the v ibration acceleration

A
sel

 RMS v alue of the v ibration acceleration in a freely  configurable

frequency  range

ISO 10816 (10 Hz to 1000 Hz), RMS v alue of the v ibration v elocity

V
sel

 RMS v alue of the v ibration v elocity  in a freely  configurable

frequency  range

D
eff

 (frequency  range depends on low pass frequency ), RMS

v alue of the demodulation signal

D
sel

 Effectiv e demodulation signal in a freely  configurable

frequency  range 

Crest factor, rotational speed, temperature, univ ersal

Window type Hanning

Averaging in frequency range 1–9 (FFT, characteristic v alue per channel)

Sampling rate Linear

max . 51,2 kHz, depending on the configured low pass frequency

(configured low pass * 2,56)
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A/D converter 16-bit (auto ranging)

Dy namic range >90 db

Frequency resolution 1600, 3200 lines (0.0625 Hz up to 12.5 Hz depending on the

configured low pass frequency )

Balancing

1 or 2 plane balancing

Weight positions: continuous (0 to 359°) or discrete (4 to 99

positions)

Remov e trial w eights: y es/no

Balancing measurement type Acceleration, v elocity , displacement

Measurement Peak, Peak – Peak, RMS

Balancing units g, mm/s, inch/s, µm, mil

Weights units g, oz (up to 99 999,99 g / oz)

Automatic measuring point detection (RFID)

Radio frequency 13.65 MHz

RFID standard ISO 15693

Product must only be operated

in

European Union (EU), Sw itzerland, USA, Canada, Australia

General

Separate measurements Temperature, rotational speed, headset (env elope signal)

Keyboard Membrane key board w ith 21 key s

Display Backlit graphic display  (LCD) 128x  64 pix els,

dimension 55 x  33 mm

Memory 1600 measuring points plus 270 time signals (max imal 300 time

signals)

Power supply NiMh 2 000 mAh

Voltage 6V

Operation time approx . 6 to 8 hours (charging time for empty  battery

approx . 4 h)

Size and weight 230 x  70 (53) x  45 (53) mm (L x  W x  H), approx . 500 g (including

battery )

Temperature range 0 to 50 °C (operating temperature)

0 to 40°C (to load the charger)

-20 to +70 °C (storage and transport temperature)

Operation time approx . 6 to 8 hours continuous operation



17

Product description

Housing ABS, IP 40

Protective bag Tw o compartments, black ny lon material 2 w indow s w ith foil

cov er, openings w ith Velcro strip fastener Velcro strip ties for cables

and sensor, carry ing strap

EMC standards EN60950-1, EN61000-4-2, EN61000-4-3, EN61000-4-6

Firmware Free firmw are updates on the Internet

Av ailable languages: German, English, Finnish, French, Italian,

Dutch, Polish, Portuguese, Sw edish, Slov enian, Spanish and

Turkish

Software FIS Trendline (updates on the Internet)

Av ailable in: German, English, French, Portuguese and Spanish

– Configuration of the FAG Detector III v ia RS 232-interface

– Bearing database w ith ca. 20 000 bearings

– Graphical display  of the measured v alues and trends

– Trend analy sis

– View  of time signals and FFTs

– Tabular and graphic v iew  of the balancing data

– Configurable report tool

Subject to technical modifications!
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2.4 Scope of delivery

DETECT3-KIT

Base unit with accumulator

Accelerometer with magnetic foot

Infrared temperature sensor

Battery charger with travel adapter

PC data cable (serial/USB)

Manual

Protective bag with temperature sensor holder

Trendline PC software

Case
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DETECT3.BALANCE-KIT

Acceleration sensor with magnetic foot and sensor cable

Trigger sensor (optical and inductive)

Scales

Magnetic holder for trigger sensor

Extension stick for magnetic holder

Cable for trigger sensor (length 10 m)

Reflex mark for optical trigger sensor

Dongle for activating the balancing function

Case
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RFID KIT

Base unit with accumulator and RFID reader

5 RFID tags: 

2 units FIS.DETECTORIII.RFID.TAG.KEY

3 units FIS.DETECTORIII.RFID.TAG.DOME (specially for metallic
foundations)

Accelerometer with magnetic foot

Infrared temperature sensor

Battery charger with travel adapter

PC data cable (serial/USB)

Manual

Protective bag with temperature sensor holder

Trendline PC software

Case

Accessories

Sensor extension cable (5  m  and 15 m  length), sensor bases  and rail  magnets
are available on request.

Optional accessories

In  connection  with  the  Detector  device,  FAG  Industrial  Services  offers  a  wide
range of optional accessories. Please contact your customer adviser .277
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3 Before you start

The  RFID  kit  or  RFID  Detector  up  to  version  F3  is  delivered  with  three  snap
ferrites.  These  must  be  attached  to  the  three  sensor  cables  (cables  for  the
acceleration sensors as well as trigger sensors) of the Detector.

Snap-on ferrite

Ferrites prevent electromagnetic disturbances from  the Detector
from affecting other electronic devices nearby.

From  RFID  Detector  version  F4  snap  ferrites  are  no  longer
needed.

Attach ferrites 

Lay the sensor cable in the groove of the snap-on ferrite.

Arrange the cable as  shown in  the picture below. Please note that the ferrites
must be attached as closely to the Detector as possible.

Close the snap-on ferrite so that it is tightly around the cable and snaps.

Ferrites attached to sensor cables
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4 Trendline 3

The  Trendline  software  is  the  server-based  program  for  the  Detector III.  The
Detector  itself  is  designed  only for  the  recording  of  measured  values.  All  data
organization and evaluation tasks are carried out by the Trendline software.

The software is  configured to  monitor a  system  as  well  as  evaluates,  analyses,
and stores the measured data collected by the Detector. 

Further, Trendline 3 manages the exchange of data between the server on which
the software is running and the Detector.

The  Trendline  software  version  3.6  operates  only  with
the Detector firmware 3.6. 

If  your  Detector  has  a  lower  firmware  version,  please
update the Detector's firmware .

4.1 Program installation
This chapter describes the installation of the Trendline software.

The Trendline software requires the MS SQL database server. It must be installed
either on the local  computer or on a network server. If you  are  already using  an
MS SQL database server (see "System  requirements" ),  you  can  register  the
CM databases with this.

4.1.1 System requirements

In order to use the Trendline software in an optimum way, the following minimum
requirements must be met:

General system requirements

Pentium III PC with 500 MHz (recommended: 1 GHz)

At least 512 MB RAM (recommended: 1 GB; Windows 7: 64 Bit version)

Screen resolution: 1024x768 (pixels)

Operating systems

Trendline software 3.6: Windows XP SP3, Windows 7: 64 Bit version
Database program MS SQL Express 2005: at least Windows XP SP3 or
Windows 7: 64 Bit version

MS Windows Server operating systems are not supported.

267
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Hard disk memory for installing the Trendline software

Trendline software 3.6 (without database and database server): 62 MB

Detector Flash Updater: 4 MB

Demo database and bearing database: 20 MB

Hard disk memory for installing the database server

MS SQL Express 2005: 525 MB

Hard disk memory for the database

MS SQL Express 2005: at least 4 GB (recommended: 10 GB)

Other requirements

Microsoft Internet Explorer 6.0 SP1 or later

MS SQL database program

If you are already using a MS  SQL  database  program,  you  can  register  the  CM
databases with this. You can use the following versions:

MS SQL Server 2000 (requires a commercial license)

MSDE (free version of MS SQL Server 2000 with limited functions)

MS SQL Server 2005 (requires a commercial license)

MS  SQL  Express  2005  (free  version  of  MS  SQL  Server  2005  with  limited
functions).

A database that has been updated from  MSDE or MS SQL Server
2000 to MS SQL Express 2005 cannot be re-opened with  MSDE or
MS SQL Server 2000.

Tips

Install the database program and the CM databases on a central computer that
is always available.

If  you  are  using  MS  SQL  Express  2005,  the  database  must  be  enabled  for
network access.
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4.1.2 User rights and writing access

For  installation  and  operation  of  the  Trendline  software  you  need  special
permissions. For problems  with  the safety requirements  of your system,  please
contact your system administrator.

User rights

For the installation of the Trendline software you need administrator permission
on your system.

Tip: Install the software with  administrator permission and
then switch back to a normal user.

Writing access

The Trendline software saves  settings  and log files  during  operation.  You  must
have write access to the following default directories:

Using Windows XP SP3

C:\Users\All Users\Application Data\Condition Monitoring\

C:\Users\User\Local Settings\Application Data\Condition Monitoring\

Using Windows 7: 64 Bit version

C:\Program Data\Condition Monitoring\

C:\Users\User\AppData\Local\Condition Monitoring\

4.1.3 Installation Trendline software

Please insert the installation CD in  your CD-ROM. If you do  not  have  a  CD,  you
can download the current version of Trendline software from  our  website  (www.
fis-services.com) in the "Downloads" section. 

The installation directory on CD-ROM can be opened as  follows  in  the Windows
Explorer:

Open My computer.

Under Equipment with removable media, right-click the CD-ROM drive and

then click Open.

Open the directory "Trendline 3.6" and

select one of the following installation types.

http://www.fis-services.com
http://www.fis-services.com
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Installation type

The Trendline software can be installed in various ways. You can

install  the software completely on a local  computer (recommended for default
users)

or

distribute it to different computers (e.g. in a network).

If  you  want  to  install  components  individually,  e.g.  to
distribute  them  on  different  computers,  make  sure  that
these  computers  have  a  network  connection  so  that  the
components  can  communicate  with  each  other.  In  any
case  the  CM  databases  must  be  registered  on  the
computer where the database program is installed.

The following installation types are available:

Complete setup

All software components including databases will be set up on the system.

Start the installation file "Trendline-Setup*.exe" with double-click.

The Trendline Setup Wizard  guides you through the installation.

Database setup

Only the database installations (Database program  optional  with  databases) will
be set up on the system. 

Start the installation file "TrendlineDatabases-Setup*.exe" with double-click.

The Database Setup Wizard  guides you through the installation.

Flash Updater setup

Only the  Flash  Updater,  to  update  the  Detector  firmware,  will  be  set  up  on  the
system.

Start the installation file "DetectorFlashUpdater*-Setup.exe" with double-click.

The Flash Updater Setup Wizard  guides you through the installation.

26
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Parts  of  the  Trendline  software  will  need  the  Windows
component MS .NET Framework  2.0. If this component is
not installed on the system, it is automatically installed.

Below, the complete installation of the Trendline software will be described.

4.1.3.1 Trendline Setup Wizard

1. Please select the language to  install  the Trendline software. You  can  change
the language settings  at any time after installing.

2. Accept the license agreement and click Next to proceed with the installation.

3. Select the directory where you want to install the software and click Next.

4. Select the start menu directory and click Next.

146
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5. Optionally you  can  select  additional  components  for  installation.  Select  from
the list:

• Flash Updater to install a program for Detector firmware updates

• Database  installations  to  install  the  demo  database  and/or  bearing
database

6. and click Next.

7. In the next window check your settings  and click Install or click Back  to  correct
your settings.

The Trendline software will be installed.

8. Click Finish to exit Trendline installation.

If  you  selected  additional  components  for  installation,  please  change  to  the
chapter  "Flash  Updater  installation"  respectively  "CM  database  installation"

.

Please restart your system after all installations have been completed!

28

28
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4.1.3.2 Detector Flash Updater Setup Wizard

If  you  selected  "Flash  Updater"  when  you  installed  the  Trendline  software,  the
Setup Wizard automatically starts the installation. 

1. Select the directory where you want to install the software and click Next.

2. Select the start menu directory and click Next.

3. Optionally, you can add program  icons  on the  desktop  or  to  the  quick  launch
bar. To do so, check the checkbox next to the option

• Create a desktop icon to add a shortcut on your desktop

• Create a Quick Launch icon to add a symbol to the Quick Launch bar next to
the Start button

4. and click on Next.

5. In  the next window check your settings  and click Install  to  install  the  Detector
Flash Updater or Back to correct your settings.

The Detector Flash Updater will be installed.

6. Click Finish to exit the Flash Updater installation.

4.1.3.3 Database Setup Wizard

If  you  selected  "Database  installations"  when  you  installed  the  Trendline
software,  the  Setup  Wizard  automatically  starts  CM  database  installation.  The
Setup  Wizard  helps  you  to  install  the  database  program  and  to  register  the
databases that are necessary for the operation of the Trendline software.
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If no database program  or  CM database  is  installed  on
your  computer  yet,  the  following  databases  are
automatically installed:
- demo_online: CM database with demo data
- cm_bearings: Bearing database

Each  new  added  database  will  be  marked  by  a
sequential number.

Click Next to proceed with the installation.

The  following  installation  depends  on  whether  you  already  have  a  MS  SQL
database program or not.
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Select  Install  SQL  Express  and  register  the  databases,  if  no  MS  SQL
database  program  is  installed  on  your  system  and  if  you  want  to  install  the
database program with databases on your system.
Please read the section "Database program does not exist" .

Or:

Select  Install  SQL  Express  only,  if  you  want  to  set  up  only  the  MS  SQL
database program on your system. 
Please read the section "Database program does not exist" .

Or:

Select  Register  databases  on  an  existing  SQL  Server  (or  MSDE/SQL
Express), if a  MS SQL database program  (see "System  requirements" )  is
already set up on your system  and you want to  register only the databases  on
it. 
Please read the section "Database program exists" .

Database program does not exist

If  no  MS  SQL  database  program  is  installed  on  your  computer,  the  database
program  and  optionally  the  databases  will  be  automatically  installed  and
registered.

30

30

22

33



31

Trendline 3

The Setup Wizard shows the name of the server instance that is created.

1. Click Next.

For the installation and administration of the server instance  the  administrator's
password  for  the  user  "sa"  is  required  (for  more  information  see  "Users  and
passwords" ).91
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2. Accept the default password "CM_services$1sa" or enter  your  own  password
for the server instance.

If  you  want  to  assign  your  own  password  for  the
administrator  user  "sa",  please  use  a  password  that
meets the security policies of your  computer.  This  can
be,  for  example,  a  strong  password  with  at  least  10
characters,  upper  and  lower  case  and  alphanumeric
and special characters.

We  recommend  to  note  the  user-defined  password  in
your records.

3. Click Next.

If you selected the installation with  databases, you can select which database(s)
should be registered in the next step.

4. Select  the  database(s)  which  should  be  installed  and  registered  at  the
database server and

5. click Next.

The  database  program  will  be  installed  and  the  selected  databases  will  be
registered (attached) automatically.

6. Click Finish, to exit installation.
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Database program exists

If you already have a MS SQL database program  (see "System  requirements"
), only the databases  must be installed and registered on the server. To access
your own database server you need the administrator password.

The  Setup  Wizard  shows,  which  server  instances  are  already  set-up  on  the
computer.

With a new installation from  FIS Trendline version 3.4 the name of
the server instance is "CM_DATABASE". In  previous installations, it
is called "FIS_DATABASE".

1. Select the server instance.

2. Click Next.

22
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For  installation  and  registration  of  databases  at  the  server  instance  the
administrator's password for the user "sa" is  required (for more information see
"Users and passwords" ).

3. Enter the administrator password for the server instance.

4. Click Next.

91
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5. Select  the  database(s)  which  should  be  installed  and  registered  on  the
database server.

6. Click Next.

The selected databases will  be installed and registered (attached) on the server
automatically.

7. Click Finish, to exit installation.

4.1.4 Update

The  Trendline  software  can  check  in  user-defined
intervals whether an update for the  Trendline  of  Detector
firmware  is  availab le  for  download  from  our  Internet
server (see "Automatic notification of updates" ).

You can update the Trendline software and its components:

Update Trendline software

To update an existing Trendline software, proceed as follows:

Make a backup copy  of your database(s),

uninstall  the Trendline software and

run the Trendline setup . 

The Setup Wizard guides you through the installation.

Update database in the Trendline software

If you want to use an existing database with  the current Trendline version, it must
possibly be  updated.  When  connecting  to  a  database,  the  Trendline  software
automatically checks  the  version  number  of  the  database  and  provides  update
information if necessary. See chapter "Update database" .

Update Flash Updater software

If you want to update the Detector Flash Updater, proceed as follows:

Uninstall  the Flash Updater software and

run the Flash Updater setup . 

The Setup Wizard guides you through the installation.

Update Detector firmware

If you want to  update the firmware of the  Detector,  you  need  the  Flash  Updater.
See chapter "Update firmware" .
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4.1.5 Uninstalling

Please note that configuration and export files are left  on
your  computer.  For  your  safety,  the  database  program
and database(s) will  not be deleted either. To completely
uninstall, you must delete these files manually.

Uninstall Trendline software

To uninstall  the Trendline software please click  in  Programs  >  FIS  >  Trendline
3.6 on Uninstall Trendline.

Uninstall Flash Updater

To  uninstall  the  Detector  Flash  Updater  please  click  in  Programs  >  FIS  >
Detector Flash Updater on Uninstall Detector Flash Updater.

4.2 Start program
Click Start > Programs > FIS > Trendline 3.6 > Trendline.

The Trendline software is starting.

When  the  Trendline  software  starts  the  first  time,  you  can  configure  automatic
notifications for software updates.

If  you  have  set  up  the  Trendline  software  without  database  program  and
databases, please select the CM database on the server .

4.2.1 Automatic notification of updates

The Trendline software can check in user-defined intervals whether an update for
the  Trendline  of  Detector  firmware  is  available  for  download  from  our  Internet
server. The following results are possible:

No update information could be obtained, for example, due to  a  problem  with
the Internet connection.

The Trendline version installed is up-to-date.

A newer version of the Trendline software is available.

The firmware on all Detector devices registered in the database is up-to-date.

There  is  a  newer  firmware  version  for  at  least  one  of  the  Detector  devices
registered in the database.

93
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No data is transmitted to FAG Industrial  Services GmbH during the
update check. The Trendline software only compares the version of
your installation with the version currently availab le on our server.

Configure automatic notifications of updates

You can configure the automatic notification the first time you start the program. If
you want to adjust the settings at a later time, click in  the Trendline tools  menu at
Options and select Update > Update settings from the list.

Under  Time  interval  you  can  enter  how  often  the  Trendline  software  should
check for updates. The default setting is weekly.

If your computer is connected to the Internet via  a  proxy server, activate the Use
proxy server  setting and enter the IP address  or the server name as  well  as
the  port  number  you  are  using.  If  you  have  any  questions  about  the
configuration, please contact your system administrator.

If you activate the Show message, if no version information could be retrieved
option, the Trendline software will  also display a  message  even  if  no  update
information was found.
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You  can  change  the  setting  for  the  automatic  notification  in  the
program settings (see Updates ) at any time.

Updates were found

If  updates  were  found  for  the  Trendline  software  or  Detector  firmware,  the
download  address  will  be  displayed.  If  a  firmware  update  is  available,  the
Trendline  software  also  displays  the  registered  Detector  devices  and  the
firmware version installed on each  device.  This  allows  you  to  quickly recognize
which devices require a firmware update.

Connection could not be established.

If  no  update  information  was  found,  for  example,  due  to  a  problem  with  the
Internet  connection,  you  can  deactivate  this  message  for  future  queries.  To  do

150
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this, check the box Don't show this message again.

Manual query

To manually start the update of the Trendline software or Detector firmware, click
on

Extras > Check for Trendline updates (Trendline) or

Detector > Check for firmware updates (Detector).

4.2.2 User interface

4.2.2.1 Main window

At the top edge of the main window you will  find the menu bar . Here you can
access  the  various  program  functions  with  the  different  menu  bar  items.
Frequently used functions  can also be activated using the buttons  in  the  toolbar

.

On  the  left-hand  side  of  the  window  the  structure  of  the  configuration  for  the
system you are monitoring is displayed in the form of a directory tree. The highest
structural  element are the "Configurations", which are  split  in  descending  order
into  the  levels  "Section",  "Machine"  and  "Measuring  Point".  This  ensures  that  a
measuring point within a configuration is clearly defined by its name and name of

40
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the machine where the measuring location is  located and the section where the
machine is located.

Next to  the name of each element of the configuration and system  structure  you
will find a box that is  highlighted in  color. This  indicates  the alarm  status  for this
part of the system as shown in the following table.

Color Meaning

For this lev el of the sy stem structure no alarm is recorded.

For this lev el of the sy stem structure a preliminary  alarm w as signaled.

For this lev el of the sy stem structure a main alarm is recorded.

This lev el has just been created or 

the alarm is not ready  configured or has been canceled.

An RFID tag has been assigned to this measuring point.

An RFID tag in this part of the sy stem has been marked as defectiv e.

On  the  right-hand  side  next  to  the  configuration  and  system  structure  you  can
insert an image. At the highest level  you will  find the tab sheets,  where  you  can
adjust the settings of the individual measuring points.

The  dividing  line  between  the  image  of  the  configuration  and  system  structure
can be shifted towards the right or left by dragging with the mouse.

In  the configuration structure, always one element is marked.  The
properties of this element are depicted in  the right-hand part of the
window.

4.2.2.2 Menu and toolbar

Menu bar

The menu bar allows access to the following functions of the Trendline software:

Menu Menu items and function

File New Creates a new  database.

Open Opens an ex isting database.

Import Loads records ex ported w ith Trendline.

Ex port
Ex ports part of a current measuring point structure using the Ex port

Wizard  or ex port a single measuring point .

Recently  used Trendline display s recently  used databases at this point in the menu.

137 138
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Menu Menu items and function

databases You can specify  the number in the program settings .

Close Quits the Trendline softw are.

System
To root lev el

Takes y ou from y our current position in the tree right back to the

beginning, all the time.

Rename Rename currently  selected element.

New  item
Inserts an element of the configuration structure in the same lev el as

currently  display ed.

New  sub-item
Inserts an element of the configuration structure in the lev el below  the

current.

Add balancing

configuration
Inserts a balancing configuration.

Add amplitude/

phase configuration Creates an amplitude/phase configuration.

Add run up / coast

dow n configuration Creates a run up/coast dow n configuration.

Ex pand selection Flaps up all elements under the current element.

Collapse selection Closes the complete tree structure.

Cut Cuts out the current element of the tree.

Copy Copies the current element of the tree.

Paste

Pastes the element on the clipboard into the current position in the

tree. This is only  possible in the tree lev el abov e that of the copied

element. For ex ample, w hen copy ing a machine, this can only  be

pasted into the plant lev el of the tree.

Delete entry Deletes the current entry  in the tree w ith all sub-entries.

Delete measured

data
Deletes measured data from the current position.

Reset alarm status

 

Reset all alarms for the element of the configuration and sy stem

structure selected.

Adjust alarm limits Automatic adjustment of the alarm limits.

Sav e configuration

as template

Sav es a configuration as template so that it can be used for free

measurements.

Create new

configuration from

template

Creates a new  configuration from a template.

Detector
Send configuration

Send all measuring points from currently  selected element

dow nw ards to Detector.

148

69

76

82

124

124

87

111

111



42

Menu Menu items and function

Send route/template Sends one of the pre-selected routes/templates to the Detector.

Load data from

Detector

Opens a connection to the Detector and dow nloads all data stored in

the Detector.

Configure Detector Allow s to set all options to the Detectors registered.

Balancing activ ation Enables the balancing function on the Detector.

Load Detector logfile Retriev es the log file from the Detector and sav es it.

Check for firmw are

updates

Checks w hether a new er Detector firmw are v ersion is av ailable for

dow nload.

Sensor Adds , edits and deletes sensors.

Comment selection

list
Create and edit a list of comments.

Planning Route Creates and edits routes.

Template
Defines and edits configuration templates that can be used for free

measurements.

Service E-Serv ice Sends selected data for further analy sis.

Measurement report Creates a measurement report.

Balancing report Creates a balancing report.

Amplitude / phase

report
Creates an amplitude/phase report.

Run up / coast

dow n report
Creates a run up/coast dow n report.

Alarm report Creates an alarm report.

Route report Creates a route report.

Tools Options Program settings

Bearing DB Opens the bearing database .

Deleting current

database
Deletes the Trendline database currently  opened.

Start database

administration
Opens a program to administrate Trendline databases.

Sav e Trendline log

file
Sav es the log file of the Trendline softw are.

Check for Trendline

updates

Checks w hether a new er v ersion of the Trendline softw are is

av ailable for dow nload.

? Contents Contents of the online help.

Index Search index  for the online help.
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Menu Menu items and function

First steps Start using the Trendline Softw are.

Menu bar Ex plains all menus of the Trendline Softw are.

Toolbar Ex plains all icons in the toolbar.

Info Information about the Trendline Softw are.

Toolbar

Frequently used functions of Trendline software can be used via the toolbar.

Go to root lev el Cut (Ctrl+X)

Create new  item Copy  (Ctrl+C)

Create new  sub-item Insert (Ctrl+V)

Add balancing configuration Delete

Add amplitude/phase configuration Reset alarm status

Add run up/coast dow n configuration Send configuration to Detector

Ex pand selected element Send route/template to Detector

Collapse selected element Dow nload data from Detector

Mov e selection up Alarm report

Mov e selection dow n E-Serv ice

4.2.2.3 Tree elements

In  the  system  tree  of  the  Trendline  software  you  can  cut,  copy  or  delete
configuration elements. 

Moving or copying configuration elements

You can only move configuration elements if the target is on a higher level, i.e. you
can

move or copy a measuring point (level 4) to another machine (level 3), and

move or copy a machine (level 3) to a different section (level 2).
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If  the  target  already  contains  sub-elements,  the  moved/copied
element is always appended to the end of the list.

In order to shift or copy elements the following possibilities are available:

Moving an element

Left-click  on  the  element,  keep  the  mouse  button  pressed,  and  drag  the
element onto the target element.

Release the mouse button to insert the element.

Or:

Right-click on the element and select Cut.

Right-click on the target element and select Insert.

Or:

Left-click on the element and

press the key combination CTRL+X or click on .

Left-click on the target element and

press CTRL+V or click on .

If you want to change the element order within a level, 

select the element by left-click and 

click on  or .

Copying an element

Left-click on the element while pressing the CTRL key, keep the mouse button
and CTRL pressed, and drag the element onto the target element.

Release the mouse button and CTRL to copy the element.

Or:

Right-click on the element and select Copy.

Right-click on the target element and select Paste.

Or:

Right-click  on  the  element,  keep  the  mouse  button  pressed,  and  drag  the
element onto the target element. A pop-up menu displays.

Select Move.

Or:

Left-click on the element and
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press the key combination CTRL+C or click on .

Left-click on the target element and

press CTRL+V or click on .

Deleting elements

When you delete a configuration  element,  the  element  is  deleted
along with all its sub-elements including data forever!

Right-click on the element and select Delete entry.

Or:

Left-click on the element and press Del.

Or:

Left-click on the element and

click on .

4.3 First steps

4.3.1 Adding a sensor

Before you can set up configurations, you must  define  the  sensors  you  want  to
use. Detector III is  delivered with  all  necessary sensors. They are pre-defined in
the Trendline software.

WARNING Damage to sensors when continuous operation is activated

If  you  would  like  to  connect  passive  sensors  to  the  Detector,  the
continuous operation of the sensor  must be deactivated to  avoid
damaging the sensor.

Proceed as follows to add new sensors:

In the Detector menu click Sensor > Add.

In Sensor type choose from Acceleration, Temperature or Trigger sensor.

In the Name field, enter a name for the sensor, e.g. "IMI 627".

221
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Acceleration sensor

Enter sensor sensitivity in  mV/g in  the Sensitivity field. Sensitivity is  printed on
the sensor or indicated in the enclosed specifications.

When you add an active sensor, select Active sensor and enter minimum and
maximum bias voltage in the appropriate input boxes. On the one hand, this
activates sensor supply voltage in the Detector before the measurement is
performed and activates a high pass to filter the supply voltage out of the
measuring signal. On the other hand, the Detector checks whether sensor bias
voltage is within the set thresholds. Minimum bias voltage must be at least 3,
maximum bias voltage must not be greater than 17. The difference between
the two values must not be less than 10.

If you want to measure on a power supply unit, Active sensor  must
not be enabled. In this case select AC or DC voltage.

Click OK to save the new sensor.
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Temperature sensor

Enter sensor sensitivity in mV/°C, mV/°F or mV/K and the offset in mV.

Click OK to save the new sensor.

Trigger sensor

The  trigger  sensor  serves  to  measure  rotational  speed  and  is  used  in
operational balancing to start the measurement .

Select the Supply voltage: extern, 5 V, 12 V.

234
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Click OK to save the new sensor.

4.3.2 Installing USB-serial converter

A  USB  serial  adapter  is  supplied  with  the  Detector  in  order  to  connect  the
Detector to computer via USB.

When installing the  adapter  software  make  sure  you  have  the  adapter  and  the
installation CD provided to hand.

Do not plug in the adapter!

Installation of the adapter software

To install the adapter software proceed as follows:

Insert the CD provided. The installation program should start automatically.

If the installation program  does  not start  automatically you  can  start  it  manually
using Windows Explorer:

1. Open My computer.

2. Under Equipment  with  removable  media,  right-click  the  CD-ROM drive,  then
click Open.

3. Double click to launch autorun.exe.

4. Depending  on  the  color  of  the  adapter  provided,  select  USB  TO  RS232
Converter or USB 2.0 TO RS232 Converter.
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4. Click on the folder symbol next to Product Driver.

5. Select the win_98se_me_2000_xp folder.

6. Click on Setup.exe.

This launches the installation wizard, which guides you through the installation.

Plug the adapter into a free USB port.

If  you  are  already  using  other  devices  that  use  a  Prolific  USB  to
Serial  chip, please uninstall  the drivers for the  old  devices  first  as
this may result in conflicts.

Checking serial interface settings

To  make  sure  that  communication  between  the  Trendline  software  and  the
Detector works  smoothly, you can check the USB serial  adapter  settings  for  the
serial interface:

1. Click the right mouse button on My computer then click on Properties.

2. Click  Hardware  then  Device  manager.  The  adapter  should  be  displayed  as
"Prolific USB-to-Serial Bridge" under Connections (COM and LPT).
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3. Close the Device manager.

Removing the adapter software

The adapter software can be removed as follows:

1. Go to Start, Control panel and then click on Software.

2. Click on Modify or remove program then click on PL-2303-USB-to-Serial.

3. Click on Uninstall/Change to uninstall the software.

4.3.3 Balancing activation

The Detector III is supplied ex works  with  the balancing function deactivated. You
can enable this function if you have purchased a Detector III balancing kit.

The balancing  kit  contains  a  USB  dongle  that  can  be  used  to  enable  one  unit
only.

Dongle

This activation is basically carried out as follows:

A dongle that has not previously been used is supplied with the balancing kit.

You can use this dongle to enable the balancing functionality for only one (any)
Detector.

Once enabled, the serial number of the Detector is  saved on the dongle. From
this point onwards the dongle may only be used with this specific Detector. 

You can also deactivate the balancing functionality in  the Detector, again using
the corresponding  dongle.  The  serial  number  on  the  dongle  is  then  deleted
and you  can  now  use  it  to  enable  any other  Detector  of  your  choice.  This  is
useful,  for  example,  if  you  are  sending  a  Detector  to  the  manufacturer  for
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calibration and want to use the balancing function on a different Detector in  the
meantime.

To activate the balancing  function  on  the  Detector,  start  the  Trendline  software.
Connect the Detector to the PC using the serial cable. Plug the dongle into  a free
USB port. Switch on the Detector and select  the Trendline menu item  Detector  >
balancing activation. The following window is now displayed:

The serial number of the connected Detector is  displayed at the top. The dongle
that has been identified is  displayed at the bottom. The identified version should
start  with  "3"  in  the  case  of  Detector  III.  The  serial  number  of  the  Detector  for
which this dongle has already been used or, if the dongle has  not yet been used,
Empty is  displayed in  the  Used  for  Detector:  column.  Now  select  the  required
dongle from  the Type  column (should be displayed as  "Empty"  in  the  "Used  for
Detector" column). You  can  now  enable  the  balancing  functionality via  Activate
balancing for  connected Detector. A new line Balancing should now be  visible
and the serial number of the Detector is displayed in the dongle line.

Please note the following:
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The first time the dongle is  used  Windows  detects  the  driver  that
was  previously  installed  with  the  Trendline  software.  If  Windows
asks for a driver, select the automatic search option.

If  the  dongle  is  not  displayed  or  a  previously  used  dongle
appears in the list, please click Refresh dongle list.

If  the  dongle  is  correctly  identified  by  Windows  but  this  is  not
displayed in the Trendline dongle list you may have an old  driver
installed  on  your  system.  You  can  check  this  in  the  device
manager under USB controller -> CBUSB Ver 2.0. If Version 1.x
is displayed, uninstall  this driver and install  the current driver on
the Trendline CD to the CbSetup directory. In this case select the
CRYPTO-BOX USB.

4.3.4 Register and configure new Detector

The Trendline software  uses  a  database  to  manage  all  Detectors  being  used.
Prior to  sending data to  the Detector for the first  time,  it  has  to  be  registered  to
Trendline software. To do that,  you  connect  the  Detector  to  a  serial  interface  of
your computer using the data cable supplied and switch on the Detector.

The  Detector  that  has  just  been  connected  to  the  computer  is
normally detected automatically by the system  and does not need
to be registered.

How to register a new Detector:

Click on Detector > Configure Detector.
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Connect  the  Detector  to  your  PC  and  switch  it  on.  Click  on  Search  for  new
Detector to register the new Detector on to the program. 

You  may  give  the  Detector  a  name,  which  will  be  displayed  in  the  default
display when switching on the instrument.

You  can  select  the  language  for  the  Detector.  Nevertheless  it  still  can  be
changed at the Detector.

You can set the time of the Detector either by entering the correct time and date
(to do this, click on the figure you want to  change) or by clicking Send system
date to the Detector (that way the Detector is set to the same time and date as
your PC).

Here, you can select the baud rate of the Detector. Normally, you should select
the highest possible  (57.6 kbps). In  case of problems  with  communication (e.
g. the connection breaks down at times) you may select the lower baud rate of
38,4 kbps.

After completing all  settings, click on OK to  send the changes  to  the Detector.
Make  sure  that  the  Detector  is  switched  on  when  clicking  OK,  because
otherwise no communication is possible.

4.4 Setting up configuration

4.4.1 Set up system tree

Each  configuration  is  subdivided  into  three  levels,  e.g.  section  -  machine  -
measuring point.
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You can change the defaults for the level names in the settings .

Setting up configuration elements

In order to create a new configuration, carry out the following steps:

Click on System > New item or click on .

Name the entry, e.g. "Location Aachen”.

Add the new sub-entry by clicking on System  > New sub-item  or click  on  .
This way, you add a new section to the configuration. Name this  "Section 1", for
example.

Exactly as  with  the  section,  add  another  machine  (“Machine  1”)  and  a  new
measuring point (“Measuring point 1”) by following the sequence via  New sub-
item.

The  name  of  the  configuration  element  must  not  exceed  49
characters.

If  you  have  set  up  templates,  you  can  use  them  for  your
configurations (see "Planning with templates and routes ").

Manage configuration elements

In  the  system  tree  of  the  Trendline  software  you  can  cut,  copy  or  delete
configuration  elements.  You  can  find  further  information  in  the  chapter  "Tree
elements ".

4.4.2 Automatic assignment of RFID tags to measuring points

In order to simplify allocation of measuring points in the Trendline configuration to
measuring point in  your system,  you  can  add  RFID  tags  to  them.  The  Detector
can read existing RFID tags at the measuring points and automatically assign the
measured values to the correct measuring point in the Trendline software.

146
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If you are using RFID tags, the sensor cable of the Detector must
be provided with  the delivered snap-on  ferrite  (see  "Before  you
start" ). 

If  you  transfer  a  configuration  with  RFID  settings  to  a  Detector
without  an  RFID  reader,  it  displays  an  error  after  data  transfer
and ignores the RFID settings.

Affixing an RFID tag to a measuring point

You must first affix the RFID tag to  the  measuring  point.  There  are  two  different
types of RFID tags:

       

FIS.DETECTORIII.RFID.TAG.KEY (left) and 

FIS.DETECTORIII.RFID.TAG.DOME (right)

The RFID tag "Key" can be affixed to the measuring point using a tape or wire  tie.
The RFID tag "Dome" is designed especially for metallic foundations  and can be
glued onto the measuring  point.  When  using  at  temperatures  above  85°C,  you
should fix it into place using a screw, for example.

The RFID tag "Key" should not be affixed to  a  metallic foundation!
The electromagnetic field can be affected by the metal  and disrupt
the measurements taken at the measuring point. 
Always use the RFID tag "Dome" for metallic foundations.

Assigning an RFID tag to a measuring point

Before using, you must assign the  RFID  tags  placed  on  the  measuring  points.
You can do this  immediately before a CM or balancing measurement. Select the
measuring points wither in the Trendline software or in the on-site Detector:

21
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Selection in the Trendline software

1. Select a measuring point in the Trendline configuration.

2. Click on the General settings tab.

3. In the RFID Status box select Assign RFID.

4. Repeat this  procedure  for  all  measuring  points  to  which  you  wish  to  assign
RFID tags.

5. Send  the configuration to the Detector.

6. During the round, select the appropriate  measuring point in  the Detector (see
Selection of measuring point ).

a) Select  Start  measurement.  The  Detector  reads  the  RFID  tag  on  site  and
assigns it to the measuring point.

b) If  you  do  not  want  to  perform  a  measurement  but  just  want  to  assign  the
RFID  tag,  select  Assign  RFID  at  the  appropriate  measuring  point  on  the
Detector.

7. Load the data from the Detector in Trendline. The RFID status of the measuring
points is  now set to  "RFID assigned" and the green RFID icon is  displayed in
front of the measuring point in the configuration tree.

Hold the underside of the Detector at the height of the display at a
distance  of  approximately  20  mm  as  long  as  "quiet"  above  the
RFID tag, until  the measuring point has been measured and you
hear a signal.

You can set the status of all measuring points of an element (e.g.
a machine) to "RFID assigned". To do so, right-click  the element
and  select  Assign  RFIDs  globally.  On  the  next  round  with  the
Detector  you  can  assign  the  RFID  tags  placed  here  to  all  the
appropriate measuring points.

Selection in Detector

1. If you have not assigned an RFID tag to  a  measuring  point  yet,  you  can  also
assign  one  on  the  Detector.  You  can  assign  it  immediately  before  a  CM/
balancing  measurement  or  before  a  run  up/coast  down  test.  Select  the
measuring point on the Detector and then the Assign RFID command. You can
then perform a measurement.

2. Load the data from the Detector in Trendline. The RFID status of the measuring
points is now set to "RFID assigned".

Removing the assignment of an RFID tag

1. Select a measuring point with an RFID tag assigned in the Trendline.

90
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2. Click on the General settings tab.

3. In the RFID Status box select Delete RFID.

4. Send  the configuration to the Detector.

5. During the round, select the appropriate  measuring point in  the Detector (see
Selection of measuring point ).

6. Select Start measurement. The Detector prompts you to delete the tag.

Delete the tag and select Tag deleted.

If you do not delete the tag, select Tag stays.

7. Continue measuring.

8. Load the data from the Detector in Trendline. The RFID status of the measuring
point is set to "No RFID" if the tag was deleted.

You  can  globally  delete  all  RFID  tag  assignments  to  measuring
points of an element (e.g.  a  machine)  in  the  configuration.  To  do
so,  right-click  the  element  and  select  Delete  RFIDs  globally.  On
the  next  round,  confirm  deletion  of  the  RFID  tag  assignment  for
each measuring point before the measurement.

Changing the assignment of an RFID tag

To change the assignment of an RFID tag to  a  measuring point: First change the
RFID status in the Trendline configuration and transfer the modified configuration
to the Detector. On the next round with  the Detector, you can then import the new
RFID tag.

1. Select the measuring point in the Trendline configuration.

2. Click on the General settings tab.

3. In the RFID Status box select Edit RFID.

4. Send  the configuration to the Detector.

5. During the round, select the appropriate  measuring point in  the Detector (see
Selection of measuring point ).

6. Select Start measurement. The Detector prompts you to delete the tag. 

a) Delete the tag and select Tag deleted. You  can  now  assign  the  new  RFID
tag.

b) If you do not delete the tag, select Tag stays.

7. Continue measuring.

8. Load the data from the Detector in Trendline. The new RFID tag is  assigned in
the measuring point in the system configuration.

90
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Exchanging a defective RFID tag

If communication with the RFID tag at a  measuring point does  not work, the user
can mark it as  "defective" in  the Detector and then continue measuring. After the
next  data  synchronization  with  the  Trendline  software,  the  RFID  status  "RFID
defective" is displayed at the measuring point and recursively up to the top level  in
the configuration tree. You can then assign a different RFID tag to  the measuring
point.

1. The Detector cannot read the RFID tag at the measuring point. Select RFID tag
defective in the Detector.

2. The program displays "Is the tag defective?". Select Yes.

3. Delete the RFID tag from the measuring point.

4. Load the data from the Detector in Trendline. The RFID status of the measuring
points is now set to "RFID defective".

5. You can now assign a different RFID tag to the measuring point.

Additional information

You can abort Detector RFID  tag  assignment  handling  functions  by pressing
Esc. This preserves the previous state of the assignment.

If the Detector recognizes an RFID tag that is not in the configuration, it displays
the error message: "At least one configuration does not exist".

Hold the underside of the Detector at the height of the display at a  distance of
approximately  20  mm  as  long  as  "quiet"  above  the  RFID  tag,  until  the
measuring point has been measured and you hear a signal.

If an error occurs while reading the RFID tag, the serial  number in  the Detector
will be marked by three dashes. 

4.4.3 Set up a measuring point

Now  you  can  configure  the  settings  for  the  measuring  point.  Three  tabs  are
assigned  to  each  measuring  point  in  the  right-hand  window:  Information ,
Configuration  and Measured values .

Info

Comments  on this  measuring point may be entered in  the field  provided  on  the

Information tab. It is  also possible  to  insert an picture. To do  this,  click   and
select  the  desired  picture  in  the  file  dialogue.  You  can  print  out  the  picture  by

pressing  and remove it by pressing .

58
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General settings

Reminder function for alarm limit adjustment

The Trendline software can remind you about the alarm limit adjustment .

Activate the checkbox Use reminder function for alarm limit adjustment and 

choose when you want to be reminded.

RFID and comment options

In this section you can display and edit the status  of an RFID tag assigned to  the
measuring point and also set up the comment options on the Detector:

RFID status

No RFID: No RFID tag is assigned to the measuring point.

Assign RFID: This  option instructs  the Detector to  assign  an  RFID  tag  placed
on the machine to this measuring point during the next round.

RFID assigned: An RFID tag is assigned to the measuring point. The unique ID
is displayed in the RFID number field.

87
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Remove  RFID:  This  option  instructs  the  Detector  to  cancel  the  RFID  tag
assignment to the measuring point during the next round.

RFID defective: The Detector has marked the assigned RFID tag as defective.

Change RFID: This  option tells  the Detector to  replace the assigned RFID tag.
During the next round, you must delete the tag and assign  a  new  one  before
you can perform the measurement at this measuring point.

You can only select the statuses that are accessib le  as a follow-up
status of the current status.

Further  information  in  the  chapter  "Automatic  assignment  of  RFID  tags  to
measuring points ".

Comment input on the Detector

Here  you  can  specify  whether  you  want  to  enter  a  comment  for  each
measurement on the Detector. Select

"Only manual selection" if you want to select a comment manually,

"Display  after  each  measurement"  if  you  want  to  be  asked  after  each
measurement or

"Enforce after each measurement" if you definitely want to  enter a  comment to
each measurement.

Sensor

You  can  adjust  the  vibration  measurement  sensors  and  the  temperature  at
Sensor. Only the sensors  that  were  previously entered  in  the  sensor  database
will be available for selection (see "Add sensor "). You can select a  sensor for
Acceleration, Temperature and Trigger from the sensor database.

Time signal

In  this  area  you  can  specify how  the  Detector  should  handle  time  signals ,
FFTs and characteristic values.

Characteristic  value  averaging:  the  FFTs  or  characteristic  values  calculated
from  the  time  signals  are  averaged.  If  four  values  should  be  averaged,  for
example, four values are recorded in succession, the FFT is calculated and the
(frequency  selective)  characteristic  values  are  produced.  The  time  signals
stored for the purposes of an averaged measurement are always  the last time
signals  measured.  Select  FFT  to  determine  the  mean  values  of  the  FFTs
calculated from the time signals. Then select Char. values to apply the average
determined for the characteristic values calculated from the FFTs.

Averaging  count:  The  Detector  averages  measured  values  during  the
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measurement. Specify how many values are to be used for averaging.

You  can  set  the  resolution  of  the  spectrum  under  FFT  lines.  Select  1600
(corresponds  to  4096  samples)  or  3200  FFT  lines  (corresponds  to  8192
samples).

You can use Save time signal to  specify when a time signal  should be saved:
never, always, on pre-alarm or on main alarm.

Under Lowpass  you can select a  lowpass  frequency from  a  list.  This  will  be
used for the frequency band being measured. The sample rate in  this  case is
always 2.56 times the selected lowpass frequency.

Note  that  the  filter  calculation  in  the  software  is  performed  at  the
200  Hz  and  500  Hz  settings  and  is  therefore  slower  than  at  the
other  frequencies.  Therefore,  you  should  only  select  this  high
frequency if you really need it. Otherwise, select a  greater number
of FFT lines: For example, it is faster to  measure  at  1  kHz  /  3200
FFT  lines  than  at  500  Hz  /  1600  FFT  lines,  although  both
measurements are performed at the same resolution.

Apart from Save time signal the time signal  settings can no longer
be changed after  the  first  measurement  as  otherwise  it  would  no
longer be possib le to compare characteristic values.

Rotational speed

If the rotational  speed  also  needs  to  be  determined  by the  Detector  during  the
measurement select the  Acquire  turning  speed  option.  The  nominal  rotational
speed as  well  as  the  maximum  permissible  deviation  in  rpms  and  pulses  per
rotation should also be entered in  the appropriate  fields.  If  the  rotational  speed
deviates  from  the rotational  speed band defined here  during  measurement,  the
Detector issues an error message but still performs the measurement.

Bearing list template

In  this  section  you  can  assign  bearings  from  the  bearing  database  to  the
measuring point or delete an assignment. The associated kinematic frequencies
of the selected bearing are then also displayed in  the evaluation diagram  in  the
FIS Viewer. Both when making assignments  and deleting assignments  you can
choose whether

to only apply bearing data in future

for all measurements already performed, or

102
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only for measurements from a certain period

Specify  the  bearing  assignment  at  measuring  point  level  in  the
configuration.  You  can  also  assign  bearing  data  directly  to
individual  measured  values.  For  more  information  refer  to
Measured values .

Add bearing to measuring point

Click  and 

select a bearing from the bearing database .

Select to which measurements the bearing should be added:

If you only want  to  apply the  bearing  information  for  future  measurements,

117
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click Do not add bearing(s) to any measurement of this measuring point.

If you want to apply the bearing information to all  saved measurements, click
Add bearing(s) to all existing measurements of this measuring point.

To apply the bearing information to  measurements  in  a  certain  time  range,
click  Add  this  bearing  to  all  measurements  of  following  time  range  and
select the time range.

In  the  Bearing  configuration  section  enter  the  speed  correction  factor  (SPF)
and select whether the bearing has a fixed outer race.

Click on OK.

Delete selected bearing

Click on the bearing to delete and

then click .

Select from which measurements the bearing should be removed:

To  keep  the  bearing  information  for  the  existing  measurements  of  this
measuring point, click Do not deactivate bearing for  any measurement  of
this measuring point.

To  delete  the  bearing  information  from  all  saved  measurements  of  this
measuring point, click Deactivate bearing for all existing measurements of
this measuring point.

To  delete  the  bearing  information  from  measurements  in  a  certain  time
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range,  click  Deactivate  bearing  for  all  measurements  of  following  time
range and select the time range.

Click on OK.

Show and edit bearing information

Click on the desired bearing and 

then click . 

This displays the bearing information in the bearing database.

Edit the Speed correction factor (SPF) and select Fixed outer race optionally.

The kinematic frequencies can only be changed in the bearing database.

Click on OK.

Additional kinematic frequencies for analysis

In  this  section  you  can  define  additional  kinematic  frequencies  for  analysis.
These are also displayed in the evaluation diagram in the FIS Viewer.

Add kinematic frequency

Click on .

Enter  the  Name,  the  Speed  correction  factor  (SPF)  and  the  Normalized
frequency.

Click on OK.

The additional kinematic frequency will be added.

Delete kinematic frequency

Select the kinematic frequency to delete.

Click on  and

click on Yes.

Edit kinematic frequency

Select the kinematic frequency from list.
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Click on  and

edit the settings.

Click on OK.

Measured values

In the Measured data section you can display the acquired data numerically and
graphically. For more information refer to Measured values .

4.4.4 Setting characteristic values

You can create the following characteristic values per measuring point:

ISO 10816,

A
sel

 and A
eff

,

D
sel

 and D
eff

,

Temperature,

V
sel

,

Crest factor and

Universal.

Please  also  observe  the  information  in  the  "Frequency  selective  characteristic
values " section.

Characteristic values can be changed until  they have been sent to
the Detector for the first time. After that the characteristic values turn
grey  in  the  tree  and  cannot  be  altered  anymore.  Otherwise,  the
measuring results could not be compared.

To  add  a  new  characteristic  value,  right-click  the  measuring  point  the
characteristic value is  meant  for  and,  after  that,  on  New  sub-item.  Alternatively,

you can do it via  System  > New sub-item  or via  .  The  following  window  now
opens:
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Under Type you can select the various characteristic values that can be
measured with the Detector. With selective characteristic values (e.g. a

sel
) the

upper and lower cut-off frequency can be set in Min frequency and Max
frequency, between which the characteristic value will be calculated. For more
information on this topic, see Frequency-selective characteristic values . For
the other characteristic values (ISO 10816, a

eff
 and d

eff
) the cut-off frequencies

are pre-set.

In the Alarm section you can set a threshold value for each characteristic value. If
a  measurement  exceeds  this  value,  the  both  Detector  and  Trendline  software
show an Alarm. You can also set a  pre-alarm  threshold in  Trendline software. If
the measured value exceeds this  threshold, the Trendline software will  display a
pre-alarm  for this  measuring point. The Detector shows  main  alarms  only.  Pre-
alarms  are only displayed in  Trendline.  Further  information  under  "Reset  alarm
status ".

ISO 10816 type

If you have selected the characteristic value type ISO 10816 you can specify in the
Machine class section, whether characteristic values will be measured in
accordance to ISO 10816 (Class 1-4). You can adjust the alarm settings within
the class limits. If you want to set the defaults of a class click on Set default
alarm. If you select "User defined alarm limit configuration", you can define free
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alarm values. For more information about the classes of ISO 10816 see "ISO
10816 ".

Universal type

To  enter  a  characteristic  value  at  a  selected  measuring  point  that  is  not
measured  by the  vibration  or  temperature  sensor,  you  can  set  up  a  universal
characteristic  value  in  the  Trendline  software.  For  each  configuration  you  can
create several  universal  characteristic values. On the Detector  you  can  enter  for
example the machine temperature and the ambient temperature for the analysis
in  the  Trendline  software.  With  the  characteristic  value  type  Universal  you  can
define custom alarm values.

Universal  characteristic  values  are  displayed  in  the  Detector
without  unit.  To  assign  later  what  has  been  measured  with  this
parameter, you should  entitle  the  characteristic  value  accordingly
(e.g. "Machine  temp.  [C]").  In  the  Trendline  software  you  can  edit
the  name  in  the  "General  settings"  tab.  On  the  Detector  you  can
only change the name in the settings of free measurements.

4.4.5 Editing / deleting sensors

If you have added custom sensors  in addition to the pre-defined sensors, you
can edit or delete them.

Editing a sensor

In the Detector menu click Sensor > Edit.

Select the sensor in the Edit sensor window.

Edit the settings (see also Add sensor ).

To edit the sensor name, click on .

Click OK.

Deleting a sensor

In the Detector menu click Sensor > Delete.

Select the sensor to delete in the Delete sensor window and click OK.

As  long  as  a  sensor  is  still  in  use,  thus  it  is  assigned  to  a
measurement point, you cannot delete this sensor.
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4.4.6 Managing measurement comments

In the Trendline software you can create short texts  as  measurement comments.
The  comments  list  of  the  Trendline  software  will  be  transferred  while  sending
data to  the  Detector.  During  the  measuring  round,  you  can  assign  a  comment
from  the list to  every measurement on the Detector. The comment is  saved with
the  measurement  and  displayed  in  the  measuring  results  in  the  Trendline
software. If you edit or create new comments on the Detector, this will be added to
the  measured  data  in  the  Trendline  software  (see  "Measured  data ").  The
comment list will not be changed.

Create comment

Click Comment selection list in the Detector menu.

In the Comments window click .

Enter the desired text and click .

Click Close.

Delete comment

Click Comment selection list in the Detector menu.

In the Comments window click .

Click Close.

Edit comment

Click Comment selection list in the Detector menu.

In the Comments window click .

Enter the new text and click .

Click Close.
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4.4.7 Add balancing configuration

To create a balancing configuration 

click on a level 3 configuration element (machine or motor, for example). 

Then click System > Add  balancing configuration or click on .

General settings

RFID status

No RFID: No RFID tag is assigned to the measuring point.

Assign RFID: This  option instructs  the Detector to  assign  an  RFID  tag  placed
on the machine to this measuring point during the next round.

RFID assigned: An RFID tag is assigned to the measuring point. The unique ID
is displayed in the RFID number field.

Remove  RFID:  This  option  instructs  the  Detector  to  cancel  the  RFID  tag
assignment to the measuring point during the next round.

RFID defective: The Detector has marked the assigned RFID tag as defective.

Change RFID: This  option tells  the Detector to  replace the assigned RFID tag.
During the next round, you must delete the tag and assign  a  new  one  before
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you can perform the measurement at this measuring point.

You can only select the statuses that are accessib le  as a follow-up
status of the current status.

Further  information  in  the  chapter  "Automatic  assignment  of  RFID  tags  to
measuring points ".

Balancing settings

Type of vibration unit: Select Acceleration, Velocity or Displacement.

Peak setting: Specify here whether the peak-to-peak  value, the peak  value or
the root mean square (RMS) should be evaluated.

Balancing OK at: define the limit value for the balancing measurement here. If
all  measured values  are below the value specified during the trim  run  the
balancing procedure has  been successfully completed and the Detector ends
the balancing measurement.

Rotor weight: Here you enter the weight of the rotor (kg) for which the balancing
measurement  is  performed.  The  Detector  uses  this  value  to  calculate  a
suggested test weight (see notes  in  section "Balancing measurement" ). If
you enter 0 here, the Detector cannot calculate a suggested test weight.

Measurement  averaging  count:  The  Detector  averages  measured  values
during  the  measurement.  Specify  how  many  values  are  to  be  used  for
averaging.

Rotational speed settings

Enter  the  Nominal  rotational  speed  (in  the  predefined  unit,  see  "Program
settings / General ") and the Max. allowed deviation in the appropriate  input
boxes. Note that a  deviation of more than 10% is  not possible. If the acquired
speed by the Detector is  outside the rotational  speed range defined here,  the
Detector displays an error message .

The  Detector  averages  the  rotational  speed  values  during  the  measuring
process.  Specify  how  many  rotational  speed  values  are  to  be  used  for
averaging at Turning speed averaging count. If you enter 20, for example, the
Detector  averages  the  values  obtained  for  rotational  speed  across  20
revolutions.

Balancing plane settings

Number of balancing  planes:  Select  "1"  for  single-plane  balancing  or  "2"  for
two-plane balancing.

Enter a  plane name  for the selected planes  or  use  the  names  suggested  by
the Trendline software (see also "Program  settings  / General "). Due to  the
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Detector display this name can only contain 5 characters.

Enter the radius in mm for which balancing weights can be applied to  the rotor.
The Detector uses this value to calculate a suggested test weight (see notes  in
section "Balancing measurement" ). If you enter 0  here, the Detector cannot
calculate a suggested test weight.

Deactivate Continuous if you can attach the balancing weights anywhere on the
shaft. If this  is  not possible  (e.g. with  a  fan with  10 blades), Continuous  must
not be selected.

If  you  activated  Continuous,  use  Discrete  positions  to  select  the  number  of
possible positions for the balancing weights, e.g. for a  fan. In  addition, please
enter the angle of the next possible  position against the direction of rotation to
the reflex mark edge in  Angle trigger mark  ->  Pos.  1.  This  position  is  called
P1.

Resonance frequency bands

In this section you can manually enter the resonant frequency bands  determined
for this measuring point.

Click on .

Enter the name of the frequency band.

Select the Start frequency and End frequency and

then click OK.

You can copy resonant frequency bands determined from a run up/
coast  down  test  and  subsequent  creation  of  an  amplitude/phase
diagram  to  the  balancing  configuration  (see  Setup  run  up/coast
down ).

To delete frequency bands

select a frequency band .

Click on  and

confirm with Yes.
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Sensor configuration

Sensor position settings

In  this  section you can insert up to  four sensor positions. Each balancing  plane
must have at least one sensor position. If you add a new balancing configuration
to  the  system  configuration,  a  sensor  position  is  automatically  added  per
balancing plane.

Sensor position: Enter a name for the sensor here (maximum of 5  characters).
Due to the size of the Detector display this can only be 5 characters long.

BNC connector: Select the BNC port  used to connect the sensor during the
measurement.  If  you  are  measuring  with  two  sensors,  you  should  use  both
BNC  connectors  on  the  Detector  as  this  accelerates  the  speed  of
measurement.

Angle: Enter the angle of displacement of the sensor from  the zero position in
the direction of shaft rotation. The stator is always used as the reference for the
zero position which points vertically upwards.

Sensor: Select the sensor used from the sensor database  here.
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Trigger settings

Select  trigger  sensor:  Select  the  trigger  sensor  used  from  the  sensor
database  here.

Name of trigger position: Enter a  designation for  the  trigger  position.  This  is
required by the  Detector  to  identify the  trigger  sensor.  Due  to  the  size  of  the
Detector display, this name can only be five characters long.

Angle of trigger sensor: Enter the angle of displacement of the trigger sensor
from the zero position in  the direction of rotation. The stator is  always  used as
the reference for the zero position which points vertically upwards.

Select Positive or Negative  to  indicate whether the measurement should start
on a positive or negative edge on the trigger sensor. This  edge determines  the
0° position of the shaft.

Configured angles

In  this  area  the  Trendline  software  provides  a  graphic  representation  of  the
position of the sensors.

The sensor  positions  are  always  counted  in  the  direction  of  shaft
rotation.

Measuring data

You can view the measured data in  this  area once a balancing measurement is
complete and the data have been transferred to  the Trendline software from  the
Detector.

45



74

Edit comment

In order to edit a  measurement comment, click on the measurement and then

on .

Show details

To display the details of a measurement click on the appropriate entry in the list
then click on .

The  Trendline  software  displays  the  sensor  position,  time  of  measurement,
rotational  speed,  amplitude  and  phase  of  the  vibration  at  the  sensor  at  each
stage  of  the  balancing  measurement.  If  you  also  wish  to  see  the  suggested
weights  and  their  amplitude  and  angel  or  coefficients  used  and  their
corresponding  amplitude  and  phase,  click  Show  proposed  weights  or  Show
coefficients.

If you wish to hide the details again click on .

Display sensor charts

Click Sensor charts to display the position of the sensors as a chart. 

Trendline enters the sensor position on a circular chart for each individual  step of
the  measurement.  You  can  activate/deactivate  the  display  of  each  sensor  at
Sensor position n.
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Display weight charts

Click Weight charts to display the weights as a chart. 

The Trendline software enters the position of the weights  during the trial  run and
trim  run in  a  circular chart. You can switch the display of weights  for each  plane
on or off by clicking on Applied/proposed weights - Plane n.

The positions of the weights are  indicated  against  the  direction  of
shaft rotation.

Print view of graphics

Click on  to call up a print preview of the graphics.
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Balancing report

Click on  to generate a balancing report .

Delete balancing data

To delete the data obtained during a balancing measurement 

click the corresponding entry in the list then click  and 

confirm deleting with Yes.

4.4.8 Set up amplitude/phase configuration

To create an amplitude/phase configuration, 

click on a Level 3 configuration element (e.g. a machine or motor). 

Then click System > Add amplitude/phase configuration.

General settings

RFID status

No RFID: No RFID tag is assigned to the measuring point.

Assign RFID: This  option instructs  the Detector to  assign  an  RFID  tag  placed
on the machine to this measuring point during the next round.

RFID assigned: An RFID tag is assigned to the measuring point. The unique ID
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is displayed in the RFID number field.

Remove  RFID:  This  option  instructs  the  Detector  to  cancel  the  RFID  tag
assignment to the measuring point during the next round.

RFID defective: The Detector has marked the assigned RFID tag as defective.

Change RFID: This  option tells  the Detector to  replace the assigned RFID tag.
During the next round, you must delete the tag and assign  a  new  one  before
you can perform the measurement at this measuring point.

You can only select the statuses that are accessib le  as a follow-up
status of the current status.

Further  information  in  the  chapter  "Automatic  assignment  of  RFID  tags  to
measuring points ".

Amplitude-Phase settings

Type of vibration unit: Select Acceleration, Velocity or Displacement.

Peak setting: Specify here whether the peak-to-peak  value, the peak  value or
the root mean square (RMS) should be evaluated.

Order: Select what signal  order the Detector should determine (1  =  rotational
speed signal, 2 = 1st harmonic, 3 = 2nd harmonic, 4 = 3rd harmonic).

Measuring point tag: Enter a  name for the measuring points. You can change
the  standard  designation  "MP"  in  the  Program  settings .  During  the
measurement,  the  Detector  adds  a  consecutively increasing  number  to  this
name to  uniquely identify a  measuring  point.  Due  to  the  size  of  the  Detector
display, this name can be a maximum of 15 characters long.

Measurement  averaging  count:  The  Detector  averages  measured  values
during  the  measurement.  Specify  how  many  values  are  to  be  used  for
averaging.

Rotational speed settings

Enter  the  Nominal  rotational  speed  (in  the  predefined  unit,  see  "Program
settings / General ") and the Max. allowed deviation in the appropriate  input
boxes. Note that a  deviation of more than 10% is  not possible. If the acquired
speed by the Detector is  outside the rotational  speed range defined here,  the
Detector displays an error message .

The  Detector  averages  the  rotational  speed  values  during  the  measuring
process.  Specify  how  many  rotational  speed  values  are  to  be  used  for
averaging at Turning  speed averaging count. If you enter 20, for example, the
Detector  averages  the  values  obtained  for  rotational  speed  across  20
revolutions.
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Sensor settings

Select acceleration sensor: Select the sensor used from the sensor database
 here.

Trigger settings

Select  trigger  sensor:  Select  the  trigger  sensor  used  from  the  sensor
database  here.

Resend data settings

If you would like to repeat an amplitude/phase measurement, you can resend the
configurations  to  the Detector, including the measured data  and  any comments
that  have  been  entered.  During  the  measurement,  the  Detector  replaced  the
existing measured values with the current measured values. This is only done for
the  measurement  points  that  have  actually  been  measured  again.  New
measuring points are attached to  the measurement job. After the measurement,
you can select a new comment from the Comment list  on the Detector. During
the transfer to Trendline, the repeated measurement is added to the configuration
as a new measuring job. The data from  the previous  measurement are therefore
fully retained.

Example: You resend a measuring job to  the Detector with  the measuring
points MP1-MP5. If you now use the Detector to  remeasure MP1 and MP2,
the measured values at MP1 and MP2 are replaced. If you remeasure at a
new MP6 measuring point, the measured value is attached to the job. After
transferring  the  data  to  the  Trendline,  you  will  find  the  complete
measurement  as  a  new  measurement  job  in  the  corresponding
configuration in the Trendline software.

To  repeat  a  measurement,  activate  the  Resend  measurement  job  checkbox
and select the consecutive number of the desired measurement job.

For further information under Send configuration .

Measured data

You  can  view  the  measured  data  in  this  area  once  a  Amplitude  /  phase
measurement is  complete and the data  have  been  transferred  to  the  Trendline
software from the Detector.
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Show details

The measured values  are combined in  measurement jobs. A measurement job
contains  all  related measured values. To display the  details  of  a  measurement
job click on the appropriate entry in the list then click on .

For  each  step  of  the  Amplitude  /  phase  measurement,  the  Trendline  software
shows  sensor  position,  distance  of  the  measuring  point  from  the  referencing
point of the measurement, amplitude and phase of the  vibration  on  the  sensor,
speed as well  as  data and time. The list is  sorted in  ascending order according
to  the  distance  from  the  referencing  point.  The  values  are  displayed  in  the
selected  units  (see  "Program  settings" ).  To  select  the  unit  for  the  "Pitch"

column, click on  and select the desired unit.

If you wish to hide the details again click on .

Pitch of a measuring point at the start of the measurement.

Click on the measuring point in the table of measurements.

Click  on   and  enter  the  desired  value  in  the  Change  pitch  field  (max.  5
places before and max. 2 places after the period).
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The list is resorted in ascending order by pitch.

Edit comment

In order to  edit a  comment of a  measurement, click on the measurement and

then .

Amplitude/phase report

Click  on   to  create  an  Amplitude/Phase  Report  for  the  selected
measurement job.

Delete amplitude/phase measurement

Click on the measurement job in the table of measurements, then on .

Display two-dimensional amplitude/phase graph

Click 2D graphics to display measurements in a graphic format. 

The Trendline software plots  the amplitude and phase of the vibration signals  at
the measuring points  separately over a  shared axis  that shows  the  positions  of
the measuring points to scale.

Cursor tools: In 2D display mode the the base and difference cursor as well as
the  zoom  tools  of  the  FIS  Viewer  are  available.  For  each  measuring  point
selected using the cursor, the diagram  shows  the values  for phase/amplitude
of the signal as well  as  the pitch at the reference point. If the difference cursor
is  activated,  the  corresponding  difference  values  between  the  selected
measuring points are also shown.

Display three-dimensional amplitude/phase graph

Click 3D graphics to display measurements in a graphic format.
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In  the three-dimensional  view, the pitch at the measuring points  is  displayed on
an asymptote. At each measuring point, the vibration signal  is  shown in  the pitch
of the amplitude and with  the phase  angle  of  the  signal  around  the  asymptote.
This makes phase leaps immediately recognizable.

Cursor tools: In  3D display mode,  the  base  and  difference  cursor  of  the  FIS
Viewer are available. For each measuring point selected using the cursor, the
diagram  shows  the  values  for  phase/amplitude  of  the  signal  as  well  as  the
pitch  at  the  reference  point.  If  the  difference  cursor  is  activated,  the
corresponding difference values  between  the  selected  measuring  points  are
also shown.

Rotation: The display can be rotated around the x and y-axis  using the middle
mouse  button.  If  you  also  hold  down  the  "Shift"  key,  the  graph  will  only  be
rotated around the x-axis; holding down the "Ctrl" key will  rotate the graph only
around the y-axis.

Zoom: You can zoom in on or out from the graph using the mouse wheel.

Reset picture: Click on  to  reset  the  picture  to  the  standard  values  (60%
size, 45° rotation around the x-axis, 30° rotation around the y-axis).

Export job

You  can  export  a  measuring  job  as  a  table  in  CSV  format  (each  column  is
separated by a semicolon):

Select  the  desired  measuring  job  and  click  on  Export  selected  job  in  .csv
format.

Click File name and select the path and file name.

Click on Continue.
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Specify whether the export file should contain column headings. 

Under Export options, choose whether the columns will be exported to  include
the column descriptions  and/or rotational  speed  (pitch,  amplitude  and  phase
are always exported). 

Click on Finish to create the file.

4.4.9 Set up run up/coast down

To create an run up/coast down configuration, 

click on a Level 3 configuration element (e.g. a machine or motor). 

Then click System > Add run up/coast down configuration.
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Configuration

RFID status

No RFID: No RFID tag is assigned to the measuring point.

Assign RFID: This  option instructs  the Detector to  assign  an  RFID  tag  placed
on the machine to this measuring point during the next round.

RFID assigned: An RFID tag is assigned to the measuring point. The unique ID
is displayed in the RFID number field.

Remove  RFID:  This  option  instructs  the  Detector  to  cancel  the  RFID  tag
assignment to the measuring point during the next round.

RFID defective: The Detector has marked the assigned RFID tag as defective.

Change RFID: This  option tells  the Detector to  replace the assigned RFID tag.
During the next round, you must delete the tag and assign  a  new  one  before
you can perform the measurement at this measuring point.
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You can only select the statuses that are accessib le  as a follow-up
status of the current status.

Further  information  in  the  chapter  "Automatic  assignment  of  RFID  tags  to
measuring points ".

Acceleration sensor settings

Choose sensor: Select the sensor used from the sensor database  here.

Name of sensor position: Enter a  designation for the sensor position. This  is
required for identification of the sensor by the Detector. Due to  the  size  of  the
Detector display, this name can only be five characters long.

Angle of sensor: Enter the angle of displacement of the trigger sensor from  the
zero  position  in  the  direction  of  rotation..  The  stator  is  always  used  as  the
reference for the zero position which points vertically upwards.

Trigger settings

Select  trigger  sensor:  Select  the  trigger  sensor  used  from  the  sensor
database  here.

Name of trigger position: Enter a name for the trigger position. This is  required
by the  Detector  to  identify the  trigger  sensor.  Due  to  the  size  of  the  Detector
display, this name can only be five characters long.

Angle of trigger sensor: Enter the angle of displacement of the trigger sensor
from the zero position in the direction of rotation.. The stator is  always  used as
the reference for the zero position which points vertically upwards.

Select Positive or Negative edge to indicate whether the measurement should
start  on  a  positive  or  negative  edge  on  the  trigger  sensor.  This  edge
determines the 0° position of the shaft.

Run up/coast down settings

In  this  section  you  can  make  settings  required  for  Determining  the  resonance
range of a machine  with the run up/coast down test.

Type of vibration unit: Enter which vibration unit to  use at run  up/coast  down.
The following are available: Displacement, Velocity and Acceleration.

Peak setting: Specify here whether the peak-to-peak  value, the peak  value or
the root mean square (RMS) should be evaluated.

Measurement  type:  Enter  whether  the  Detector  measures  during  run  up  or
coast down of the machine
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Frequency settings

In  this  section  you  can  set  the  start  and  end  velocity  for  Determining  the
resonance range of a machine  with the run up/coast down test.

Use  automatic  start  frequency:  Enter  the  frequency  at  which  the  Detector
starts measuring.

Use automatic end frequency: Enter the frequency at which the Detector stops
measuring.

Expert settings

The  settings  in  this  section  concern  conditioning  of  the  measuring  signal
determined while Determining the resonance range of a machine  with the run
up/coast down test.

Order: Select what signal  order the Detector should determine (1  =  rotational
speed signal, 2 = 1st harmonic, 3 = 2nd harmonic, 4 = 3rd harmonic).

Signal  length:  Enter  how  many samples  (1024,  2048  or  4096)  the  Detector
should measure per measuring signal.

Use  Hanning  windowing:  Select  whether  the  Detector  should  use  Hanning
windowing when conditioning the measuring signal. Hanning windowing leads
to better quality of the digitized measuring signal, particularly at  low  rotational
speeds. However, this additional step requires  computing time in  the Detector
and leads to increased noise in the digitized signal.

The effects of this setting depend very much on the type of machine
and  on  the  individual  demands  on  the  ratio  of  accuracy  to  the
number of signal support points. As a general rule, you should

measure as many amplitude and phase values  as  possib le  for
machines  that  run  up/coast  down  quickly  -  i.e.  reduce  signal
length  and  thus  signal  quality  and  do  without  Hanning
windowing,

increase accuracy for machines that run up/coast down slowly, i.
e.  increase  signal  length  and  thus  signal  quality  and  activate
Hanning windowing.

Measuring data

In the Measured data window you can

create an amplitude/phase diagram for a set of measured data,

save frequency bands  selected in  the diagram  and copy them  to  a  balancing
configuration .
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The Run up/coast down measurements  section displays  the run up/coast down
measurements saved for the measuring point.

Limit time range

In  order to  limit the time  range  of  the  measured  values  displayed,  select  the
Time range option.

Set the desired start and end date.

Edit comment

In order to edit a  measurement comment, click on the measurement and then
Edit comment.

Below the measurements the window is  split into  three sections. The amplitude/
phase diagram  is  displayed in  the middle, with  the diagram  editing  tools  to  the
left. To the right of the diagram there is a list of the user-defined frequency bands.

Displaying the amplitude/phase diagram and setting the frequency band

Click  on  a  measurement  to  display  the  amplitude/phase  diagram  in  the
diagram window. 

You can use the FIS Viewer zoom  tools  described in  the "FIS Viewer"  section  to
edit  the  diagram.  Cursor  tools  for  the  diagram  include  the  base  cursor  (see  "
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Cursor  tools")  and  a  difference  cursor,  with  which  you  can  specify a  frequency
band.

How to specify a frequency band in the amplitude/phase diagram:

Move the base cursor (yellow) to the measuring point to  specify the lower cutoff
frequency.

Move the difference cursor (green) to the desired measuring point to specify the
upper cutoff frequency.

In the diagram  information, you can read the position of the base and difference
cursor and the width of the frequency band and amplitude difference.

Saving the frequency band

Select the frequency band in the amplitude/phase diagram and click .

Enter a name for the frequency band and click OK.

Or:

Click on .

Enter the name of the frequency band.

Select the start and end velocity and click OK.

Deleting a frequency band

Click on the frequency band to delete.

Click on .

Copying frequency bands to a balancing configuration

Click on .

The Add frequencies to balancing configuration window displays  the balancing
configurations available in the system configuration. 

Select the desired balancing configuration and 

click OK.

4.4.10 Adjust alarm limits automatically

The Trendline software can automatically adjust the alarm settings for the
individual characteristic values. During this process the software determines the
average of all measured values for the relevant characteristic value and
automatically adjusts the corresponding alarm value according to your
specifications. Alternatively, you can use the values suggested by the software.
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CAUTION Modification  of  alarm  thresholds  may  have  severe  effects  on  the
service life  of the  monitored  components  if  used  improperly.  You
should  therefore  always  carefully  check  whether  the  intended
settings are suitab le for your specific system.

To adjust the alarm values automatically proceed as follows:

In the System menu, click on Adjust alarm limits.

Select the required element from the configuration tree, a  specific machine, for
example. 

The alarm values for this element and all  sub-elements  it contains  are adjusted.
Please select or unselect sub-elements if necessary.

You can define the default values for the alarm  limit adjustment in
the program settings .

Specify time range

You  can  use  the  Time  range  option  to  limit  the  measured  values  used  for
averaging. To do this, enter the start and end time. Alternatively, you can enter the
end time and specify the duration in  whole days  in  the No. of days  input field. In
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this case the start time will be determined automatically.

Configuring automatic adjustment

Automatic  adjustment  of  alarm  values  can  be  defined  for  each  characteristic
value  (acceleration, demodulation, velocity, temperature and ISO 10816-1) of
the element selected in the configuration tree.

To  activate  the  automatic  adjustment  for  one  characteristic  value  proceed  as
follows:

Select the characteristic value.

Enter the main alarm adjustment as a factor of the average value.

Enter the pre-alarm adjustment as a percentage (less than 100).

or:

Click Recommended to set the values recommended by Trendline.

For the ISO 10816 value,  the  alarm  limits  can  only  be  created
within the class boundaries of pre-alarm (C) and main alarm  (D).
More information about ISO 10816 classes can be found in  the "
ISO 10816 " chapter.

The values suggested by Trendline for the automatic adjustment
of  alarm  values  are  based  on  empirical  values  used  by  FAG
Industrial  Services  GmbH.  Because  entirely  different  settings
may  be  required,  depending  on  the  properties  of  the
components being monitored, these must be regarded purely as
suggested values, which are  completely  non-b inding.  The  user
is always responsib le for selecting appropriate alarm values.

Click Execute to apply the settings.

The Trendline software adapts the alarm limits of the selected elements. A green
check mark displays  a successful  adjustment at  the  measurement  point.  A red
struck  out  circle  indicates  that  the  adjustment  failed.  In  this  case  check  the
settings and repeat the configuration.

Click Close to exit the alarm limit adjustment.
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4.4.11 Send configuration

In the Trendline software You can send a configuration or a part of a  configuration
to the Detector. For that, follow the sequence below:

Select a machine in the tree.

Connect the connector to the serial interface using the data cable.

Switch on the Detector.

Click on Detector > Send configuration or click on .

The  configuration  for  the  machine  for  the  selected  machine,  including  all
measuring  points,  is  sent  to  the  Detector.  If  you  want  to  send  a  complete
configuration,  you  would  have  to  select  the  configuration  in  the  tree  (in  the
example in  paragraph "Setting up system  tree"  this  would be  “Cement  Plant
1”) prior to  sending the  data.  It  is  even  possible  to  send  one  measuring  point.
This facility is mostly used for test purposes.

If the "Always save" option is selected for more time signals in  the
configuration  that  you  wish  to  send  to  the  Detector  than  are
permitted in the Detector memory an error message will  be output
and  the  data  will  not  be  transferred.  For  more  on  this,  see  also
chapter  "Frequency  analysis"  (see  PDF  "General  information  on
vibration monitoring" on the delivered CD-Rom).

4.5 Trendline database

About the Trendline databases

The data required for configuration and evaluation of data is stored centrally in  the
Trendline  database.  The  Trendline  software  is  delivered  with  the  MS  SQL
Express 2005 database program, but the size of the database is  limited to  4  GB
for licensing reasons. If you require  more space in  the database please consult
FAG Industrial Services GmbH. 

The  database  program  can  be  used  to  manage  multiple  database  files.  Each
database  contains  a  MDF  and  a  LDF  file.  For  the  sake  of  simplicity,  individual
database files are referred to in this manual as "database".

Please note:

If  you  would  like  to  attach,  detach  or  update  a  database,  use  the  database
administration that is provided and described in the following chapter.

If you would like to create or delete a database, you can do this directly from  the
Trendline  software.  For  more  on  this  see  "Create  database"  /  "Delete
database" ).
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If  there  is  less  than  512  MB  of  unused  space  in  the
Trendline database, a warning is displayed.

CAUTION Measured data may be lost if database is full!

If  the  maximum  storage  capacity  of  the  Trendline
database  has  been  used  up,  a  warning  is  displayed.  If
additional measured data is downloaded from  a Detector
device  when  the  database  is  full,  this  data  cannot  be
saved and will be lost!

Free up storage space in the database by

deleting unneeded data,

storing  existing  data  to  a  different  location  using  the
export  function  and  then  deleting  the  Trendline
database.

4.5.1 Users and passwords

During  the  installation  of  the  Trendline  software  the  following  users  and
passwords will be set up for the database program (SQL server) access:

User name User password User rights

sa CM_serv ices$1sa

(for new  installations from v ersion 3.6)

Install and register

databases at the SQL

serv ersql8

(for ex isting installations up to including v ersion 3.4)

cmuser CM_serv ices$1user Select, attach, detach,

update and delete

databases in the Trendline

softw are

The user passwords can differ depending on your specifications!
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The following possib ilities can be considered for the user
password:

If  the  SQL  server  has  been  set  up  with  the  FIS
Trendline  software  up  to  version  3.4  the  password  is
"sql8".

If  the  SQL  server  has  been  set  up  with  the  FIS
Trendline  software  from  version  3.6,  the  password  is
"CM_services$1sa".

If you use your own SQL server, you need the password
for this one.

If  you  have  defined  your  own  password  according  to
your security rules, you need this one.

With  user-defined  passwords  maybe  you  have  to  use  a
password  that  meets  the  security  policies  of  your
computer. This can be a strong password with  at least 10
characters, upper and lower case and alphanumeric  and
special characters, for example.

For prob lems with the safety requirements of your system,
please contact your system administrator.
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4.5.2 Select database on server

You can select a CM database on a database server as follows:

1. Select SQL server

First select the SQL database server where the database is located. You have the
following options:

By default, the Server name  list displays  the server instances  running on your
computer. Select an instance.

Or:

Click  and enter the full server name. 

Or:

Click  to  search the SQL database servers  that are available  in  the  network
and display them in the server list. Then select the server from the list.
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The  server  list  will  be  empty,  if  you  are  working  with  a  restricted  
Windows  user  account.  In  this  case  you  have  to  enter  "PC
name\CM_DATABASE"  manually  (if  you  use  an  older  version  of
Trendline software  it  is  "PC  name\FIS_DATABASE").  You  can  find
your  PCs  name  above  the  disk  drives  in  the  Windows  Explorer.
When  your  PCs  name  is  "peters_laptop",  then  enter
"peters_laptop\CM_DATABASE" as server name.
If you are unsure about the computer name ask your administrator.

Database servers that have been added with , will be saved in  the
list  Server  name  and  were  automatically  availab le  next  time  you
open the program. You can delete items from this list by clicking .

2. Select user authentication

You have several options for the user authentication on the database server:

Check  Use  Windows  authentication  to  use  your  Windows  user  name  and
password.

Or:

Check Use user name and password and

activate Default user and password to use the default logon (see tip).

Or:

Check Use user name and password,

disable Default user and password and 

enter your own user name and password for the selected database.

To  access  the  database  server  a  user  account  is
created  during  Trendline  installation  with  the  default
name  "cmuser"  and  password  "CM_services$1user".
For  database  server  that  have  been  installed  with
Trendline software version 3.4 or earlier, the user name
is "sa" and the password "sql8". 

If  you  use  your  own  (custom)  password,  please  enter
this one.

Further  information  in  chapter  "Users  and  passwords"
.

3. Select database

After  selecting  a  database  server  in  step  1,  the  available  databases  will  be
displayed on the select list Database.
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The Name  list displays  the available  databases. Select a  database or click 
to refresh the list of available databases.

Click  to  test the connection. If the connection fails, check  your  user  data.  If
necessary, contact your system administrator.

4. Enter database alias

Optionally, you can give the selected database an alias name to make it easier to
distinguish it  from  other  databases.  If  you  have  already given  the  database  an
alias name, it is  displayed, otherwise the name of the database is  including the
name of the server.

Click OK to use the selected CM database.

4.5.3 Database administration

With  the  database  administration  of  the  Trendline  software  you  can  perform
several administration tasks, so as  attaching, detaching or updating a Trendline
database.

You can start the database administration as follows:

Click on Extras > Start Database Administration in the Trendline-Software.

Or:

Close the Trendline-Software.

Open  the  start  menu  and  click  on  Programs  >  FIS  >  Trendline  3.6  >  FIS
Database Administration.
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Attach a database

To use a database on a SQL database server, the server needs  to  know  where
the  database  files  (*.mdf  and  *.ldf)  of  a  specific  database  are.  With  Attach
Database you let the server know where the database files are located.

Detach a database

If you detach a database from SQL database server, you remove the database file
from the list of known databases for a specific server. The database files  are still
present on your computer, but they are not accessible  by the database server or
the Trendline-Software anymore.

If you want to  make a detached database accessible  for the Trendline Software,
you have to attach the database again.

Update a database

When new features  are  added  to  the  Trendline  database,  it  might  be  possible
that the database format has to be changed. With  this  option, you can update the
database to the new format.

4.5.3.1 Attach database

You can attach a database to the SQL database server as follows:

Start the Database administration.

Click Attach.
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Click on Connect to connect to the master database:

From  the server list, select the database server that contains  the database  or
enter it manually there. You can click Refresh first in  order to  update the list of
available servers.

Click Use a specific user name and password and enter your user name and
password to log in to the master database.

Select the Allow saving the password option.

Select the "master" database from the database list and click OK.

Click Continue in the database administration.

Select the required database file  to  be imported (MDF file) and click  OK.  Now
select the corresponding LDF file and click OK.

Click Continue and enter a name for the database.

Click on Execute. The database is attached.
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4.5.3.2 Detach database

You can only detach a database if it is not being used
by the Trendline Software.

If  you  have  disconnected  the  database  from  the
database  server,  you  can  only  access  the  database
again with the Trendline software by reattaching  the
database again.

You can detach a database from the SQL database server as follows:

Start the Database administration.

Click Detach.

Click on Connect to connect to the master database.

From  the server list, select the database server that contains  the database  or
enter it manually there. You can click Refresh first in  order to  update the list of
available servers.

Click Use a specific user name and password and enter your user name and
password to log in to the master database.

Select the Allow saving the password option.

Select the "master" database from the database list and click OK.

Click Continue in the database administration.

Select the database to  be detached  in  the  database  administration  and  click
OK.

Click on Execute. The database is detached.

4.5.3.3 Update database

ATTENTION

Back up  your Trendline database before updating it!

You can update a database as follows:

Start the Database administration.

Click Update.

Click on Connect to connect to the master database.

From  the server list, select the database server that contains  the database  or
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enter it manually there. You can click Refresh first in  order to  update the list of
available servers.

Click Use a specific user name and password and enter your user name and
password to log in to the master database.

Select the Allow saving the password option.

Select the "master" database from the database list and click OK.

Click Continue in the database administration.

Select  the  database  to  be  updated  in  the  database  administration,  click
Continue and then Execute. 

The database is updated.

Click Execute.

If you try to open a Trendline database that needs to  be
updated, Trendline software offers to  start the database
administration with  all  preliminary steps for  an  update.

If the database administration is opened, click Execute to
update the database.

A database that has been  updated  from  MSDE  or  MS
SQL Server 2000 to  MS SQL Express  2005  cannot  be
re-opened with MSDE or MS SQL Server 2000.

4.5.4 Create database

You can create a new CM database as follows:

Click File > New in the Trendline software.
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Select from the Server name list the database server or enter it manually. 

Define the User authentication for the database server access  and enter user
name and password if necessary.

Select a name for the new CM database.

Click OK.

The CM database will be created.

You  can  find  further  information  to  the  settings  of  the  database
connection dialog in  the  chapter  "Select  CM database  on  server"

.

4.5.5 Open database

You can open a CM database as follows:

Click File > Open in the Trendline software.
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Select from the Server name list the database server or enter it manually. 

Define the User authentication for the database server access  and enter user
name and password if necessary.

Select the CM database from the Name list (e.g. "CM_OFFLINE_DB0").

Enter an Alias name for the database optionally.

Click OK.

The selected CM database can be used.

You  can  find  further  information  to  the  settings  of  the  database
connection dialog in  the  chapter  "Select  CM database  on  server"

.

4.5.6 Delete database

To delete a CM database proceed as follows:

Open the Trendline database.

Click in the menu on Extras > Delete current database. 

A safety information is displayed.

Click Delete.

The database will be deleted irreversibly.
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If  you  delete  a  CM  database,  all  configuration  and  measured
data will be removed irreversib ly!

You cannot interrupt the delete process!

4.5.7 Back up database

You can back up database(s) as follows:

To make a backup of a  database,  you  have  to  detach  the  database  from  the
database server (see "Detach database" ).

Start Windows Explorer and choose the directory where the database files  are
located.

Copy both the MDF and the LDF file of the database, which you want to back up,
to da different location.

For  backup,  it  is  essential  that  you  copy  both  database  files!
Therefore always copy the MDF and the LDF file.

4.6 Bearing database
The Trendline database provides you with data on the most widely used bearings
for use in your individual configuration (see Setting up measuring point ).

You  can  also  add  your  own  bearings  to  the  existing  bearing  data.
Furthermore,  the  Trendline  bearing  database  also  includes  a  group
administration feature  which you can use, for example, to  group  bearings  of
different makes that have similar characteristics.

Click Tools > Bearing database to open the bearing database.

Select  the  database  as  described  in  "Select  database" .  The  name  of  the
included bearing database is  "CM_BEARINGS".  If  you  set  it  up  during  software
installation, it is automatically opened when you call  the bearing database for the
first time. The program uses the default user name and the default password.

The bearing database opens.
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4.6.1 Search bearing

To find a bearing click on Search bearing in the bearing database .

Click on  to display all bearings.

To restrict the search you can specify the manufacturer and/or group.

Additionally, you can further limit the name of the bearing in  Search  criterion.
You can use the wildcards "?" and "*" in the usual way, e.g.

"*1200*" to find all bearing names containing 1200 or

"?200*" to find all bearings whose name includes the text "200" at position 2-4.

The list of hits is displayed in Search result.
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4.6.2 Add bearing

To add a bearing to the bearing database  click on Add bearing.

Select a manufacturer from the list.

Enter a name for the bearing in the Label field.

Detailed comments may be entered in the Comment field (optional).

Geometry data or damage frequencies 

Use the Geometry and Frequencies options to  switch between the input fields
in  the  right-hand  area  of  the  window  in  order  to  enter  corresponding  data.
When  inputting  the  contact  angle  select  either  degrees  or  radians  for  units.
When specifying the frequencies enter whether these should be in Hz or rpm.

  

Trendline indicates whether any information still  needs to  be input
in  the bottom  right-hand area of the  window.  The  bearing  can  be
added to the database only if all inputs are completed.

Click on Continue to store the bearing in the bearing database.

If  you  add  or  edit  a  bearing,  it  is  imperative  that  you  check  the
plausib ility of these data. Ensure that you have entered the correct
values  for  the  bearing  data  because  these  are  factored  into  the
calculation.
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4.6.3 Edit / delete bearings

Editing bearings

Click  on  Edit  bearing  and  start  by searching  for  the  corresponding  bearing  as
described at Search bearing .

The  list  of  bearings  found  is  displayed  in  the  Search  results  as  well  as  the
number of hits.

Select the bearing to be modified and click on Continue.

Enter the data for the required bearing as described under Add bearing .

Click on Continue.
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Click  on   to  open  the  Manufacturer  details  window.  You  can
find the contact details for the manufacturer here.

Deleting a bearing

Perform your search as  described above . Then select the desired bearing
for deletion from the Search results.

Click on Delete  bearing to remove the bearing from the database.

You can only delete  bearings  that  you  have  entered  yourself!
Once  all  the  bearings  for  a  particular  manufacturer  have  been
deleted you can also delete the manufacturer .

4.6.4 Export / import bearings

Exporting bearings

Click  on  Export  bearing  and  search  for  the  bearing  you  would  like  to  edit  as
described in Edit/delete bearings .

You can use the Export self-created bearings only option to  restrict the export
to bearings you yourself have entered.

Click  and select the path  and  file  name.  By default,  Trendline  uses  a  file
name  according  to  the  convention
FISBearingDB_export_<year>_<month>_<day>.zip. Alternatively,  you  can
use your own file name.

Importing bearings

Click on Import bearings, then on .

Select the import file.

4.6.5 Manage groups

You  can  use  the  manage  group  feature  to  classify  bearings  with  similar
characteristics, regardless of their manufacturer.

Click  on  Manage  groups  to  call  up  the  bearing  database  group
administration feature. 
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Create a new group

To create a new group click on .

Enter a name for the new group and click OK.
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Assign bearings to a group

To assign one or more bearings to a group proceed as follows:

Select the desired group from the Group list.

Search  for  one  or  more  bearings  as  described  at  "Edit/change  bearing  ->
Search  bearing ".  The  bearings  found  are  displayed  in  the  Unassigned
bearings list.

To  assign  a  bearing  to  the  group  click  on  it  then  click  on  .  The  bearing
should now be displayed in the Assigned bearings list.

To assign all bearings found to the group, click on . All  bearings  should now
be displayed in the Assigned bearings list.

To  delete  a  bearing  from  the  group  click  on  the  bearing  in  the  Assigned

bearings list then click on .

To delete all bearings from the group, click on .

Click on Save assign the bearings to the group in the bearing database.

Rename a group

To rename a group, select it from the Group list and click on .

Enter a new name for the group and click on OK.

Delete a group

To delete a group, select it from the Group list and click on .

Warning!  the  group  is  deleted  immediately  -  you  will  not  be
prompted  to  confirm  this!  You  should  therefore  only  use  these
functions if you are sure that you want to delete a group.

4.6.6 Add manufacturer

Click on Add manufacturer to create a new manufacturer.

Enter the manufacturer's data in the appropriate input fields and click on Next.

Check your input in  the next window that appears.  If  the  input  is  correct,  click
Add  to  save  the  manufacturer  in  the  bearing  database  or  click  Back  to
modify your input.
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4.6.7 Edit / delete manufacturers

Edit manufacturer

Click on Edit manufacturer to modify the data for a manufacturer.

Modify the manufacturer data and click on Next.

In the next window the Trendline shows  your changes  and the original  data for
an easy compare. Click on Save to store your changes in the bearing database

 or click on Back to change your data.

Delete manufacturer

If you have deleted all  bearings  from  a manufacturer from  the bearing  database
(see Edit/delete bearings ), you can also remove the manufacturer.

Click Delete manufacturer.

Then select the manufacture from the Manufacturer list and click Continue.

The manufacturer is then deleted from the bearing database.

You can only delete manufacturers which have been added  by
yourself!

4.6.8 Select bearing database

Click in the Bearing database  dialog on Change database.

Select the database as  described  in  "Select  database" .  The  name  of  the
included bearing database is "cm_bearings".

This opens the bearing database.

4.6.9 Close

To exit the bearing database 

click Close.

4.7 Template and route planning
Constantly recurring plant structures  and measurement tasks  can be performed
efficiently with the help of templates and routes. 

4.7.1 Template planning

A template has the same layout as a measuring point. As with a measuring point,
time signals can be recorded and different characteristic values set. If you want to
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associate a free measurement with  a  certain  measuring  point,  the  template  for
this measurement must have the same layout as the respective measuring point.
That  means  that  the  same  characteristic  values  (with  the  same  cut-off
frequencies) must be set and the  sensor  must  also  be  configured  accordingly.
Time signals and alarm thresholds may differ, as the characteristic values can be
compared none-the-less.

Create new template

To create a new template, open the template planning.

Click in the Planning menu on Template.

Click on  to add a new template group.

Name the template group. On the "Info" page you can include a picture with  
or write a comment in the comment area.

With  you create a new template. Here you can change the name (under
"Info") and insert a picture or comments. On the "General  settings" page you
can  configure  different  settings  depending  on  the  selected  template  (for
more information see "Set up a measuring point ").

Clicking  lets you add new characteristic values  to  the template (for more
information see "Setting characteristic values ").

With   and  with   you  can  unfold  the  tree  starting  from  the  element
selected or close again respectively.
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To add a new balancing  configuration  to  the  template  group  click  on   (for
more information see "Add balancing configuration ").

To add a new run up/coast down configuration to  the template group, click on

 (for more information see "Set up run up/coast down ").

To add  a  new  amplitude/phase  configuration  to  the  template  group,  click  on

 (for more information see "Set up amplitude/phase configuration ").

With  you can delete the element selected from the list.

You can find more information about configuring  measurement
points  and  characteristic  values  in  the  chapter  "Setting  up
configuration".

You can create up to  255 templates per  configuration  type  in  a
template group.

Edit template

To edit a template 

click on the Planning menu on Template.

Edit the settings as described in "Create new template".

The  condition  monitoring  templates  are  protected  against
accidental  editing.  If  you  want  to  edit  a  template,  click  in  the
"General configuration" tab on Unlock template.

Templates from FAG Industrial Services cannot be edited.

You can move or delete single template elements:

- With  and  you can move a selected element within its level up or down.

- With ,  and  you can cut, copy and insert an element.

- With  you can delete a selected element.

Further information in "Tree elements "

Save configuration as template

If you want to save a configuration from a measurement point as template,

select the measurement point in the Trendline configuration and

click in the System menu on Save configuration as template.

Enter a name to the configuration, e.g. "Fan" and
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select a template group.

Click on OK.

The new template will be saved in the template planning. 

Create configuration from template

If you want to create a new configuration from a template,

select a machine from the Trendline configuration and

click in the System menu on Create new configuration from template.

Enter a name to the new configuration and

select a template from a template group.

Click on OK.

The new configuration will be set up.

Export/import templates

In  the  Trendline  Software  you  can  export  and  import  templates.  Further
information in the chapter "Importing and exporting templates ".

4.7.2 Route planning

After  the  system  structure  has  been  entered  into  a  configuration  (or  in  several
configurations as well), you have the option to group parts of those configurations
into routes  using the "Route" function. For example, you could create a  route  for
each day of the week and measure certain  machines  only on Mondays.  Another
example would be a route for a certain mechanic who performs maintenance only
on a few machines of a configuration.

Should you want to take measurements at a measuring point not contained in  the
current route, you can take a free measurement with  the Detector. To  define  the
settings for that, at least one template must have been created  before. In  this
template you can set exactly the same properties as in a normal measuring point,
i.e. characteristic values, sensor type, time signals, etc. 

Create new route

To create a new route, open the route planning.

Click in the Planning menu on Route.
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A new window that is divided into three parts will open. On the left you will  find the
configuration  tree,  in  the  middle  the  routes,  and  on  the  right-hand  side  the
settings,  respectively (same  as  in  configuration  view).  To  create  a  new  route,
follow the sequence below:

Right-click  the  middle  window  and  subsequently on  Add  Route.  Alternatively

you can click on  just as well.

Name the route in  the right window and add a picture, if desired (for that, click

on ).

Now you can add elements from the configuration to  the route. You can do that
in two different ways:

- Left-click in the configuration tree on the element you want to add to the route
. Next, left-click in the middle window on the route you want to  modify. Finally,

click  or select in the contextual menu Add selection.

-  Left-click on the part of the configuration tree you wish to  add. Keep the left
mouse button  pressed  and  drag  the  element  onto  the  name  of  the  route.
Release the mouse button.

With   and  with   you  can  unfold  the  tree  starting  from  the  element
selected or close again respectively.

Repeat  this  procedure  for  all  routes  you  want  to  create,  e.g.  for  Monday  to
Friday. 

Click on  to close the route planning.

Edit route

To change route settings,
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click in Planning on Route.

You can move or delete single route elements:

- With  and  you can move a selected element within its level up or down.

- With  you can delete a selected element.

Print route

In the Trendline software you can print a route report.

Click on .

Select a route.

Click on OK.

Further information in the chapter "route report ".

4.7.3 Send templates and routes

If you have created templates  or routes  (see "Template and route  planning ")
you can transfer them to the Detector.

The transfer of a  new route or configuration to  Detector deletes  all
data stored on the instrument.

Click on Detector > Send route/template or on .

Now you can select a template and/or a route:

Activate Route and select the one you want to send to the Detector.

Activate Send template and select a template group.

Connect the Detector with the data cable to your PC and switch it on.

Click OK to send the route to the Detector.

Another way of sending a route to  the Detector is  directly from  route planning  by
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selecting Planning > Route. Click on . The Send route  window opens. Then
proceed exactly as described above.

If  the  "Always  save"  option  is  marked  for  a  greater  number  of
measurement points in  the route you wish to  send to  the  Detector
than are permitted in  the Detector memory  an  error  message  will
be output. The  data  will  not  be  transferred.  Also  refer  to  "System
messages and their meaning ".

4.8 Download data from Detector
After  using  the  Detector  to  take  a  measurement,  you  must  transfer  the  data  to
Trendline software. 

Connect the Detector with the data cable to your PC and switch it on. 

Click on Detector > Load data from Detector or on . 

Another way of downloading data from the Detector is directly from  route planning

by selecting Planning > Route. Click on   in the route planning.

All  data,  i.e.  configurations,  time  signals  and  free  measurements  are
downloaded to the PC. This process can take several  minutes  depending on the
amount of data.

Once all  data have been received, they are stored  in  the  respective  locations  in
the  database.  It  can  happen  that  the  program  does  not  automatically  sort  the
measuring points, e.g. you have taken free measurements or the configuration on
the Detector had been created on a different PC. In  this  case, the sorting wizard

 will  be  started  automatically  for  sorting  the  measurements  into  your
configuration tree.

4.8.1 Sorting Wizard

When  you  start  the  sorting  wizard,  Trendline  displays  an  information  window
showing you why the data cannot be sorted in. 

Click Next to continue sorting in the data.
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The next window is  divided into  two parts. On the left-hand side you will  find  the
measuring  points  that  are  not  yet  sorted  and  on  the  right-hand  side  your
configuration structure. Here you have two options.

If  there  is  a  measuring  point  that  has  not  yet  been  sorted  in  one  of  the
configurations, drag it with  the left mouse button from  the left window onto the
measuring  point  in  the  configuration.  If  the  two  really  do  match,  the  mouse
cursor changes. You can release the mouse button to insert the measurement.
In  the status  bar  you  can  read  why it  was  not  possible  to  insert  at  a  certain
point.

Alternatively, you can use the suggestions  of the  Trendline  software.  For  this,
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click on Wizard and select a measuring point from the list of proposals.

If the measuring point does  not exist in  the configuration yet, you again have two
possibilities.

If you want to  add a measuring point to  a  machine, drag it  into  the  right-hand
window and onto the machine name to which it should be added.

Additionally, you can add new configurations, sections  and machines  with  the

 and  buttons as you did, when creating the configuration. For information
on this topic, see also "Enter system structure ".

4.9 Viewing measuring data

4.9.1 Measured values

On the Measured values  tab, the selected measured values  are  displayed  in  a
table. When a row is  displayed in  bold, there is  at least one time  signal  for  this
measurement. The time, the measured values determined and any pre-alarms or
alarms  that may have  been  output  are  displayed  for  each  measurement  in  the
measured values view.
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Limit time range

In  order to  limit the time  range  of  the  measured  values  displayed,  select  the
Time range option.

Set the desired start and end date.

Filter by comments

If  you  want  to  display measured  data  with  a  particular  comment,  select  the
option Filter by measurement comments.

Enter the desired comment in  the "Filter" field. You can  use  the  wildcards  "?"
and "*" in the usual way, e.g.

o "*Pump*" to find all measurements containing Pump or

o "?200*" to find all measurements whose comment includes  the text "200" at
position 2-4.

Click on Enter to start filtering or click on Reload.

Changing acquired speed and comment

You can also correct rotational  speeds  in  the Measured value  view  and  edit  the
measured values comment. Proceed as follows:

Click on an entry in the list of measured values.

Click Edit speed and comment.

Enter the new values and click OK.



119

Trendline 3

Displaying measured values in the Viewer

You can display one or multiple measured values in the FIS Viewer.

Double-click on a measurement to view it in the Viewer.

To view multiple  measured  values,  click  the  desired  measured  values  while
holding the CTRL key.

Then double-click one of the selected measurements  while  holding the SHIFT
key.

To  view  the  FFTs  of  one  or  more  measured  values,  each  in  an  individual
window, first select the measured values. Then right click on the selection and
then on Show FFTs in multiple windows.

To view the FFTs  of one or more measured  values  as  a  waterfall  graph,  first
select  the  measured  values.  Then  right  click  on  the  selection  and  on  Show
FFTs as waterfall graph. In the waterfall graph you can view one or more FFTs
in  different  two  or  three-dimensional  views  or  as  a  sonogram.  For  more
information, refer to the chapter "Waterfall graphs".

Show/hide bearing data

Click the Display bearing data for selected measurement button to  display a list
of bearings  assigned  to  this  measuring  point  in  the  configuration .  You  can
also  assign  bearings  to  measurements  or  delete  assignments  here.  The
activation status  of a  bearing is  indicated  by the  disabled  checkbox.  Both  when
making assignments and disabling you can choose whether

bearing data should apply or not for all measurements already performed, or

only for measurements from a certain period

 

Add bearing

Click  and select the bearing from the bearing database.
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Selecting measurements:

If you want to apply the bearing information to all  saved measurements, click
Add this bearing to all existing measurements of this measuring point.

To apply the bearing information to  measurements  in  a  certain  time  range,
click  Add  this  bearing  to  all  measurements  of  following  time  range  and
select the time range.

In the Bearing configuration section enter the speed transmission ratio  (SPF)
and select whether the bearing has a fixed outer race.

Disable bearing

Click on the bearing to delete and then .
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Selecting measurements:

To  delete  the  bearing  information  from  all  saved  measurements  of  this
measuring point, click Disable the bearing  for  all  existing  measurements
of this measuring point.

To  delete  the  bearing  information  from  measurements  in  a  certain  time
range,  click  Deactivate  bearing  for  all  measurements  of  following  time
range and select the time range.

Displaying bearing information

Click  on  the  desired  bearing  and  then  .  This  displays  the  bearing
information in the bearing database.

Further information in Evaluating measured data with the FIS Viewer.

4.9.2 Graphic

On the Diagram tab, Trendline depicts the measured readings in a trend diagram
with  the  aid  of  the  integrated  FIS  Viewer.  The  viewer  provides  a  visual
representation of the signals and characteristic values delivered by the Detector: 

Time signals

Fast Fourier Transformations (FFTs)

Trend data

Additionally alarm  limits  are  displayed  in  the  diagram.  The  main  alarm  limit  is
marked  by a  red  line,  the  pre-alarm  limit  is  marked  by a  yellow  line.  You  can
adjust the alarm limits with the mouse. 
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Time range

Click on Time range  to  limit the shown data to  a  defined period and enter  Start
date and End date.

Alternatively you can select an  End  date  and  enter  the  Number  of  days.  In  this
case, the Trendline sets the Start date automatically.

Full screen

Click on Full screen to scale the graphic to the size of your monitor.

Filter by comments

If  you  want  to  display measured  data  with  a  particular  comment,  select  the
option Filter by measurement comments.

Enter the desired comment in  the "Filter" field. You can  use  the  wildcards  "?"
and "*" in the usual way, e.g.

o "*Pump*" to find all measurements containing Pump or

o "?200*" to find all measurements whose comment includes  the text "200" at
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position 2-4.

Click on Enter to start filtering or click on Reload.

Displayed measurements

Activate  the  check  mark  in  front  of  the  measurements  that  should  be  shown
additionally.

Toolbar

Click Toolbar to show/hide Viewer toolbar. For further information, please refer to
the description of the FIS Viewer in the "Toolbar" section.

Time signal, FFT signal

If a certain value on the trend diagram  is  marked with  a  small  circle, this  means
that there is a time signal for this measurement. You can view this  time signal  by
marking the value with the cursor and then clicking on Time signal/FFT. If there is
no time signal  for the  selected  value,  this  symbol  is  grayed  out  and  cannot  be
selected.

Adjust alarm limits with the mouse

The alarm  limits  are displayed as  colored lines  in  the  diagram.  The  yellow  line
represents  the pre-alarm  limit, the red line the main alarm  limit. You  can  adjust
the alarm limits directly in the diagram  by using the mouse. The changed values
will be set automatically to each characteristic value. 

Press left on an alarm limit line.

Hold the mouse button down while 

dragging the line to the new position.

The originally alarm limit will be displayed as a thin line in the diagram.

A pre-alarm limit cannot be placed above a main alarm limit. 

Changes to  the alarm  limits  are  not  activated  till  they  have  been
sent with a configuration to the Detector.

Print time signal, print FFT signal

Click  these  buttons  to  include  the  respective  signal  in  the  trend  report  (cf.
"Printing").

Print

Click Print to create a trend report. The trend report combines the diagrams of the
selected  measured  data  for  printing.  Each  diagram  is  printed  on  a  separate
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page.

More detailed information on the viewer can be found here.

4.10 Reset alarm status
In the system structure for each element the Trendline software displays  whether
an alarm  or  pre-alarm  was  measured  (also  see  "Main  window ").  It  may be
sensible  to  reset this  alarm  status  if the cause of an  alarm  has  been  identified
and  eliminated.  The  alarm  status  must  be  reset  manually by the  user  as  this
decision cannot be made by the Trendline software.

To reset the alarm status for a  configurations  element (e.g. machine or motor)
and the associated sub-elements, click on the element in the system tree. 

Then click System > Reset Alarm Status.

   

Only the status display in  the system  structure is affected when the
alarm  status  is  reset.  The  measuring  data  status  displays
remain unaffected.

4.11 Delete measured data
You  can  delete  measured  data  for  a  particular  time  range  in  the  database.  In
doing so, the characteristic values (i.e. trend data) and the time signals  recorded
during that period of time are deleted. To delete data follow the sequence below:

Left  click  the  element  in  the  configuration  tree,  from  which  you  want  to  start
deleting  data.  All  data  relating  to  the  measuring  points  of  this  machine  are
deleted for the selected time range.

Click on System > Delete measured data or right-click on this  point and select
delete measured data.
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Opens the Delete measured data:

Select the date and time for the start and end of the desired time range.

Click on Period to deactivate the option and delete all data. 

Click on OK to delete the data for the period selected.

Please  observe  that  the  data  will  be  permanently  deleted  if  you
click "OK" in the above window and cannot be restored! There is no
way of restoring the data!

4.12 Log file
In  an  internal  protocol  file  (also  called  log  file)  are  all  system  messages  and
additional  information  on  import  and  export  operations  are  logged.  If  an  error
occurs  during  Trendline  or  Detector  operation,  then  an  error  message  is
recorded along with additional information in an internal  log file. You can use the
Trendline software to retrieve this log file from the Detector and then send it by e-
mail to our Support.

You can open a log file with a text editor or a word program.

Save log file of the Trendline software

Click on Extras > Save Trendline log file.

Select the saving location and 

click on Save.

Download log file from Detector

With the Trendline software you can download  the  log  file  from  the  Detector  as
follows:

mailto:support@fis-services.de
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Connect the Detector to your computer with the data cable.

Click on Detector > Load Detector log file.

Click on "...", select the saving location and enter the file name.

If the log file should be deleted after transferring to  the Detector, check the box
Delete log file on the Detector after download.

Click OK.

4.13 E-Service
The Trendline software enables you now for the first time to  utilize the services  of
FAG Industrial  Services  GmbH  easily and  conveniently.  Regardless  of  whether
we can assist you with  the selection of measuring points  or  the  analysis  of  the
vibration signals  recorded by you, the E-Services  function allows  you to  send all
data necessary to FAG Industrial Services GmbH by e-mail.

Before you begin

These  services  are  economical,  but  subject  to  charge.  You  will  find  detailed
information  on  our  website  www.fis-services.com.  Or  just  contact  our  sales
department (Tel. +49-(0)2407-9149-99 or sales@fis-services.com). If you have a
valid  service  contract,  you  can  enter  the  contract  number  in  the  Options  menu
(Extras  >  Options  >  E-mail).  The  contract  number  together  with  your  e-mail
address are needed for identification.

Send data

In the configuration tree, select the first element you would like to  use to  send

data. Now, click on  or on Service  >  E-Service. The following window now
opens:

At the top of the window you can  adjust  the  time  range  containing  the  data  you

http://www.fis-services.com
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want to send. If you have unchecked the Time range  checkbox, all  previous  data
will be sent.

Enter at Data to be exported, which data shall  be transferred. If no data  can  be
sent via this selection anymore, i.e. if you want to send alarms only, but no alarms
are in the selection, the OK button will be disabled.

Now click on OK to send the data. Depending on your e-mail  settings  the data
are transferred immediately or they are copied into  an Outlook mail, which you
will have to send manually.

4.14 Create reports
The Trendline software offers the following report types:

The  measurement  report  provides  a  comprehensive  overview  of  the
measured values  for  the  sensors  defined  in  the  configuration  in  tabular  and
graphic form.

You can use the alarm report  to create an overview of pre-alarms  and main
alarms  accumulated  to  date  for  freely  selectable  elements  in  your
configuration.

The  route  report  presents  all  measuring  points  and  corresponding
measurement  signals  for  a  given  route  in  the  form  of  check  lists.  You  can
systematically and reliably "work through" the measuring point of  a  route  with
the aid of the route report.

The  balancing  report  provides  you  with  a  clear  overview  of  balancing
measurements carried out for one element of your configuration.

The run up/coast down report  creates an overview of the run up/coast down
configuration settings and the associated amplitude/phase diagrams.

The  amplitude/phase  report  creates  an  overview  of  the  amplitude/phase
configuration settings and the associated amplitude/phase diagrams.

Also see report options .

4.14.1 Measurement report

To  create  a  measurement  report  click  on  Measurement  report  in  the  Service
menu. The Configure report window opens.
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In this window, you can:

select which measuring points from the configuration should be displayed;

specify the scope and content of the report;

save the report configuration or load a previously saved configuration.

Select measuring points

Trendline displays  all  available  measuring  point  configurations  in  the  left-hand
area of the configuration window.

Select  individual  measuring  points  to  display  the  corresponding  measured
values in the report.

Click on  to select all measuring points.

Click on  to delete the selection.

Scope and content

In the right-hand area of the configuration window you can specify the settings  for
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the scope and content of the measurement report:

Specifying a report time range

Select the Time range option to restrict the period that is reported.

Enter  the  start  and  end  time.  Alternatively,  you  can  enter  the  end  time  and
specify the duration in whole days in the No. of days input field. In  this  case the
start time will be determined automatically.

Filter by comments

If  you  want  to  display measured  data  with  a  particular  comment,  select  the
option Filter by measurement comments.

Enter the desired comment in  the "Filter" field. You can  use  the  wildcards  "?"
and "*" in the usual way, e.g.

o "*Pump*" to find all measurements containing Pump or

o "?200*" to find all measurements whose comment includes  the text "200" at
position 2-4.

Click on Enter to start filtering or click on Reload.

Alarm selection

Pre-alarms and main alarms can be displayed separately or together. 

Click on Report all to select all alarms; to select individual  alarm  types  click on
Report alarms or Report pre-alarms.

Select characteristic values

Under Char. values, select which characteristic values should be displayed.



130

Click on Show trends  to  create a trend graph that of the measured values  for
the period specified.

Click on Selected to  display only a  selection of available  characteristic values
and select the required characteristic values from the list.

You can use the Show table of results  option to  instruct Trendline to  create a
table containing the measured values.

Select time signal / FFT

In  the Time signal / FFT area you  can  specify which  time  signals  are  displayed
and  also  whether  their  corresponding  frequencies  should  be  included  in  the
report.

Click on Time signal or FFT to activate the corresponding display.

Click on Selected to display only a selection of available signals and select the
required signals from the list.

Click on Last time signal / FFT  only  to  display only the  last  signals  saved  in
each case. All previous measurements will be ignored.

Display additional information

The following options can be selected under Additional info:
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Show  measuring  point  pictures  to  include  the  pictures  inserted  in  the
measuring point configuration ;

Show  measuring  point  comments  to  have  the  report  include  comments
entered in the measuring point configuration ;

Show  cover sheet to output a cover sheet.

Save / load report settings

You can save the report settings for use at a later date.

To  do  this,  click  on  the  diskette  symbol.  The  Insert   configuration  name
window opens.

Enter the name of the configuration you would like to  save in  the Configuration
name  field.  If  this  name  already exists,  you  can  either  overwrite  the  existing
configuration or cancel this operation.

Create report

Click on Preview to create the report. The report window opens.

Trendline  outputs  a  warning  if  your  chosen  settings  will  cause  a
substantial  report  to  be  generated  accompanied  by  a  time-
consuming calculation.

You still have the option of canceling the operation at this stage in
order to reduce the report period or the quantity of data that will  be
output.

You can use the toolbar to control the screen display:

The display size can be defined in View. Select Percent adjustable  to  enter a
zoom factor expressed as a percentage in the Percent input field.

You can navigate forwards  or backwards  through the report and  also  jump  to
the start or end of the report using the arrow buttons.

Click on  to print out the report.
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4.14.2 Alarm report

You have the option of displaying main alarms and pre-alarms  in  an alarm  report
using the Trendline software.

The  alarm  report  incorporates  sections  for  main  alarms  and  pre-alarms.  All
characteristic values  for  a  given  measuring  point  will  be  displayed  in  the  main
alarm  section  where  at  least  one  main  alarm  exists  for  this  measuring  point.
Characteristic values  having a main alarm  are displayed in  bold;  for  pre-alarms
they  are  in  italics.  If  neither  a  main  alarm  nor  pre-alarm  exists,  the  relevant
characteristic value is displayed in gray.

Where  a  main  alarm  exists  for  a  characteristic  value,  the  main
alarm threshold is used as reference for the exceeding value, and
where  a  pre-alarm  exists  the  pre-alarm  threshold  is  used  as
reference.

To do this, select the element in  the configuration tree from  which you wish to
create the report.

Click on Service > Alarm report or click on  in the Toolbar .

Select the Time range option to define the limits for the report period. Enter the
start  and  end  time.  Alternatively,  you  can  enter  the  end  time  and  specify  the
duration in whole days in the No. of days  input field. In  this  case the start time
will be determined automatically.

Deactivate the Time range option to incorporate all available data in the report.

Click on OK to create the report. The report window opens.

You can use the toolbar to control the screen display:

The display size can be defined in View. Select Percent adjustable  to  enter a
zoom factor expressed as a percentage in the Percent input field.

You can navigate forwards  or backwards  through the report and  also  jump  to
the start or end of the report using the arrow buttons.

Click on  to print out the report.
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4.14.3 Route report

You can use the Route report  to  create  an  overview  of  settings  and  measuring
points for a specific route.

Click on Route report  in  the Service  menu and  select  a  route  that  has  been
defined in your configuration.

Click on OK to create the report. The report window opens.

You can use the toolbar to control the screen display:

The display size can be defined in View. Select Percent adjustable  to  enter a
zoom factor expressed as a percentage in the Percent input field.

You can navigate forwards  or backwards  through the report and  also  jump  to
the start or end of the report using the arrow buttons.

Click on  to print out the report.

4.14.4 Balancing report

To create a balancing report, click on an element of your  system  structure.  Next
click on Balancing report in  the Service  menu. The Configure report properties
window opens.

Print  balancing  configurations:  If  this  option  is  selected  the  settings  for  the
balancing configuration  are printed with the report.

Print planes: Information on the planes is included in the report.

69
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Print  sensor  positions:  Information  on  the  trigger  sensor  and  vibration
sensors is included in the report.

Print  measurement  details:  The  individual  steps  of  the  balancing
measurement,  the  amplitude  and  phase  of  the  vibration,  the  time  of
measurement and the rotational speed are documented in the report.

Print suggested weights: The suggested weights are documented.

Print  measurement  coefficients:  The  coefficients  determined  during
balancing are also displayed.

Print measurement results: The start and end of the imbalance amplitude, the
imbalance reduction and information on the  balance  weights  determined  are
included.

Click on OK to create the report. The report window opens.

You can use the toolbar to control the screen display:

The display size can be defined in View. Select Percent adjustable  to  enter a
zoom factor expressed as a percentage in the Percent input field.

You can navigate forwards  or backwards  through the report and  also  jump  to
the start or end of the report using the arrow buttons.

Click on  to print out the report.

Further information under Add balancing configuration .

4.14.5 Amplitude/phase report

To create an amplitude/phase report, select an element in  your system  tree and
click Amplitude/phase report in  the Service  menu. The report will  be created for
all amplitude/phase configurations contained in the element that is selected.

Selecting data for the report

Print amplitude/phase configuration: If this  option is  selected the settings  for
the  amplitude/phase  configuration  are  printed.  In  order  to  print  the  sensor

69



135

Trendline 3

settings, choose the option Print sensor settings.

Print  data:  Choose  this  option  to  print  the  measured  data  available  for  the
particular measuring point.

Print  2D  graphics/Print  3D  graphics:  Select  this  option  to  print  the
corresponding amplitude/phase graphs. 

Click on OK to create the report. The report window opens.

You can use the toolbar to control the screen display:

The display size can be defined in View. Select Percent adjustable  to  enter a
zoom factor expressed as a percentage in the Percent input field.

You can navigate forwards  or backwards  through the report and  also  jump  to
the start or end of the report using the arrow buttons.

Click on  to print out the report.

4.14.6 Run up/coast down report

To create a run up/coast down report, select a run up/coast down configuration in
your system tree and click Run up/coast down report  in  the Service  menu. This
displays the Run up/coast down configuration.

Selecting data for the report

Print  configuration  of  run  up  /  coast  down:  If  this  option  is  enabled,  all
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amplitude/phase  diagram  and  run  up/coast  down  test  settings  are  also
printed. To hide/show specific sections of this configuration , please use the
other options.

Print run up/coast down diagrams: The run up/coast down measured data
available  for  the  measuring  point  are  also  printed  as  an  amplitude/phase
diagram, including any frequency bands.

Specifying a report time range

Select the Time range option to restrict the period that is reported.

Enter  the  start  and  end  time.  Alternatively,  you  can  enter  the  end  time  and
specify the duration in whole days in the No. of days input field. In  this  case the
start time will be determined automatically.

Click on OK to create the report. The report window opens.

You can use the toolbar to control the screen display:

The display size can be defined in View. Select Percent adjustable  to  enter a
zoom factor expressed as a percentage in the Percent input field.

You can navigate forwards  or backwards  through the report and  also  jump  to
the start or end of the report using the arrow buttons.

Click on  to print out the report.

4.15 Importing and exporting data

Import and export between different workstations

In Trendline every measuring point in the database has a unique number, the so-
called  GUID  (Global  Unique  Identifier).  This  number  is  only  stored  in  the
database  and  is  not  displayed  in  the  software.  This  allows  configurations  and
measuring  points  to  be  identified  unambiguously  among  several  computers.
Consequently, when exporting data from  one  computer  and  then  reimporting  it,
the  data  will  be  automatically  recognized  and  sorted  correctly.  This  will  be
explained in more detail using an example.

The data that has been measured is evaluated at a central location. However, this
should be measured on several locations. This exports a part of the configuration
containing the measuring  points  for  location  B  and  imports  it  to  a  computer  at
location B in  Trendline. The data are imported  into  the  Detector,  the  measuring
points  are measured and the measured  data  are  read  back  into  the  computer.
The  configuration  is  now  exported  from  computer  B  and  imported  into  the
Trendline  at  the  central  location.  The  following  is  an  graphic  illustration  of  this
behavior.
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4.15.1 Export wizard

The Export Wizard allows for the flexible selection of export data. For example, you
can include pictures  and comments, specify a  period for the data to  be exported
or export only selected data objects.

To export data, proceed as follows:

Click on Export > Export wizard in the File menu. 

This  launches  the  Export  Wizard,  which  guides  you  step  by  step  through  the
export function. First select an export file. 

To do so, click File name and enter a name.

Next decide whether pictures and comments should also be exported. 

Note that pictures in  particular can increase  file  size  dramatically.
Make sure that there is enough memory availab le.

Now decide whether Trendline should export All Data or just a  Selection. If you
select "All data" the exported file may be very large.
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In the next step you can define the export data:

Activate the checkbox before Not yet exported data only, Only measure points
with pre- and main alarm and/or Export all template configurations.
If you selected "All data", you can also Export route information.

Click on Next.

To  export  data  of  a  specific  time  range  activate  Time  range  and  define  the
range. 

Click on Next.

Click on Finish to apply your settings and create the export file.

The data is exported in the Trendline 3 format (tr3).

4.15.2 Export a single measuring point

You can export the data assigned to an individual  measuring point to  a  text file  to
edit them with  another program. The Trendline software saves  the export files  in
one or several files in CSV format ("comma separated values"), i.e. data on a line
are separated by semicolon. You can open files  in  CSV format with  any common
spreadsheet software to get a clear overview of the data in a table.

In addition to the measuring point data proper, the Trendline software also saves
a file  called "VersionInfo.csv" containing details  on the program  version  and  the
database used.

Proceed as follows to save a measuring point:

Click on the measuring point in the configuration tree.

Click on File > Export > Measuring point.

Select the directory where you want to  save the file  and enter a  file  name. The
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program automatically adds the .csv ("comma separated variables") extension.

Click on OK to export the data.

Below is  a  description of the contents  of the export file  depending on the type of
measuring point.

Measuring point from a Cm configuration

If you export a  measuring point from  a CM configuration,  the  Trendline  software
saves a general export file with details of the configuration and other files  with  the
time signals.

The  general  export  file  contains  a  line  for  each  measurement  containing  the
following:

Heading Contents

idx Measurement identification number.

State Alarm Status: 0 – no alarm, 1 – pre-alarm, 2 – main alarm

Timestamp Measurement timestamp.

Velocity Ex port file w ith v elocity  time signal (the signal is an acceleration signal,

see also "Time signals ").

Acceleration Ex port file w ith the acceleration time signal.

Demodulation Ex port file w ith the demodulation time signal.

Data x Characteristic v alue measured

Name x Name of characteristic v alue

Type x Ty pe of characteristic v alue .

Prealarm x Pre-alarm threshold in % of the main alarm threshold.

Alarm x Main alarm threshold.

Measuring point Name of measuring point

export_timestamp Ex port time

Comment Measuring point comment

used_revolution The rotational speed input by  the user after the measurement. This v alue

is identical to the rotational speed actually  measured until it is changed.

config_revolution_delta The max imum rotational speed dev iation set in the measuring point

configuration

config_revolution The rotational speed set in the measuring point configuration.

271

269
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Heading Contents

revolution The acquired speed on the Detector.

viewer_config_x Configuration data for the FIS View er.

The  entries  "Name",  "Type",  "Prealarm",  "Alarm"  and  "Data"  are  created  for
every existing characteristic value, i.e. a  maximum  of four times. x  designates
the serial number of the characteristic value.

The  entries  "Velocity",  "Acceleration"  and  "Demodulation"  refer  to  other  CSV
files with the data of the measured time signals.

The time signal files are structured as follows:

The file header contains the data.

Heading Contents

idx Measurement identification number.

Internal Number Internal number identify ing the measuring point.

Timestamp Timestamp.

ValueUnit Detector channel (v elocity , acceleration or demodulation) of the

measurement, as a figure and in plain tex t.

length Column 1: Internal control index , Column 2: Number of FFT lines set in

the configuration.

Ampl Amplifier setting used in the measurement. Amplification factor = 2Ampl,

w here 0 means amplification factor 1, 6 amplification factor 64. This

constant is already  considered in the time signal v alues.

Scale factor Scale factor for the measurement. This has been w orked into the time

signal v alue already  just as w ell.

Sample rate Sample rate in samples per Second.

Rotational speed The acquired speed on the Detector.

GUID Global unique identification number of the measuring point.

Timesignal count /

FFT count

Number of time signals and FFT v alues

The time signals and FFT values are stored in four columns under the header.

Column 1 contains the time of the measurement in seconds from the start of
the time signal, column 2 contains the time signal measurement.

Column  3  contains  the  frequencies  of  the  FFT  in  Hz,  column  4  the
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amplitudes.

Measuring point from a balancing configuration

If  you  export  a  measuring  point  from  a  balancing  configuration,  the  Trendline
software  saves  a  general  export  file  with  details  on  the  configuration,  the
balancing  jobs  and  the  weights.  In  addition,  the  program  creates  one  file  per
balancing step ("Data File<n>.csv") containing the associated sensor data.

The general export file contains the following details:

Heading Contents

Data File Ex port file w ith the sensor data.

Balancing measurepoint Name of measuring point

Job Number Number of the balancing job.

App. weight 1 amplitude Amplitude of the w eight used in plane 1.

App. weight 1 angle Position angle of the w eight used in plane 1.

App. weight 2 amplitude Amplitude of the w eight used in plane 2.

App. weight 2 angle Position angle of the w eight used in plane 2.

comment Measurement comment.

step_type_text Ty pe of balancing step (reference run, trial run, etc.).

remove_weights_text Indicates w hat w eights w ere remov ed.

The sensor data files contain the following details:

Heading Contents

Sensor position Name of sensor position.

Amp. Coeff. plane 1 Amplitude of the coefficients in plane 1.

Ph. Coeff. plane 1 Angle of the coefficients in plane 1.

Amp. Coeff. plane 2 Amplitude of the coefficients in plane 2.

Ph. Coeff. plane 2 Angle of the coefficients in plane 2.

Speed Rotational speed.

Amplitude Amplitude of the v ibration.

Phase Phase of the v ibration.
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Heading Contents

Timestamp Measurement timestamp.

export_timestamp Ex port time

Measuring point from a run up/coast down configuration

If  you  export  a  Measuring  point  from  a  balancing  configuration,  the  Trendline
software  saves  a  file  containing  the  values  of  the  amplitude/phase  diagram  in
addition to a general export file with details of the configuration.

The general export file contains the following details:

Heading Contents

id Identification number

Run up / coast down

measuring point

Name of measuring point

timestamp Measurement timestamp

Comment Measurement comment

No. data points Number of v alues measured in run up/coast dow n.

bodeplot data file  File w ith v alues from the amplitude/phase diagram

export timestamp Ex port time

The file  with  the amplitude/phase diagram  values  contains  the  following  details
for each diagram value:

Heading Contents

Amplitude Vibration amplitude

Phase Phase of the v ibration

Frequency Rotational speed

4.15.3 Importing data from a Trendline database

You can import configurations  and  measurement  data  that  have  been  exported
with the Export Wizard  in the Trendline software.

Import data of Trendline software from version 3.2

Click on File > Import > Trendline data (.tr3).

137
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Select the import file with the extension "tr3".

Click on OK.

The import window opens.

By default bearing information

- of measurement data will be kept

- at configurations will be overwritten with those from the current database.

To adopt the default import options click on OK.

The imported data will be added in the tree view.

Or:

Click on Expand to define other import options.

Advanced settings

For the import of measurement configurations you can 

- keep the bearing information of the current Trendline database or
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- keep the bearing information of the import file or

- require  a new user request if the Trendline software  detects  different  bearing
information.

In addition, during the import of measurement data you can

- keep the bearing information of the import file and

- replace  missing  bearing  information  with  those  of  the  current  Trendline
database or

- adopt bearing information of the current Trendline database.

If  you  use  other  settings  than  the  default  import  options,  maybe
data are not comparable!

Select the import options.

Or:

Click on Default to use the default import options.

Click on OK to start the import.

The imported data will be added in the tree view.

Import data of Trendline software from version 2.0.x up to 3.0.x

Click on File > Import > Import data from an old database (Version 2.x/3.0.x).

Select the directory with import files.

Click on OK.

The data will  be imported. In  the measurement view a vertical  line  indicates  the
import time and the border between old and new measurement data.

4.15.4 Export and import templates

To export and import templates  proceed as follows:

Export templates

You can export one or more templates from the Trendline software.

Click in the menu Planning on Template.

Click in the toolbar on .

Enter a file name and click on Save.

Activate the checkbox next to the templates that should be exported.

Click on OK.

109
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The templates are exported in the Trendline 3 format (tr3).

Import templates

If you want to import templates in the Trendline-3 format,

click in the menu File on Import and 

select Trendline data (.tr3).

Select the import file in .tr3 format.

Click on Open.

The dialog "Import options for bearing information" opens.

Accept the default settings.

Click on OK.

The templates will be imported to the Trendline software.

4.16 Program settings
You can open the general program settings configuration window via the Extras >
 Options menu item.

A tree view is displayed on the left-hand side of the window and shows a range of
configuration  options  arranged  in  groups.  You  can  expand  the  view  and
configuration options by clicking the symbols in front of the groups.

Information on the individual configuration options is provided or input masks  are
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displayed on the right-hand side of the window.

Edit program settings

Select a group.

Change settings and

click on OK.

4.16.1 General

Name

Click on Name to specify how new configurations, sections, routes, etc. should
be named when you click on New entry or New  sub-entry.

Please  note  that  balancing  plane  identifiers  on  the  Detector  is
limited to four characters.

Language

Click on the Language  selection box and select the dialogue language for the
Trendline software.

System of units setting

In this section you can set the units system for the measured values listed.

The following options are available:

Standard SI units,

Standard US units or

User-defined units. When making these settings you can assign units from the
range of available units to each measured variable individually.

Default values

Click  on  Default  values  to  set  the  standards  for  the  alarm  threshold
adjustment, comment options and the time signal configuration.

If you create a new measuring point, the following values will be automatically set.
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Reminder function for alarm limit adjustment

The Trendline software can remind you about the alarm limit adjustment .

Activate the checkbox Use reminder function for alarm limit adjustment and 

choose when you want to be reminded.

Adjust alarm limits

Configure  the  alarm  limit  settings  as  described  in  "Adjust  alarm  limits
automatically" .

Comment input on the Detector

Here  you  can  specify  whether  you  want  to  enter  a  comment  for  each
measurement on the Detector. Select

"Only manual selection" if you want to select a comment manually,

"Display  after  each  measurement"  if  you  want  to  be  asked  after  each
measurement or

"Enforce after each measurement" if you definitely want to  enter a  comment to
each measurement.

87
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Default configuration for time signals

Here you can configure when time signals should be saved with measurements. 

Select "Never", "Always", "On main alarm" or "On pre-alarm".

If the "Always save" option is selected for more time signals in  the
configuration  that  you  wish  to  send  to  the  Detector  than  are
permitted in the Detector memory an error message will  be output
and  the  data  will  not  be  transferred.  For  more  on  this,  see  also
chapter  "Frequency  analysis"  (see  PDF  "General  information  on
vibration monitoring" on the delivered CD-Rom).

4.16.2 Database

History

Click History.

In  the Number  field  you can adjust how many entries  the list of  recently opened
databases in the File menu will contain. The default value is 10.

Memory usage

Click on Memory usage.

The following information to the used database will be displayed:

- Name of database program

- Name of database server

- Name of database

- used space

- free space

The ratio of free to used memory is also presented as a diagram.

The  displayed  free  space  and  the  diagram  can  only
provide  plausib le  information  when  the  database  and
database server are installed on the same system.

Database optimization

You should run the database optimization  periodically.  This  helps  to  accelerate
the database access and minimizes the used space.
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Click on Database optimization.

4.16.3 Report

Pictures

Click on Pictures.

You can specify what pictures  to  print on a Trendline report  cover sheet here.
The pictures are scaled automatically for the printout.

If you select a  picture in the Vignette area this is printed at the bottom of the cover
sheet on the left.

You can specify which picture is  to  be printed in  the center of the cover  sheet  in
the Large  picture area.

In the Logo section you can specify what logo to print on the top right of all  pages
except for the cover sheet.

To change the pictures, proceed as follows:

Click  Edit  and  select  the  desired  graphics  file.  Trendline  displays  a  preview
and the file name.

To remove a graphic file again click on Delete.

4.16.4 E-mail

Configuration

In order for Trendline to be able to send data by e-mail  (see also E-Service  or
Automatic export ), you must enter the name of the  sender,  the  recipient  and
the contract number.

Click on Configuration.

Enter your own e-mail address in From.

Enter the e-mail address specified in  the contract (e.g. nemo@fis-services.de)
in To and the number of your service contract in Contract number.

You can enter a text in the Comment field which will appear by default when the
e-mail window is opened. 

Advanced settings

Click  Configure  to  set  the  protocol  for  Trendline  to  send  e-mails.  Trendline
supports  Microsoft   Outlook,  MAPI  or  SMTP.  Consult  your  network
administrator to obtain the correct settings.

To test whether e-mails are being transferred correctly click Test connection.

Click OK.

127
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4.16.5 Data view

Configuration

Click Configuration > Configure. 

This  opens  the Configuration window of the Viewer. For further details, refer to
Viewer section "Program settings".

4.16.6 Automatic export

The Trendline software can automatically export data from CM measurements
as  soon as  the  Detector  receives  them.  It  can  automatically send  the  exported
data by e-mail or save them to a compressed ZIP file.

E-mail export

Click on Automatic to activate automatic export and subsequent dispatch by e-
mail.

Click on Only on alarms to carry out the automatic e-mail  export only if the data
received from the Detector contains alarms.

File export

Click on Automatic to tell the software to export data automatically to a file.

Click on  Only on  alarms  to  perform  the  automatic  file  export  only if  the  data
received from the Detector contains alarms.

In  Default  file  name (.tr3)  enter  a  name  for  the  ZIP  file  to  be  saved.  The  file
name must include the ".zip" file suffix.

Select the storage location for the exported file at Default directory.

4.16.7 Update

Update settings

The Trendline software can check in user-defined intervals whether an update for
the  Trendline  of  Detector  firmware  is  available  for  download  from  our  Internet
server.

Click on Update settings.

Configure the settings as described in "Automatic notification for updates ".

223
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4.16.8 Communication

Settings

On the Detector, a  Trend of 2  to  a  maximum  of  20  characteristic  values  can  be
shown. In addition, you can send the latest trend data from the Trendline software
to the Detector. The number is limited to a maximum of 10 values. The trend data
will be send with a configuration to the Detector.

Click on Settings.

Activate Send trend data to Detector and

select how many trend data should be send to the Detector.

4.17 Exit program
To exit the program, 

click File > Close.
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5 FIS Viewer

5.1 About the FIS Viewer
FIS  Viewer  displays  the  signals  and  characteristic  values  provided  by  the  FIS
hardware. With the aid  of the various  Viewer navigation and cursor tools  you can
change  the  display of  the  data  and  perform  an  error  analysis.  The  aim  of  the
analysis is to identify possible damage as exactly as possible so as to  be able to
perform repairs in good time and thus avoid downtimes.

The following chapter explains  the work interface . It goes  on to  provide more
information about working with the Viewer .

5.2 The work interface

5.2.1 Work interface areas

The  toolbar  contains  various  tools  which  can  be  used  to  arrange  the
diagrams  and  display/remove  the  tool  area  and  diagram  information  bar  as
well as other tools which can be used to export measurement data, display the
corresponding  configuration  for  the  data  set  selected  and  create  a
measurement report.

You will find a range of navigation tools in the tools  working area which can
be used to modify the way in which the diagrams are presented and also find a
number of different cursor tools  for  carrying  out  fault  analyses.  The  choice  of
tools  which can  be  used  varies  according  to  the  type  of  diagrams  displayed
(FFTs, time signals or trend data).

The main area of the work interface  contains  the  diagram  and  the  cursor
and measuring information area, in which the corresponding values  for the
selected cursor are displayed. 

You will find additional information in  the diagram  information bar  area (on
measurement  data  for  example)  depending  on  the  diagram  type  displayed.
You can use the tools in this working area to do the following:

o enter comments into the diagram

o select frequency bands with FFTs in order to determine characteristic values
for the fault analysis

o determine  the  maximum,  harmonic  or  sideband  values  from  the  diagram
depending on the cursor type.

The diagram  information bar area for each diagram  can be displayed or  hidden
as required and can be used to zoom in on the diagram area.
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5.2.2 Toolbar

You can use the Tile windows horizontally button to arrange open w indow s

v ertically  abov e one another in the w orking area of the Trendline View er.

You can use the Cascade windows button to arrange open w indow s so they  ov erlap

in the w orking area of the Trendline View er.

You can use the Show current diagram in full screen button to fill the entire screen

of the Trendline View er w orking area w ith the current diagram selected.

You can use the Arrange icons button to arrange minimized w indow s horizontally

from left to right in the w orking area of the View er.

If the Arrange diagrams automatically button is activ ated the size of the diagram

alw ay s adjusts automatically  to fit the av ailable w orking area (w hen the tool area is

display ed or remov ed, for ex ample).

You can v iew  a list of the w indow s that are currently  open and make y our selection

using the Show list of all diagrams button. The selected diagrams are arranged

horizontally  and the rest of the diagrams are minimized.

You can use the Show toolbar button to display /hide the tool bar in the w orking

interface of the Trendline View er.
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You can display /remov e the information bars of all open diagrams using the Show

diagrams information bars.

You can open a list of the w indow s that are currently  open using the Paste selected

diagrams to clipboard button. From this list y ou can also select w hether the

accompany ing information tex t should be copied together w ith the diagram and define

the size of the diagram. The diagrams selected are copied together to the clipboard as

one graphic object.

You can use the Show time signals button to only  show  the time signal w indow s. All

other w indow s w ill be minimized.

You can use the Show FFTs to only  show  the FFT w indow s. All other w indow s w ill

be minimized.

The Show all diagrams button max imizes all diagram w indow s.

The Add additional bearing to the FFT button adds a bearing to the current FFT

from the bearing database.

You can use the Switch back to trendline button to sw itch directly  from the View er to

the Trendline.

5.2.3 Tools

The tools  area  contains  a  range  of  adjustments  which  you  can  use  to  set  the
display area  for  the  diagrams.  A range  of  different  individually tailored  tools  is
available depending on the type of data set displayed (time signals, FFT or trend
data). These tools can be used for example to do the following:

display/hide signals within a series of signals when working with trend data,

modify the scale of measuring ranges,

integrate the velocity and displacement from the acceleration,

modify the display of the measuring range to suit your individual requirements,

navigate through a diagram easily using the navigation overview.
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List of the tools available in conjunction with the corresponding diagram type

Tool Time
signal

FFT Trend
data

Automatic scaling

Manual scaling

Logarithmic display  of ax es

Integration of y -ax is

Free zoom

Horizontal zoom

Vertical zoom

Key board zoom

Base cursor

Measure cursor

Difference cursor

RMS/AMV cursor

Harmonics cursor

Sideband cursor

HS cursor

Rev olutions cursor

Positioning of base cursor

Modify  cursor properties

Copy  to clipboard

Modify ing coordinates of ax es  

Signal distribution    

Trend filtering    

Zoom tools

In order to optimize the display you can enlarge any part of the diagram  using the
various  zoom  tools.  You  can  use  one  of  the  predefined  zoom  tools  for  this  or
define the zoom area numerically via a dialogue window.
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Zoom tools

Tool & symbol Description

Free zoom You can use the Free zoom  tool to enlarge any  giv en rectangular area

on the x - and y -ax is w ithin a diagram.

Horizontal zoom You can enlarge any  part of a diagram in a horizontal direction using

the Horizontal zoom  tool. The range of v alues and scaling of the y -

ax is remain unchanged.

Vertical zoom You can enlarge an area inside a diagram in a v ertical direction using

the Vertical zoom  tool. The range of v alues and scaling of the x -ax is

remain unchanged.

Keyboard zoom You can use the Keyboard zoom  feature to enlarge an area of the

diagram using the key board instead of the mouse.

Specifying zoom selection in dialogue window

In  addition  to  using  the  various  zoom  tools  you  can  also  specify  the  zoom
selection via a dialogue window. To open the dialogue window which is  currently
active click on the zoom tool symbol. 

Cursor tools

You can specify the values  from  a  diagram  to  be  used  for  an  analysis  with  the
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cursor  tools.  Depending  on  the  type  of  diagram  which  has  been  opened
appropriate  cursor  tools  are  made  available  which  can  be  used  to  obtain
individual measuring and characteristic values directly from the diagram.

Information on the current cursor is displayed above the diagram. You can show/
hide these value fields and the cursor by clicking on the cursor tool  symbol  that is
currently active.

Tool & symbol Description

Base cursor

(FFT, time signals,

Trend data)

 
You can use the base cursor to determine the measured v alues on

the x - and y -ax is of a measuring point. 

Measure cursor

(Time signals)

You can use the measure cursor to calculate the difference, the

effectiv e v alue (root mean spare) and the arithmetic mean betw een

tw o measured v alues as w ell as the minimum/max imum v alue.

Difference cursor

(FFT, time signals,

Trend data)

 
You can use the difference cursor to calculate the difference

betw een tw o measured v alues. 

RMS/AMV cursor

(FFT, time signals)  
You can calculate the effectiv e v alue (root mean square) and the

arithmetic mean betw een tw o measuring points using the RMS/AMV

cursor. 

Harmonic cursor

(FFT)  
You can use the harmonic cursor to determine measured v alues at

points in the diagram w here harmonics (multiples of the basic

frequency ) are likely  to occur.

Sideband cursor

(FFT)  
You can use the sideband cursor to determine additional measured

v alues in definable sidebands starting from the base cursor.

HS cursor

(FFT)  
The HS cursor (Harmonic w ith Sidebands) combines both cursor

ty pes described abov e w hich means that both the harmonics and

their sidebands w ill be display ed.
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Tool & symbol Description

Revolutions cursor

(FFT, time signals)  
The rev olutions cursor marks the frequency  that is assigned to a

specific speed w ith a line.  

A  cursor  can  only  be  placed  at  a  measuring  point  that
exists. If you click  on a position in  the diagram  where  no
measured value exists the cursor automatically  jumps  to
the nearest existing measuring point.

Additional tools

In  addition to  the zoom  and cursor tools  you can use a  range  of  further  tools  to
change the manner in which signals or cursors are displayed and transfer data to
other programs via the clipboard.

Tool & symbol Description

Positioning of 

base cursor

Places the base cursor at a point in the diagram specified v ia

numeric input. The base cursor jumps to the measuring point

nearest the v alue entered.

Cursor 

properties

Opens the cursor properties dialogue w indow  w here y ou can

change the properties of the cursor currently  used.

Clipboard Copies an image of the current diagram v iew  into the clipboard (

additional information ).

Change diagram

boundaries

Changes the display  of minimum/max imum v alues for the x - and

y -ax is (additional information ).

5.2.4 Diagram display

The diagram area shows the FFT, time signals and trend data diagrams. You can
specify the desired zoom area inside the diagrams  and adjust the position of the
cursor using the mouse or keyboard.

5.2.5 Cursor and measuring information

The  cursor  information  for  the  Trendline  Viewer  shows  important  values  and
measurement  data  that  vary depending  on  the  cursor  tool  used.  Each  item  of
cursor  information  contains  either  the  value  pairs  for  a  measured  value  or
calculated characteristic values  that are obtained by combining different  cursors
within the diagram such as  the difference cursor or RMS/AMV cursor. The cursor

185
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information can be displayed or removed for each diagram with Ctrl+U. 

The  measuring  information  for  the  Trendline  Viewer  shows  important
measurement data according to the diagram type. This  measuring information is
always visible in the diagram and cannot be removed.

The  table  below  shows  the  corresponding  values  displayed  in  the  cursor
information for the currently active cursor type:

Cursor type Displayed cursor information

Base 

cursor

Measure 

cursor

Difference 

cursor

RMS/AMV 

cursor

Harmonic 

cursor

Sideband 

cursor

HS cursor

Revolutions 

cursor
  

5.2.6 The diagram information bar

You can find the diagram information bar in  the right-hand column of the working
area.  This  column  contains  additional  information  on  the  diagram  currently
selected and can be displayed or hidden as required.
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The table below provides an overview of the corresponding information displayed
with the active cursor type for FFT diagrams in the diagram information bar:

Information displayed in
the diagram
information bar

Base
cursor

Difference
cursor

RMS/AMV
cursor

Harmonics
cursor

Diagram information

Comments

Frequency  bands

Highest peaks

Harmonics 

Sidebands

Kinematic frequencies

Information displayed in the
diagram information bar Sideband

cursor
HS cursor

Revolutions
cursor

Diagram information

Comments

Frequency  bands

Highest peaks

Harmonics 

Sidebands

Kinematic frequencies

The  Measure  cursor  shows  the  same  information  as  displayed  by  Difference
and RMS/AMV cursor plus  Min/Max. Diagram  information and comments  for time
signals  and  trend  diagrams  are  displayed  in  the  diagram  information  bar
irrespective of the cursor type selected. Further, information on the alarm  values
of the data set currently open is displayed in the trend diagrams. 
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Diagram information

This field contains general information about the measurement data including 

Information on the measuring process such as the low pass or sample rate

 Further information included in the data sets.

5.3 Working with the Viewer

5.3.1 Displaying several diagrams simultaneously

You can open several  diagrams  in  the  FIS  Viewer  simultaneously and  arrange
these in the working area according to your needs. 

Select one of the  following  options  from  the  Diagrams  menu:  Tile  horizontally,
Cascade, Full screen, Arrange icons or List….

The windows are rearranged accordingly.

5.3.2 Modifying the appearance of a diagram

Displaying and removing signals

When a new data set is  opened the Viewer simultaneously displays  all  signals
contained  in  the  data.  In  order  to  obtain  a  clearer  overview  you  can  activate  or
deactivate  individual  Signal  selection  in  the  list  shown  below.  All  series  of
measurements  included  in  the  current  data  set  are  listed  in  the  Trendline
software  signals  field.  The  options  Show  alarms  and  Averaging,  are  only
available in Trend.

1. Click on the checkbox in front of the signal.
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This signal will be displayed or removed.

Axis settings

Automatic scaling of axes

The Automatic scaling option sets  the  scaling  of  the  diagram  axes  to  the  next
1000 scale (10³). Based on the base unit of the diagram for measured values  < 1
this  automatically selects  the  next  smaller  unit  (e.g.  g   mg  or  m   mm)  and,
inversely, for values > 1000 the next greater unit (e.g. ms   s or Hz   kHz).

1. Click the "Auto" checkbox to activate it.

The scaling of the diagram will be adjusted automatically.
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Manual scaling of axes

If  you  disable  the  Automatic  scaling  option,  you  can  select  one  of  the  preset,
equivalent units for axis scaling. The available scaling units depend on the type of
diagram  (e.g.  Hz or  kHz  with  FFTs  for  frequencies,  g,  mg,  m/s²  or  mm/s²  for
acceleration values, "orders" for order spectrums, rotations  for angular signals, s
or ms for time signals, etc.). The scaling for the axes  can be set independently of
one another, i.e. you can specify any desired unit for the x- and y-axes individually.

1. Click the "Auto" checkbox to deactivate it.

2. Select one of the units provided in the X unit field.

3. Select one of the units provided in the Y unit field.

The  axes  are  scaled  independently  of  one  another  and  can  be  modified
according to the settings that are selected.

Logarithmic scaling of the y-axis

It may be possible under certain conditions to present signals  more clearly using
a logarithmic scale if they do not contain  zero values  or negative values. You can
therefore switch over to logarithmic scaling in the diagram. 

1. Click on the Log checkbox to activate the logarithmic scaling of the y-axis.

The scaling of the diagram will be modified according to the settings selected.

This option is deactivated if the measurement data cannot
be  presented  logarithmically  (if  the  it  contains  values
smaller than or equal to zero, for example).

Displaying y-axis integrations

You  have  a  number  of  display  options  for  the  integration  of  signals  in  FFT
diagrams that contain an acceleration signal, for example: 

No integration: Acceleration

Velocity

Displacement

1. In  the  Integration  field,  select  the  Acceleration  option  to  not  integrate  the
signal.

2. In the Integration field, select the Velocity option to  display the first integration
of the signal.

3. In the Integration field, select the Path option to  display the second integration
of the signal.

The scaling and display of the diagram will be modified based on the selected
settings.
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Once you have selected the integration option  for  the  y-
axis  you  can  also  modify  the  scaling  of  the  axes  here
(automatic,  manual  or  logarithmic)  and  display  any
desired part of the diagram using the zoom tools.

No integration is possib le in order spectrums.

5.3.3 Using the mouse to control the cursor or zoom function

General

You can position the various cursors by left clicking the mouse.

You can adjust the zoom selection setting by right clicking the mouse. 

With the scroll wheel you can zoom and scroll in diagrams.

Zooming with the scroll wheel

If your computer mouse has a scroll wheel, you can use it to  zoom-in or zoom-out
of diagrams. The zoom area is changed in 10% steps.

Click on the diagram which you want to zoom.

Roll the scroll wheel away from you to zoom in.

Or:

Roll it towards you to zoom out.

Scrolling in a zoom area with the scroll wheel

Click with the scroll wheel in a zoom area and 

move the mouse to the left or right without releasing.
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Mark zoom area with mouse

Select one of the zoom tools  from the selection list.

Mark a zoom area in the diagram using the right mouse button.

Your selection is marked in the diagram.

Reset zoom

Right click on the diagram if you wish to return to the previous zoom selection.

Or:

If you wish to return to the full view of the diagram  hold down the Shift-key and
right click on the diagram

Assign zoom area to other diagrams (Synchronous zoom)

You can assign the zoom area of all diagrams automatically, which have identical
type and base units. Proceed as follows:

If you opened several datasets in the FIS Viewer,

select one of the zoom tools  and

click on the diagram type whose zoom area you want to change.

Hold down the Alt-key and span the area with the right mouse button.

The  zoom  area  of  all  diagrams  with  identical  type  and  base  units  will  be
assigned.

Reset synchronous zoom

Hold down the Alt-key and right click on the diagram if you wish to  return to  the
previous zoom selection.

Or:

To reset all by synchronous zoom changed diagrams, press Ctrl+Alt+Space.

5.3.4 Zoom tools

1. Select one of the zoom tools from the selection list.

2. Mark a zoom area in the diagram using the right-hand mouse button.

Your selection is marked in the diagram.

3. Right click on the diagram if you wish to return to the previous zoom selection.

4. If you wish to  return to  the full  view of the diagram  hold the Shift button  down
and right click on the diagram.
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Free zoom

You can use the Free zoom tool  to  enlarge any chosen rectangular area within  a
diagram:

1. Select the Free zoom tool from the zoom tool  selection list using the mouse or
press the F9 .

2. While holding down the right mouse button, drag the mouse across the section
of the diagram you wish to enlarge.

The zoom selection is now marked dark blue in the diagram.

3. Release the right-hand mouse button.

Your selection is marked in the diagram.

4. Right click once again on the diagram if you wish to return to the previous  zoom
selection. 

or

5. To return to  the full  view  of  the  diagram  hold  the  Shift  button  down  and  right
click on the diagram

Horizontal zoom

You  can  enlarge  any  part  of  a  diagram  in  a  horizontal  direction  using  the
Horizontal  zoom  tool.  The  range  of  values  and  scaling  of  the  y-axis  remain
unchanged:

1. Select  the  Horizontal  zoom  tool  from  the  zoom  tool  selection  list  using  the
mouse or press the F10 .

2. Keeping the right-hand mouse button pressed down, drag the mouse  across
the horizontal section of the diagram you wish to enlarge.

The zoom selection is now marked dark blue in the diagram.
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3. Release the right-hand mouse button.

Your selection is marked in the diagram.

4. Right click once again on the diagram if you wish to return to the previous  zoom
selection. 

or

5. To return to  the full  view  of  the  diagram  hold  the  Shift  button  down  and  right
click on the diagram

Vertical zoom

You  can  enlarge  an  area  inside  a  diagram  in  a  vertical  direction  using  the
Vertical  zoom  tool.  The  range  of  values  and  scaling  of  the  x-axis  remain
unchanged:

1. Select the Vertical zoom tool from the zoom tool selection list using the mouse
or press the F11 .

2. Keeping the right-hand mouse button pressed down, drag the mouse  across
the vertical section of the diagram you wish to enlarge.

The zoom selection is now marked dark blue in the diagram.
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3. Release the right-hand mouse button.

Your selection is marked in the diagram.

4. Right click once again on the diagram if you wish to return to the previous  zoom
selection. 

or

5. To return to  the full  view  of  the  diagram  hold  the  Shift  button  down  and  right
click on the diagram

Keyboard zoom

You can use the keyboard zoom feature to enlarge an area of the diagram  using
the keyboard instead of the mouse.

1. Select  the  Keyboard  zoom  tool  from  the  zoom  tool  selection  list  using  the
mouse or press the F12 button.

2. Use the Ctrl+Q and Ctrl+W buttons to shift the start of the zoom selection.

3. Use the Ctrl+A and Ctrl+S buttons to shift the end of the zoom selection.

4. Use the Ctrl+Y and Ctrl+X buttons to shift the highlighted zoom  selection to  the
right or the left.

5. You can enlarge a section of the diagram by pressing Ctrl+Enter (zoom in).

6. You can reduce a section of the diagram  by pressing  Ctrl+Backspace  (zoom
out).

7. You can return to the full view of the diagram by pressing Ctrl+Space bar.

Defining the zoom selection by inputting values

1. Click the left-hand mouse button on the current zoom tool.

The zoom selection dialogue window opens and shows the current settings  for
the boundary values.

2. Enter a minimum and maximum for the X axis in the appropriate field.
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3. Then enter a minimum and maximum for the Y axis in the appropriate field.

4. Click OK.

The diagram displays your defined zoom selection.

With Reset you can undo your settings.

5.3.5 Cursor tools

A  cursor  can  be  positioned  in  the  diagram  by  clicking
near a measured value or moved by dragging the dotted
vertical  line  along  the  diagram  axis  keeping  the  mouse
button pressed down. 
Sliding  cursors  are  always  represented  by  a  dotted
vertical  line  whereas  fixed  cursors  or  automatically
calculated data displays are represented by a continuous
vertical line.

Base cursor

You can use the base cursor to determine the measured values on the
x- and y-axis of a measuring point. 

To do this, place a base cursor at any desired measuring point in  the
diagram.  The  corresponding  measured  values  are  displayed  in  the
cursor information.
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1. Select the  base  cursor  option  from  the  cursor  selection  list  or  press  the  F2
button.

2. Position the base cursor by left clicking the mouse  near a  measuring point in
the diagram. 

The base  cursor  jumps  to  the  nearest  measuring  point  in  the  diagram.  The
current  position  in  the  diagram  is  represented  by a  vertical  dotted  line.  The
measured  values  for  this  measuring  point  are  displayed  in  the  cursor
information above the diagram.

Measure cursor

You can calculate the difference, the effective value (root mean square)
and the arithmetic mean between two measuring points with the 
measure cursor. Min/max displays the smallest and biggest measure
value of the selected area.

To do this, place the base cursor and a difference cursor at the desired
measuring points in the diagram. The distance between the cursors  is
indicated  by a  colored  bar  directly  above  the  x-axis.  Both  measured
values  obtained with  the cursors  and  the  resulting  differential  values,
Min/Max and RMS/AMV are displayed in the cursor information.
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1. Select the measure cursor option from the cursor selection list or press  the F3
button.

The base cursor and the measure cursor are displayed in  the diagram, these
are connected by a colored bar that runs along and slightly above the x-axis.

2. You can place the base cursor at any desired measuring point in  the diagram
by left clicking.

3. You can  position  the  measure  cursor  at  any desired  measuring  point  in  the
diagram by left clicking while holding down the Shift button.

The cursor information above  the  diagram  displays  the  measured  values  for
the base cursor and measure cursor as well as  the delta  value with  frequency,
minimum/maximum  values  as  well  as  the  arithmetic  and  RMS  value  for  the
selected area.

Calculate spectrum

Another preview is shown in the work interface area, If you select the measure
cursor in the time signal diagram. Under "FFT preview" the spectrum of the time
signal is displayed and updated in real-time. You can calculate a spectrum of the
time signal or a spectrum of definied values of the time signal.

Spectrum of the time signal

1. Select the measure area as described above.

2. Double click on FFT preview.

The spectrogram is displayed in the "Calculated FFT" diagram. 

Spectrum of time signal values

1. Click on Create spectrogram from time signal in the Edit menu.
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2. Enter the Number of values you want to calculate the spectrum  for. The pre-set
value is equal to the maximum applicable value.

The number  values  you  enter  for  the  calculation  will  be
increased automatically to the next power of two.

Example: If you want to  calculate a spectrogram  for 1000
measure values, the calculation value will  be set to  1024
automatically.  The  calculated  FFT  will  contain  512
measure values.

3. Define % overlap.

4. Click on OK.

The spectrogram is shown in the "Calculated FFT" diagram. 

You can change the display under FFT  settings  in  the  work  interface  area  (see
Waterfall charts ).

Difference cursor

You can use the difference cursor  to  calculate the difference between
two measured values. 

To do this, place the base cursor and a difference cursor at the desired
measuring points in the diagram. The distance between the cursors  is
indicated  by a  colored  bar  directly  above  the  x-axis.  Both  measured
values  obtained  with  the  cursors  and  the  resulting  differential  values
are displayed in the cursor information.

198
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1. Select the difference cursor  option from  the cursor selection list or press  the
F3 button.

The base cursor and the difference cursor are displayed in  the diagram, these
are connected by a colored bar that runs along and slightly above the x-axis.

2. You can place the base cursor at any desired measuring point in  the diagram
by left clicking.

3. You can position the difference cursor  at  any desired  measuring  point  in  the
diagram by left clicking while holding down the Shift button.

The cursor information above  the  diagram  displays  the  measured  values  for
the base cursor and difference cursor as well as the delta value.

RMS/AMV cursor

 
You  can  calculate  the  effective  value  (root  mean  square)  and  the
arithmetic  mean  between  two  measuring  points  using  the  RMS/AMV
cursor. 

To do this, place the base cursor and an additional  averaging cursor at
any desired measuring point in the diagram. The distance between the
cursors  is  indicated  by a  colored  bar  directly  above  the  x-axis.  Both
measured  values  obtained  with  the  cursors  and  the  resulting  mean
values are displayed in the cursor information.
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1. Select the RMS/AMV cursor  option from  the cursor selection list or  press  the
F4 button.

The base cursor and the averaging cursor are displayed in  the diagram, these
are connected by a colored bar that runs along the x-axis and slightly above it.

2. You can place the base cursor at any desired measuring point in  the diagram
by clicking the left-hand mouse button.

3. You can position the  RMS/AMV cursor  at  any desired  measuring  point  in  the
diagram  by clicking the left-hand  mouse  button  with  the  Shift  button  pressed
down.

The measured values  of the base cursor, the averaging cursor as  well  as  the
arithmetic  and  RMS  value  for  the  area  specified  are  displayed  in  the  cursor
information above the diagram

Harmonics cursor

 
You can use the harmonics  cursor  to  determine  whether  harmonics
are present in the diagram (integer multiple of a vibration).

To do this, place the base cursor at any desired measuring point in  the
diagram. The harmonics are displayed in each case as  drawn-through
vertical lines. The corresponding measured values are displayed at the
upper end of the vertical  lines, and the measured values  for  the  base
cursor are displayed in the cursor information.



175

FIS Viewer

1. Select the harmonic cursor  option from  the cursor selection list  or  press  the
F5 button.

The base cursor and vertical  lines  are displayed at the harmonic of  the  basic
frequency.

2. You can shift the base cursor to  any desired measuring  point  in  the  diagram
using the left-hand mouse button.

When  the  position  of  the  harmonic  cursor  is  changed  the  harmonics  are
automatically shifted. The cursor  information  above  the  diagram  displays  the
measured values for the base cursor and the micro-increments  that were set.
The measured values of the harmonics are each displayed as  vertical  text next
to the corresponding vertical line.

Sideband cursor

 
You can use the  sideband  cursor  to  determine  additional  measured
values in definable sidebands starting from the base cursor.

To  do  this,  the  base  cursor  must  first  be  placed  at  any  desired
measuring  point  in  the  diagram.  You  can  then  shift  the  nearest
sideband  to  another  measuring  point  in  the  diagram.  All  other
sidebands that are displayed are simultaneously adjusted.
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1. Select the sideband cursor option from the cursor selection list or press the F6
button.

The  base  cursor  and  vertical  lines  are  displayed  at  the  sidebands  of  the
frequency.

2. You can use the left-hand mouse button to shift the base cursor to  any desired
measuring point in the diagram and also modify the position of the sidebands.

The cursor information above  the  diagram  displays  the  measured  values  for
the base cursor as  well  as  the differential  delta  of  the  sideband  frequencies.
The  measured  values  of  the  sidebands  are  each  displayed  vertically as  text
next to the corresponding vertical line.

HS cursor

 
The HS cursor (Harmonic with Sidebands) combines both cursor types
described  above.  This  means  that  the  measured  values  of  the
harmonics and their sidebands will be displayed.
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1. Select  the  HS  cursor  option  from  the  cursor  selection  list  or  press  the  F7
button.

The base cursor and vertical lines are displayed at each harmonic of the base
cursor frequency as well as its sidebands.

2. You can use the left-hand mouse button to shift the base cursor to  any desired
measuring point in the diagram and also modify the position of the sidebands.

The cursor information above  the  diagram  displays  the  measured  values  for
the base cursor as  well  as  the differential  delta  of  the  sideband  frequencies.
The measured values of the harmonics are each displayed as  vertical  text next
to the corresponding vertical line.

Revolutions cursor

 
The  revolutions  cursor  marks  the  frequency  that  is  assigned  to  a
specific speed with a line. 
The revolutions  value is  calculated as  follows:  Revolutions  n  [Rpm]  =
60 * Frequency f [Hz]

1. Select the revolutions cursor option from the cursor selection list or press  the
F8 button.

The "revolutions cursor" dialogue opens.

2. Activate  or  deactivate  the  options  for  the  cursor  settings  in  the  "revolutions
cursor" dialogue.

3. Enter any desired speed in the rpm field and click OK. The revolutions cursor is
displayed differently, depending on the type of diagram (FFT or time signal):

In  an  FFT  diagram,  a  single  revolutions  cursor  is  displayed  at  the  point
previously  specified  for  the  speed  in  the  dialogue.  The  cursor  information
above the diagram shows the base cursor value as well as the speed setting. 
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For  a  time  signal  a  speed  field  with  a  series  of  revolutions  cursors  is
displayed.  In  this  case  the  individual  lines  correspond  to  an  additional
revolution before or after the current position of the base cursor. If you move the
base cursor or position it at another measuring  point,  the  speed  field  moves
automatically with it.

5.3.6 Positioning of base cursor

 
You can position the base cursor at a point in the diagram defined via
numeric input in the base cursor positioning dialogue box. The base
cursor jumps to the measuring point nearest to this position.
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1. Click  in the toolbar.

The base cursor positioning dialogue is displayed.

2. Select the Move cursor to the nearest sample at option and enter any desired
value inside the diagram area in the input field.

or

3. Select  the  Move  base  cursor  to  measure  point  index  option  and  enter  an
index value for the corresponding measured value in the input field.

4. Click OK.

The base cursor is now positioned at the position you entered numerically.

5.3.7 Modify cursor properties

Using the cursor properties dialogue, you can change the properties of
the cursor currently selected.

1. Click  in the toolbar.

A dialogue  showing  the  currently  selected  properties  of  the  cursor  tool  will
open.

2. Activate or deactivate the relevant fields in the dialogue window and pick one of
the values in the selection boxes or enter the respective value in the input fields
provided.

3. Click OK.

The cursor properties are applied and saved.

General cursor properties

You  can  modify the  general  cursor  options  described  below.  These  properties
apply  to  all  available  cursor  types.  To  do  this,  activate  or  deactivate  the
corresponding checkboxes in the dialogue window.
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Drag cursors to
nearest peak

Switched  on:  the  cursor  jumps  to  the  maximum  value
which  is  nearest  the  mouse  pointer.  If  no  maximum
value  can  be  found  immediately  near  the  mouse,  the
cursor remains in its previous position.

Switched  off:  the  cursor  jumps  precisely  to  the
measuring  point  in  the  diagram  which  is  nearest  the
mouse pointer. 

Show peaks Switched  on:  in  addition  to  the  vertical  lines  current
symbols  are  used  to  label  measured  values  at  the
characteristic  points  of  the  various  cursors  in  the
diagram.

Switched off: the symbols that identify measured values
at  characteristic  points  are  removed.  The  vertical  lines
will still be displayed.

Show units in 
info boxes

This  option  is  only  relevant  for  the  cursor  information
display which must also be switched on.

Switched on: numerical  values  and units  for the current
cursor are displayed in  the  information  boxes  at  cursor
information.

Switched off:  only the  numerical  values  for  the  current
cursor are displayed in  the  information  boxes  at  cursor
information.

Modifying the properties of the base cursor

When using the base cursor you can only modify the general  cursor  options
described above. To do this, activate or deactivate the corresponding checkboxes
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in the dialogue window.

Modifying the properties of the measure cursor

When using the measure cursor you can only modify the general  cursor options
 described  above.  To  do  this,  activate  or  deactivate  the  corresponding

checkboxes in the dialogue window.

Modifying the properties of the difference cursor

When using the difference cursor you can only modify the general  cursor options
described  in  Modify cursor  properties .  To  do  this,  activate  or  deactivate  the
corresponding checkboxes in the dialogue window.

Modifying the properties of the RMS/AMV cursor

Similarly, when using the RMS/AMV cursor you can only modify the general  cursor
options  described  in  Modify  the  cursor  properties .  To  do  this,  activate  or
deactivate the corresponding checkboxes in the dialogue window.

Editing the properties of the harmonic cursor

In addition to the general cursor options described in Modify the cursor properties
 you can also modify the additional options for the harmonic cursor (described

below).  To  do  this,  activate  or  deactivate  the  appropriate  fields  in  the  dialogue
window or select the respective value from the selection boxes.

Cursor type:

Standard

The  harmonics  are  precisely calculated  for  the  current
cursor. The indicators  for the harmonics  are set so they
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locate  the  nearest  measured  value  for  the  harmonics
calculated.

Micro steps

Micro steps  are necessary to  allow  the  basic  frequency
to  be  more  precisely defined.  In  this  selection  box you
can enter the increment  between  two  measured  points
that will be used to  specify the basic frequency and also
calculate the harmonic.

Cursor type:

Smart peak
detection

The  harmonics  are  precisely calculated  for  the  current
cursor. The indicators  for the harmonics  are set so they
locate  the  nearest  maximum  value  for  the  harmonics
calculated. 

Nearest points

The Trendline Viewer calculates the precise mathematic
values of the harmonics. The intelligent cursor analyses
the  number  of  nearest  points  specified  in  this  field
(measuring points  in  the diagram  in  both directions) for
maximum  values  and  positions  the  indicator  for  the
harmonic at the nearest maximum value.

Calculated harmonic In  this  field  you can enter the number of harmonics  that
must be calculated in each case.

In this  field  you can enter the number of sub harmonics
that must be calculated in each case.

Show coordinates Switched  on:  the  coordinates  (value  pairs)  of  the
harmonics are displayed in the diagram.

Switched  off:  the  coordinates  (value  pairs)  of  the
harmonics are removed from the diagram.
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Show vertical lines Switched  on:  the  harmonics  are  identified  in  the
diagram using the cursor symbol and a vertical line.

Switched off: the harmonics are identified using only the
corresponding cursor symbol.

Modifying the properties of the sideband cursor

In addition to the general cursor options described in Modify the cursor properties
 you  can  also  modify additional  options  of  the  sideband  cursor  (described

below).  To  do  this,  activate  or  deactivate  the  appropriate  fields  in  the  dialogue
window or select the respective value from the selection boxes.

Number of sidebands In  this  field  you can enter the number of sidebands  that
must be calculated for the current cursor in each case.

Nearest points The Trendline Viewer calculates the precise mathematic
values  of the sidebands. The number of  nearest  points
specified in  this  field  (existing  measuring  points  in  the
diagram) are then analyzed for maximum values  and the
sideband marker is  positioned at the nearest maximum
value.

Show coordinates Switched  on:  the  measured  values  of  the  respective
sidebands  on  the  x-  and  y-axes  are  displayed  at  the
vertical lines.

Switched off: the measured values of the sidebands are
removed from the display.

Show vertical lines Switched  on:  the  harmonics  are  identified  in  the
diagram using the cursor symbol and a vertical line.
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Switched off: the harmonics are identified using only the
corresponding cursor symbol.

Editing the HS cursor properties

In addition to the general cursor options described in Modify the cursor properties
 you can also modify the options  for the HS cursor (described below). To  do

this, activate or deactivate the appropriate  fields  in  the dialogue window or select
the respective value from the selection boxes.

Calculated harmonic In  this  field  you can enter the number of harmonics  that
must be calculated in each case.

Nearest points Each  harmonic  is  determined  precisely  using  a
mathematical  formula.  You  can  enter  the  number  of
nearest  points  to  the  left  and  right  of  the  harmonic
identified  to  be  analyzed  for  maximum  values.  The
highest  value  in  each  case  is  then  labeled  as  a
harmonic and displayed.

Number of nearest 
points

Each  sideband  is  also  determined  precisely  using  a
mathematical  formula.  You  can  enter  the  number  of
nearest  points  to  the  left  and  right  of  the  sideband
identified  to  be  analyzed  for  maximum  values.  The
highest  value  in  each  case  is  then  labeled  as  a
sideband and displayed.

Show coordinates Switched  on:  the  measured  value  for  each  harmonic
and  sideband  on  the  x-  and  y-axes  is  displayed  at  the
vertical line.

Switched  off:  the  measured  values  of  the  harmonics
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and sidebands are removed from the display.

Show vertical lines Switched  on:  the  harmonics  and  sidebands  are
identified in  the diagram  using the cursor symbol  and a
vertical line.

Switched  off:  the  harmonics  and  sidebands  are
identified using only the corresponding cursor symbol.

Modifying the properties of the revolutions cursor

In addition to the general cursor options described in Modify the cursor properties
 you can also modify the additional  option for the revolutions  cursor –  this  is

described below. To  do  this,  activate  or  deactivate  the  appropriate  fields  in  the
dialogue window or enter the appropriate value in the input field.

RPM Enter  a  rotational  speed  [rpm]  in  the  input  field.  The  Trendline
Viewer  uses  this  value  to  calculate  the  corresponding  frequency
and positions  the revolutions  cursor  at  the  appropriate  location  in
the diagram.

5.3.8 Other tools

Copying a diagram as a graphic to the clipboard

You can use this tool to copy the current diagram view to the clipboard.

1. Click on the Copy diagram to clipboard symbol.

2. Switch to the application in which you would like to insert the image.
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3. Select  the  Paste  option  from  the  Edit  menu  for  the  application  or  use  the
shortcut Ctrl+V

Change diagram boundaries

You can use this tool to change the minimum/maximum values
displayed on the x- and y-axis.

1. Click on the Change diagram boundaries symbol.

The "Modify maximum values" dialogue is displayed.

2. Enter a new minimum/maximum value for the X and/or Y axis in the appropriate
boxes. Click Reset to restore values automatically calculated by the Viewer.

3. Select an additional option:

o Apply settings to the selected diagram only:  Only the diagram  activated in
the signal selection (see "Displaying and removing signals" ) is changed.

o Apply settings to all diagrams with the  same  axis  unit:  All  diagrams  with
the same axis unit – e.g. "g" – are changed.

o Apply settings to group: All  diagrams  belonging  to  the  same  configuration
as the selected signal are changed.

o Apply settings  to  all  diagrams  with  the  same  type:  All  diagrams  of  the
same type – e.g. "time signals" – are changed.

o Reset  all  customizations  of  the  selected  diagram:  The  settings  for  all
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diagrams  of  the  active  window  are  reset  to  the  values  automatically
calculated by the Viewer.

o Reset all customizations of all diagrams: The settings for all diagrams in  all
Viewer  windows  are  reset  to  the  values  automatically  calculated  by  the
Viewer.

4. Click OK.

The  diagram  (and  other  diagrams  if  relevant)  is  displayed  with  the  chosen
settings applied.

Or:

Click on Cancel to discard the changes.

Edit rotational speed 

Use this  tool  to  change the rotational  speed  information  in  an  FFT  or
time signal. 

1. Click on the Edit rotational speed symbol.

The "Edit rotational speed" dialogue is displayed.

2. Click  on  the  signal  whose  rotational  speed  you  wish  to  change.  If  there  are
multiple signals, you can right-click to select or deselect them all.

3. Enter the appropriate  speed  in  the  Rotational  speed  box and  select  the  unit
(rpm or Hz). The rotational  speed is  automatically converted when you change
the unit.

4. Click  Apply rotational  speed  to  selection  to  allocate  the  new  speed  to  the
selected signals.

5. Click Reset select to defaults to undo the change of speed.
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6. Click OK to apply the changes or Cancel to discard them.

5.3.9 Using the diagram information bar

Displaying the diagram information bar of the viewer

The  diagram  information  bar  contains  additional  information  on  the  diagram
displayed and outputs the relevant characteristic measured values in tabular form
depending  on  the  cursor  selected.  There  are  a  number  of  ways  in  which  the
diagram information bar can be displayed.

Adjusting the default setting for the diagram information bar display via the
Viewer options

The default setting for the diagram  information bar display can be adjusted  with
the Viewer options. The settings  can be configured individually for each diagram
type  (FFT,  time  signal  or  trend  data).  This  default  setting  is  used  when  new
diagrams are opened.

1. Click on the Extras menu.

2. Select the Options menu item.

The Viewer options dialog opens.
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3. Select  the  Diagrams  heading  in  the  left-hand  column.  Open  the  navigation
menu by clicking the mouse on the "+" symbol.

4. Select the desired  diagram  type  (FFT  diagram,  time  signal  diagram  or  trend
diagram) you want to change the setting for.

The options for the selected diagram type are displayed in the right-hand field.

5. Activate  the  Show  diagram  info  bar  at  startup  checkbox  in  the  Diagram
information bar field. 

The changes are applied the next time this diagram type is opened.

Displaying the diagram information bar with the mouse

1. Click the mouse on the slim grey bar to the right of the diagram display.

The diagram information bar appears.

2. Once the diagram information bar is  displayed, click on the narrow grey bar to
the left of the diagram display.

The diagram information bar is hidden.
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Displaying the diagram information bar with the keyboard

1. Use the keyboard shortcut Ctrl+I to display the diagram information bar.

The diagram information bar appears.

Displaying frequency bands

The  diagram  data  in  an  FFT  diagram  contain  important  frequency  bands  from
which characteristic values  may be determined. The frequency bands  which  are
defined  by the  higher-level  application  are  highlighted  in  color  in  the  diagram.
These  frequency bands  cannot  be  edited  in  the  Trendline  Viewer  but  can  be
displayed or hidden as required. Frequency bands are only displayed in FFTs.

Double-click on  a  frequency band  to  zoom  in.  If  Select  characteristic  value  in
trend diagram is enabled, clicking on a frequency band automatically selects  the
appropriate signal in the trend diagram. 

Frequency bands are only displayed in FFTs.

1. To activate or deactivate a frequency band in an FFT diagram click the checkbox
in front of the preferred frequency band in the list.

The frequency bands selected are displayed in the diagram as colored fields

You can switch the display of all frequency bands  in  an FFT diagram  on or off via
the context menu in the frequency band information window.

1. Right click the mouse at any desired point in the frequency band window in  the
diagram information bar.

2. Click Select all in the context menu to display all available frequency bands.

Or:

3. Click Remove all in  the context menu to  remove all  available  frequency bands
from the diagram.

The frequency bands are displayed or removed depending on the setting.
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Kinematic frequencies

If  you  have  added  one  or  multiple  bearings  to  a  spectrum  from  the  bearings
database  using  the  Add  bearing  tool,  the  characteristic  bearing  data  are
displayed in the Kinematic frequencies box.

The following information is displayed:

Manufacturer / Bearing designation

BPFO: Outer race frequency

BPFI: Inner race frequency

BSF / 2xBSF: Single and double roller frequency

FTF fixed outer race: Cage frequency at fixed outer race

FTF fixed inner race: Cage frequency at fixed inner race

If  a  rotational  speed  is  available  for  the  spectrum  (see  Other  Tools   Add
bearing ),  the  FIS  Viewer  can  also  display  the  bearing  frequencies  in  the
spectrum.

1. Check the Bearing frequencies checkbox to do so.

2. Click on the bearing frequency in  the Kinematic frequencies  box to  display in
the spectrum.

The selected frequency is  displayed in  the spectrum. The bearing frequencies
multiplied by the current rotational  speed are displayed in  parentheses  in  the
Kinematic frequencies box.

Inserting comments into the diagram

You can assign  comments  to  individual  measuring  points  in  the  diagram.  The
comments in the diagram are presented at the corresponding measuring point in
an information field if the display field is activated. 

185
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You can move the comment dialog by left-clicking on the dialog and dragging it to
the desired position.

1. Select the preferred measuring point using the base cursor.

2. Click  the  Add  button  in  the  Comments  field  in  the  right-hand  section  of  the
Trendline Viewer information area.

3. Enter a comment for the measuring point selected at the line provided for this
in the table.

The comment is  displayed in  the  diagram  next  to  the  appropriate  measuring
point and can be moved by left-clicking and dragging it.

To change the allocation of the comment to the measuring point (shift on the X
axis), click on the black triangle for the comment and drag it to  the appropriate
measuring point.

When you select a comment in the list, it is displayed on a colored background
in the diagram.

Hover  the  mouse  over  a  comment  in  the  list  of  comments  to  display  the
comment details in a tooltip at the mouse position.

Displaying maximum values

The Highest peaks box shows the highest measured values  on the Y axis  of the
diagram.  You  can  define  the  number  of  maximum  values  displayed  via  the
selection box. You can use the checkbox provided to display the maximum  values
in the diagram view.
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1. If  you  wish  to  modify  the  number  of  maximum  values  displayed,  click  the
Number of maximum values radio button in the Highest peaks box.

2. Check  the  Mark  peaks  checkbox  to  display  the  corresponding  maximum
values in the diagram.

Displaying the measured values of harmonics

If the Harmonic cursor  is  selected, this  diagram  information  area  is  displayed.
The  table  shows  the  measured  values  that  most  closely  correspond  to  the
harmonic.

The Harmonics  table  displays  the  measured  values  for  each  harmonics  value
calculated.

Modifying the settings for the harmonic cursor

You can  modify the  settings  used  to  calculate  the  harmonics  via  the  harmonic
cursor properties. 

1. To modify the settings click on the Cursor properties symbol in  the "Navigation
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and Tools" field .

2. Modify the settings in the cursor properties dialogue field.

Copying measured values for the harmonics using the clipboard

You can transfer measured values  for the harmonics  to  other applications  using
the clipboard. 

1. Highlight each measured value you wish  to  transfer  to  another  application  in
the table  or right click on the table  and choose the Select all menu item  from
the context menu.

2. To copy the measured values you have selected to the clipboard, right click  on
the table. Pick the Copy selected values to the clipboard menu item  from  the
context menu.

3. Switch to  the other application and click the paste symbol  or select the  Paste
menu item from the Edit menu.

Displaying the measured values of sidebands

If  the  sideband  cursor  or  HS  cursor  is  selected,  this  field  is  displayed  in  the
information area. It contains  the measured values  that most  closely correspond
to the defined sidebands.

The Sidebands  table  displays  the  measured  values  for  the  relevant  sidebands
calculated.

Modifying the settings for the sideband cursor

You can  modify the  settings  used  to  calculate  the  sidebands  via  the  sideband
cursor properties. 

1. To modify the settings click on the Cursor properties symbol in  the "Navigation

and Tools" field .
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2. Modify the settings in the cursor properties dialogue field.

Copying measured values for the sidebands via the clipboard

You can transfer measured values for the sidebands  to  other applications  via  the
clipboard. 

1. Highlight each measured value you wish  to  transfer  to  another  application  in
the table  or right click on the table  and choose the Select all menu item  from
the context menu.

2. To copy the measured values you have selected to the clipboard, right click  on
the table. Pick the Copy selected values to the clipboard menu item  from  the
context menu.

3. Switch to  the other application and click the paste symbol  or select the  Paste
menu item from the Edit menu.

Hiding diagram information bar of the Viewer

Adjusting the default setting for removing the diagram information bar from
the display via the Trendline Viewer options

The default setting for the diagram  information bar display can be adjusted  with
the Trendline Viewer options. The  adjustments  can  be  made  for  each  diagram
type individually (FFT, time signal  or trend data diagrams). This  default setting is
used when new diagrams are opened.

1. Click on the Extras menu.

2. Select the Options menu item.

The options dialog for the Trendline Viewer opens.
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1. Select  the  Diagrams  heading  in  the  left-hand  column.  Open  the  navigation
menu by clicking the mouse on the "+" symbol.

2. Select  the  required  diagram  type  (FFT  viewer,  time  signal  viewer  or  trend
viewer) you want to change the setting for.

The options for the selected diagram type are displayed in the right-hand field.

3. Deactivate the Display right diagram information bar  at start up  checkbox in
the Diagram information bar field. 

The changes are applied the next time this diagram type is opened.

Hiding the diagram information bar with the mouse

1. Click on the narrow grey bar to the left of the diagram information bar.

The diagram information bar is hidden.

Removing the diagram information bar using the keyboard

1. Use  the  keyboard  shortcut  Ctrl+I  to  hide  the  diagram  information  bar  in  the
display.

The diagram information bar is hidden.
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5.3.10 Export diagrams and information

With the FIS Viewer, you can copy diagrams  to  the clipboard or save diagrams  in
JPG or BMP format. The exported diagrams contain the cursor and measurement
information and optionally an information text with  the diagram  titel. The diagram
information bar is  not exported. Diagram  dimensions  and further options  can be
specified in the program  settings . Furthermore you can copy measuring data
and the content of the diagram  information bar to  the clipboard, to  insert it in  an
other application.

Modify the diagram appearance and proceed as follows.

Copy current diagram to clipboard

Select a diagram by clicking on the diagram windows.

Click on Copy current diagram to clipboard in the Edit menu.

Switch to the application in which you would like to insert the diagram.

Select  the  Paste  option  from  the  Edit  menu  for  the  application  or  use  the
shortcut Ctrl+V.

Copy selected diagrams to clipboard

Click on Copy selected diagrams to clipboard in the Edit menu.

Or:

Click on  in the toolbar.

205
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Activate the check box in  front of the available  diagrams, to  select diagrams  to
be copied.

If you want to adjust the clipboard settings, click on "Save settings" if wanted to
adopt changes in the program settings .

Click on OK.

Switch to the application in which you would like to insert the diagram.

Select  the  Paste  option  from  the  Edit  menu  of  the  application  or  use  the
shortcut Ctrl+V.

Save current diagram as image

Select a diagram by clicking on the diagram window.

Click on Save current diagram as image in the Edit menu.

Select the saving directory,

enter a file name and

select the file type JPG (JPEG format) or BMP (Windows Bitmap format).

Click on Save.

Copy diagramm information to clipboard

All diagram information of a selected diagram can be copied to the clipboard.

Select a diagram by clicking on the diagram windows.

Click on Copy diagram information to clipboard in the Edit menu.

Switch  to  the  application  in  which  you  would  like  to  insert  the  diagram
information.

Select  the  Paste  option  from  the  Edit  menu  of  the  application  or  use  the
shortcut Ctrl+V.

Copy measuring data to clipboard

You can copy the measuring data of a diagram to the clipboard.

Select a diagram by clicking on the diagram window.

Press Ctrl+V.

Switch  to  the  application  in  which  you  would  like  to  insert  the  diagram
information.

Select  the  Paste  option  from  the  Edit  menu  of  the  application  or  use  the
shortcut Ctrl+V.

5.3.11 Waterfall charts

FFTs  and  order  spectrums  can  be  displayed  as  three-dimensional  waterfall
charts. For this  type of display, the  same  tools  are  available  as  for  the  two-
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dimensional  display. If  you  have  selected  multiple  datasets,  the  corresponding
FFTS are also displayed in a window.

You can configure the display under FFT settings with Display mode. 

Display mode

2D stacked (only in case of multiple diagrams): The diagrams  are displayed
two-dimensionally with separate axes on top of each other.

2D stacked (only in case of several diagrams): The diagrams are displayed in
a diagram with the same axes.

3D Wireframe: The diagrams are displayed spatially behind each other, sorted
by date (the "oldest" value at the front). The order of the curves  can be changed
by pressing CTRL+F.
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3D Area: The surfaces  under the signal  curves  are  displayed  in  a  completed
fashion. The order of the curves can be changed by pressing CTRL+F.

3D Mountains: For this type of display, the surfaces under the signal curves  are
displayed in a completed fashion. In addition, the peaks between the individual
diagrams are connected by planes. The order of the curves  can be changed by



201

FIS Viewer

pressing CTRL+F.

Sonagram:  For  this  type  of  display,  the  diagrams  are  displayed  as  colored
surfaces  on  top  of  each  other  in  which  the  signal  values  are  indicated  as  a
color value. This type of display is  especially well-suited for comparing a large
number  of  measurements  across  a  long  timeframe.  Here,  the  sonogram
makes  it  easy to  recognize  whether  a  machine  is  running  at  a  decreasing
speed in a resonance range. If the speed is dropping, the peaks of the FFT will
normally be smaller; in the resonance range they will be larger.
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The assignment of colors  to  signal  values  can be changed in  the color scale on
the right-hand side of the window. Click and hold down the mouse button in  the
color scale and drag the colored bar up or down. The diagram  is  updated in  real
time. In this way you can quickly distinguish relevant areas for your analysis.

Using zoom and cursor tools

In  the waterfall  diagram  you  have  the  same  zoom  and  cursor  tools  as  for  two-
dimensional  diagrams  (for more on this, see Zoom  tools /cursor tools ). If
multiple diagrams are displayed, you can select the signal  you would like to  edit
with the cursor tool in the Signal selector.

Click  the  preferred  signal.  The  signal  you  have  chosen  is  highlighted  by  the
cursor signal  (yellow triangle). As  soon as  you have positioned the basis  cursor
on  a  diagram  value,  the  corresponding  values  are  connected  in  the  other
diagrams by a transparent yellow plane.
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5.3.12 Program settings

To edit program settings for the Viewer, click Options in the Extras menu.

Modifying the global settings

You  can  restore  the  factory settings  for  the  Trendline  Viewer  using  the  Global
dialogue window (status following initial installation of the software).

Click the Reset all options to factory defaults! button

and confirm by clicking OK.

The settings are reset.
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Units

In the  Units dialogue window, you can specify the options  for scaling units  used
in the diagrams. 

In  the  Unit  selection  area  all  measurement  types  are  listed.  Besides  the
preferred  unit  and  an  information  about  scaling  are  shown.  The  preferred  unit
cannot be changed at  ISO  and  US  units.  The  automatic  scaling  is  activated  by
default at this profiles.

By  selecting  "custom"  you  can  assign  the  preferred  unit  depending  on  the
measurement type. Here the automatic scaling can also be set.
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Select the units profile.

To change the preferred unit or automatic scaling,

select the profile Custom and

define the settings for single measurement types.

Clipboard

You can select the options  for  transferring  the  diagrams  to  the  clipboard  in  the
Clipboard dialogue window.

1. Select the preferred dimensions  for the diagram  display in  the Diagram width
and Diagram height fields.

2. Activate the Copy information text to clipboard checkbox if you  also  wish  the
diagram title to be copied with the graphic.

3. Click on OK to apply these settings.
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Modifying the diagram settings

In  the  Diagrams  dialog  you  can  specify  whether  new  diagram  windows  are
automatically displayed horizontally in the Viewer.

1. You can specify whether diagrams  belonging to  the same data set should be
identified using color in the Diagram grouping field.

2. If required, activate the Tile diagrams horizontally if new  diagram is displayed
checkbox. 

If this  option is  activated the Trendline Viewer arranges  the diagram  windows
horizontally (below one another) and the new diagram  is  opened at the lowest
position in the diagram window.

If this option is deactivated, new diagram windows are cascaded.

3. Click on OK to apply these settings.

FFT diagram

You  can  select  the  various  FFT  diagram  display  options  in  the  FFT  diagram
dialogue window. 

1. You can specify the background color for the FFT diagram in the Visual options
field. You can also define here whether you wish the grid  to  be displayed in  the
background and also its color.

2. In the Integration field you can specify the measuring point in the diagram  from
which the integration should be performed

3. In  the  Information  bar  field  you  can  specify  what  information  (cf.  Using  the
diagram information bar ) to display when a new diagram is opened.

4. In  the Toolbar  field  you  can  specify whether  Signal  selection,  Preview,  Axis
settings, FFT settings  and Zoom tools  should be displayed when you open a
new diagram.

5. Click on OK to apply these settings.

Time signal diagram

In  the  dialog  window  Time  signal  diagram,  you  can  define  certain  options  for
displaying a time signal diagram. 

1. The section Visual  options  allows  you  to  adjust  the  background  color  of  the
time signal diagram. You can also define here whether you wish the grid  to  be
displayed in the background and also its color.

2. In the Information bar  field  you can specify whether diagram information and
comments should be displayed when a new diagram is opened.

3. In  the Toolbar  field  you  can  specify whether  Signal  selection,  Preview,  Axis
settings, and Zoom tools should be displayed when you open a new diagram.
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4. Click on OK to apply these settings.

Trend diagram

In addition to the display settings already presented with the FFT diagram  and the
diagram  information bar option the settings  for the trend display and  smoothing
can also be specified in the Trend diagram  dialogue window.

1. The section Display options  allows  you to  adjust the  background  color  of  the
time signal diagram. You can also define here whether you wish the grid  to  be
displayed in the background and also its color.

2. In the Trend display settings  you can specify field  whether each characteristic
value should be displayed in a separate diagram (Stacked view) or whether all
characteristic values should be displayed in one diagram (Overlapped view).

3. You can specify which function and which period length should be used to carry
out the smoothing calculation in the Smoothing field.

4. In the Information bar  field  you can specify whether diagram information and
comments should be displayed when a new diagram is opened.

5. In  the Toolbar  field  you  can  specify whether  Signal  selection,  Axis  settings,
and Zoom tools should be displayed when you open a new diagram.

6. In the Trend limitation on load field you can specify how many trends of the last
days and maximum data sets should be load in the Viewer.

7. Click on OK to apply these settings.

Modifying the cursor options

You can modify how each individual  cursor is  displayed in  the dialogue windows
for the various cursors. 

1. Select the cursor you wish to modify from the list of cursors on the left.

2. Select  the  preferred  cursor  shape  for  the  cursor  specified  above  from  the
Symbol drop-down menu.

3. Select the symbol  and color  to  be used for the cursor as  well  as  the color for
vertical cursor line.

4. Because  the  differential  and  averaging  cursors  work  in  pairs,  you  can  also
modify the appearance of the second cursor in this field accordingly.

5. Click on OK to apply these settings.

Modifying the signal settings

You  can  select  measurement  data  display  options  in  the  signal  dialogue
windows.

1. If fewer than 50 measuring points  are displayed in  the diagram  window, each
measuring  point  can  be  made  clearly  visible  as  a  dot.  If  greater  than  50
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measuring  points  are  displayed  in  the  diagram  window,  the  display  of
individual measuring points  is  automatically deactivated and only the diagram
of the function and not the measuring points remains visible. 

2. Click on OK to apply these settings.

Active signal / 1st - 5th signal

Under the signal options you can modify the display of the individual signals.

1. Select a line type for the signal from the drop-down menu.

2. Specify a line width for the signal in pixels from the field provided.

3. Click on the palette to select a color for the signal.

4. Click on OK to apply these settings.

You can also apply these settings for additional signals.
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5.4 Keyboard shortcuts

Cursor selection

Key Function

F2 Activ ating the base cursor

F3 Activ ating the difference cursor

F4 Activ ating the RMS/AMV cursor

F5 Activ ating the harmonic cursor

F6 Activ ating the sideband cursor

F7 Activ ating the HS cursor (Harmonic w ith sideband)

F8 Activ ating the rev olutions cursor

Move cursor

Key Function

Cursor left Mov es the basic cursor left to the nex t measuring point

Cursor right Mov es the basic cursor right to the nex t measuring point

Cursor up Mov es the ex tended cursor left to the nex t measuring point

Cursor down Mov es the ex tended cursor right to the nex t measuring point

CTRL + cursor left Mov es the basic cursor to the first measuring point in the diagram

CTRL + cursor right Mov es the basic cursor to the last measuring point in the diagram

CTRL + cursor up Mov es the ex tended cursor to the first measuring point in the diagram

CTRL + cursor down Mov es the ex tended cursor to the last measuring point in the diagram

ALT + cursor left Mov es the basic cursor 10 measuring points to the left

ALT + cursor right Mov es the basic cursor 10 measuring points to the right

ALT + cursor up Mov es the ex tended cursor 10 measuring points to the left

ALT + cursor down Mov es the ex tended cursor 10 measuring points to the right

CTRL + K Mov es the cursor one microstep left (only  for harmonic cursor if

standard detection is enabled)

CTRL + L Mov es the cursor one microstep right

(only  for harmonic cursor if standard detection is enabled)
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Key Function

CTRL + D Hides or show s the cursor

CTRL + P Opens the dialog for numeric cursor positioning

CTRL + O Opens the cursor options dialog

Zoom selection

Key Function

F9 Activ ates free mouse zoom

F10 Activ ates horizontal mouse zoom

F11 Activ ates v ertical mouse zoom

F12 Activ ates key board zoom

Keyboard zoom

Key Function

CTRL + Q Mov es the start of the zoom area left

CTRL + W Mov es the start of the zoom area right

CTRL + A Mov es the end of the zoom area left

CTRL + S Mov es the end of the zoom area right

CTRL + Y Mov es the set zoom area left

CTRL + X Mov es the set zoom area right

CTRL + Enter Display s the set zoom area

CTRL + Backspace Display s the prev ious zoom area

CTRL + Space Display s the w hole diagram

CTRL + Z Opens the dialog for numeric zoom area input

Diagram scrolling

Key Function

CTRL + B Mov es the diagram display  left

CTRL + N Mov es the diagram display  right
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Key Function

CTRL + J Mov es the diagram display  up

CTRL + M Mov es the diagram display  dow n

Trend diagram

Key Function

CTRL + H Calls another record from the trend display

CTRL + G Toggle ax is v iew  betw een "cascaded" and "tiled".

Other keyboard shortcuts

Key Function

CTRL + R Reset comment position

CTRL + U Show /hide right info box  at top edge of diagram.

CTRL + T Show /hide toolbar

CTRL + I Show s/hides the diagram information bar on the right edge of the

diagram

CTRL + C Copies a screenshot of the diagram to the clipboard
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6 Detector III

Detector III is  a  hand-held measuring instrument with  data recording function for
offline  monitoring  of  systems  and  machinery  (condition  monitoring).  For  this
purpose, the instrument senses  vibrations  at  pre-determined  measuring  points
using a Detector and works  out the RMS values  of vibration velocity, acceleration
in  vibration  and  demodulation,  the  so-called  characteristic  values,  for
characterizing  machine  or  component  condition.  In  addition,  Detector can
measure temperatures using an infra-red sensor.

6.1 Operation

6.1.1 Keypad

Detector  III  is  exclusively operated  via  the  keys  on  the  membrane  keypad.  The
following table explains the meaning of the different keys:

Key Meaning

On/off key :

Sw itches dev ice on and off.

Time signal key :

To display  the time signal, FFT and Trend after measurements.

Lighting key :

Sw itches the display  lighting on and off.

Esc key  (Escape/Cancel key ):

Cancels an action, goes back one menu lev el.

Enter key :

Confirm selection. Both input key s perform the same function and are equally  v alid.

Cursor key s:

Mov es cursor in direction of arrow .

HOME key :

Go directly  to the main menu from any  menu.

Function key :

Call up special functions or to set a decimal point w hen entering numbers.

Navigating in the menus

Menu items can be marked using the cursor key  or . To select a  menu item

use the enter key . You can go back one level using the ESC key .
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Switch display lighting on and off

Press the lighting key .

Keyboard entries

In the Detector you can type in  both numbers  and texts. You can enter numerical
values  directly by pressing the corresponding number on the keypad.  In  the  text
edit  field  you  can  enter  letters  and  special  characters  by pressing  the  number
keys multiple times. For example:

If you want to type in the letter "k", press the button  twice.

To enter a space character press the button  once.

To set the upper or lower case for a  single  character, select the character with

the cursor keys  or  and press the cursor keys  or .

The following table provides the keys and their functions:

Key 1x 2x 3x 4x 5x 6x 7x 8x 9x 10x 11x 12x

. , - ? ! 1

a b c 2 ä á à â ã å æ ç

d e f 3 ë é è ê ð

g h i 4 ï í ì î

j k l 5 £

m n o 6 ö ó ò ô ø ñ

p q r s 7 ß $

t u v 8 ü ú ù û

w x y z 9 ÿ ý Þ

* 0

Opens the character map w ith other special characters.

  Alternates betw een upper and low er case

Confirms the entry .
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* Space character

To edit entries, select the appropriate position using the cursor keys   or  and
overwrite the following positions.

6.1.2 Switching on and off

Switching on

Keep the on/off button  pressed for one second to switch on the Detector. Right
after  switching  on,  the  system  checks  the  accumulator  charge  level.  If  it  is  not
sufficient  for  a  measuring  process,  i.e.  of  battery  charge  is  less  than  5%  of
maximum capacity, you are prompted to  recharge the accumulator. The Detector
shuts down after this error message.

If no new action is performed within a  certain  time after the Detector's  last action,
the device automatically shuts down. You must switch it back on to perform a new
action. The power down time can be configured in the system menu .

If  the  accumulator  is  completely  empty,  you  will  not  be  ab le  to
switch  on  the  Detector  at  all  (without  an  error  message).  This
prevents  the  accumulator  from  deep  discharging.  Recharge  the
accumulator to work with the Detector again.

Switching off

Press the on/off button  again to switch off the Detector.

6.1.3 Display and icons

All  information  necessary for  operating  the  device  is  shown  to  the  user  on  a
display. This includes 

selection of measuring points,

user guidance while measuring,

display of measured values,

status display of data transfer between computer and Detector

and system settings.
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The  accumulator  symbol  (top  left  in  the  display)  informs  you  about  the  current
accumulator  condition.

Display of longer lines

The  Detector  can  display names  that  are  up  to  49  characters  long.  However,
because  the  Detector  can  only display a  maximum  of  21  characters  in  a  line,
longer  lines  are  indicated  by  an  ellipsis  ("...").  This  indicates  that  there  are
additional characters to the left or right of the text currently being displayed.

To display parts  of the line  that  are  not  currently visible,  navigate  in  the  display

using the cursor keys  and  until you see the desired portion of text.

Icon explanation

Several  icons  are used in  the  Detector  to  guide  the  user.  In  the  following  table
these icons are explained:

Symbol Meaning

Esc key  

Enter key  

Cursor key  

Cursor key  

Cursor key s  

Cursor key s  

sub-tree has been measured partially , or

the balancing job has been started, but has not y et finished.

sub-tree has been measured completely , or

a balancing job has been finished.

Time signal key  

is display ed in front of a menu entry  if this entry  can be selected.

is display ed in front of a menu entry  if this entry  cannot be selected.
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6.2 Connectors
The Detector has a total of 6 connectors on the top or shaft end:

Connector Meaning

BNC connectors 1/2 Each connection accommodates one activ e sensor w ith ex citation current (4.7

mA).

Port 1 is alw ay s used for CM measurements. Port 2 can be used for tw o-plane

balancing measurements.

Because the Detector  is  a  single-channel  device it  cannot  perform

measurements at both ports simultaneously!

3.5 mm jack Connection for headset or analog recording dev ice. The headset connection can

only  be activ ated v ia the "Single measurements" menu.

9-pin sub-D socket Connection for a serial data line to facilitate ex change of data w ith the computer

(RS 232 interface).

AUX socket

(8p socket)

A temperature sensor or trigger sensor may  be connected to the AUX socket. It

is assigned as follow s:

1:  Output 12 V supply  for trigger sensors (12 V against DGND)

2:  Input GND Temperature sensor

3:  Input + Temperature sensor

4:  Output DGND

5:  Input + Trigger sensor signal

6:  Input GND Trigger sensor signal

7:  Output 5 V supply  for trigger sensors (5 V against DGND)

8:  - Not used

Charging port 

(4-pin socket next to

serial port)

For connection of battery  charger.
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Connect vibration sensor to BNC connector

On the top end of the Detector are two BNC  connectors  for  connecting  vibration
sensors.

Mounting a vibration sensor

Screw the magnet (1) on the sensor (2).

Connect the sensor (2) to the sensor cable (3).

Connect the sensor cable (3) with  the corresponding BNC connector (4) of the
Detector device, e.g. red cable to red BNC connector.

6.3 Accumulator
The power supply of the Detector is  provided  by a  removable  accumulator.  The
Detector constantly checks the accumulator charge level. If the accumulator is  not
sufficiently charged, the device issues a warning message and then shuts  down
automatically.

After  Charging  the  accumulator,  the  Detector  is  ready  for  use  again.  The
accumulator stays connected to the device during charging.

Checking accumulator charge level

Click Battery status  in  the System  menu to  check the accumulator charge level.
The  accumulator  charge  level  is  displayed  graphically  and  in  %  of  maximum
capacity.
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During normal  operation,  the  accumulator  symbol  (top  left  of  display)  indicates
the charge level.

Charging the accumulator

Only use the included charger for charging the battery!

Note that the Detector cannot be switched on during the charging
process.

In order to charge the accumulator

connect the included battery charger to a supply voltage outlet and 

connect the Detector to the battery charger via the charge connector.

The charging process starts  automatically as  soon as  the Detector is  connected
to the battery charger and depending on the current accumulator charge level.

The temperature of the accumulator must be between 2 °C and 44 °C. Outside of
this  range, the charging  process  is  delayed  until  the  accumulator  has  reached
the appropriate temperature.

The  LEDs  on  the  battery charger  indicate  the  charge  level.  Please  refer  to  the
battery charger manual for further information.

Recharge the accumulator regularly even when it is not  in  use  so
that the Detector is always ready for use.

Because  of  the  physical  characteristics  by  self  discharge,  a
accumulator can lose its stored energy within a time period of three
to four month.  If  you  don't  use  the  accumulator  for  a  longer  time
period, please do several charge/decharge procedures at times.

6.4 Data transfer
Data  are  exchanged  in  both  directions  between  Detector  and  the  computer  on
which the Trendline software is  installed. With  the help of the Trendline software
measuring  configurations  and  routes  are  created  and  administrated  on  the
computer, and measuring data are stored and evaluated.

On  the  one  hand,  measuring  configurations  and  routes  created  and
administrated on the computer are transferred to the Detector. On the other hand,
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recorded  measuring  data  are  downloaded  from  the  Detector  to  evaluate  and
store them using the Trendline software.

The  data  transfer  between  Detector  and  PC  is  controlled  by  the  Trendline
software.

Connect  the  serial  interface  of  Detector  (9-pin  sub-D-connector  at  the
instrument shaft) with a free serial interface of the computer Trendline software
is installed on.

Follow the sequence as described in the Trendline software help menu.

You can interrupt the data transfer between Detector and computer at any time

by pressing the Esc key .

The transfer of a  new route or configuration to  Detector deletes  all
data stored on the instrument.

6.5 Device menu
When  switching  on  the  Detector,  the  main  menu  shows  the  following  menu
items:  Condition  monitoring ,  Balancing ,  Run  up/coast  down ,
Amplitude/phase , Single measurements  and System menu .

The  menu  items  "Balancing"  and  "Amplitude/Phase"  are  only
availab le if the balancing function is enabled  on the Detector. 
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Condition monitoring

Measurements  are  performed  using  the  Condition  Monitoring  menu  and  its
submenus. Here you can decide whether you want to perform a pre-configured or
free measurement as well as  which measuring points  should be used to  record
data.  After  selecting  desired  the  measuring  point,  you  can  begin  the
measurement and then decide if you want to save or discard the data. During the
measurement  operation,  the  measured  results  and  system  messages  are
shown  on  the  display.  You  can  find  a  more  detailed  description  in  "Measuring
procedure ".

Balancing

You  can  use  this  option  to  select  the  measuring  point  for  the  balancing
measurement .

Run up/coast down

Use  this  menu  item  to  select  the  run  up/coast  down  for  determining  resonant
ranges .

Amplitude/phase

Use this menu item to select the amplitude/phase measurement .

Single measurements

Use this menu item to do single measurements .

System menu

From the system menu you can specify global settings for the Detector. 

Change language

Select display language. You can currently choose from  the following languages:
German, English, French, Italian, Dutch, Spanish, Portuguese, Swedish, Finnish,
Slovenian and Turkish.

Set backlight delay

In order to save battery running time the display lighting switches off automatically
once the time preset here has elapsed. The following settings are available: 30 s,
60 s, 90 s and no automatic deactivation.
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Contrast settings

Press "cursor right" to increase and "cursor left" to decrease display contrast.

Memory manager

Shows  the current amount of memory occupied by configuration and measuring
data. See "Dynamic memory management ".

Battery status

Displays the charge remaining in the battery .

Detector information

Displays the date and time as  well  as  the serial  number and software version of
the Detector. The date of the last successful  calibration check is  also  displayed
here.

Calibration

Displays  the  date  of  calibration  and  the  date  and  status  of  the  last  calibration
check. If the status  of the last calibration check is  OK, a  "Yes" is  displayed. "No"
displays  that  a  deviation  was  detected.  The  calibration  check  is  password
protected. If you want  to  perform  a  check,  please  contact  support@fis-services.
com.

Keep menu position

If you choose Yes  here, the Detector will  automatically display the  most  recently
accessed menu after switching off.

Sensor power supply

This menu item lets you activate or deactivate the constant supply of the sensor. If
the constant  supply is  always  activated,  the  sensor  is  not  initialized  before  the
measurement (except for with  Balancing measurements ),  which  saves  time
when  there  are  many  measuring  points.  However,  the  constant  supply  to  the
sensor will reduce the battery life of the Detector.

WARNING Damage to sensors when continuous operation is activated

If  you  would  like  to  connect  passive  sensors  to  the  Detector,  the
continuous  operation  of  the  sensor  must  be  deactivated  to  avoid
damaging the sensor.
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Activate constant supply of the sensor:

Select  Sensor  supply  >  Always  on  and  confirm  the  warning  for  passive
sensors.

The sensor is  initialized. If an error occurs  during the sensor initialization,  the
Detector will signal a sensor error and retain the If required setting.

Deactivate constant supply of the sensor:

Select Sensor supply >If required.

Power down time

Here you can configure when the device should switch off automatically after the
last action.

Select Power down time.

Press the Enter button  and

set the power down time in minutes.

"0" deactivates  this  function. In  order to  save battery running time, set the  power
down time as short as possible.

Bias voltages

For ICP sensors  you can  define  the  minimum  and  maximum  value  of  the  bias
voltage. Minimum  bias  voltage must be at least  3,  maximum  bias  voltage  must
not be greater than 17. The difference between the two values  must not be less
than 10. The default setting is min. 5 V and max. 17 V.

This  values  will  be used for the free measurements  "ISO 10816" and "Headset"
as thresholds for the sensor test.

RFID settings

This menu item is only visible if the Detector has an RFID reader.

Select whether the Detector should confirm successful import of an RFID tag. The
following settings are available: optical, acoustic, both.

6.6 Measuring procedure
During  a  measuring  round  the  sensor  signals  are  recorded  at  all  measuring
points  and  the  characteristic  values  calculated.  The  measuring  points  can  be
measured in random order.

Before you perform a round of measurements with your Detector, you should

You  should  mark  the  measuring  position,  where  the  sensor  should  be
mounted  for  the  measurement,  in  a  suitable  way.  (only  then  will  you  get
comparable results usable for trend analysis), and
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label  the  measuring  points  (only  then  can  a  measuring  point  be  clearly
identified)

If  you  are  using  the  RFID  add-on  for  the  Detector  (see  also  "Automatic
assignment  of  RFID  tags  to  measuring  points "),  make  sure  that  all
measuring points have been assigned RFID tags.

Please ensure before each round of measurements 

that the measured data stored from  the previous  round of measurements  are
transferred to the computer, as these will be overwritten by new data (only after
being warned accordingly),

that  the  proper  configuration  for  the  system  to  be  measured  has  been
transferred to Detector.

that the battery is charged.

Fix vibration sensor at measurement point

The measurement sensor  is  placed  with  a  magnet  at  the  measurement  point.
Therefore  the  measurement  point  should  have  a  good  metallic  contact  with
bearing  and  shaft.  If  this  is  not  possible  due  to  the  housing  material  (e.g.
aluminum),  attach  an  iron  plate  or  a  washer  the  size  of  the  magnetic  at  the
measuring point. This is easiest done with the help of a  fast-curing superglue (e.
g. cyan acrylate glue).

Place the sensor as  "soft" as  possible. Take the sensor tightly in  your hand and
set it with an edge on the measurement point. Then tilt the sensor over the edge
on the measuring point.

After the measurement, you can remove the sensor by tilting it over one side.

6.7 CM measurement

CM measurement procedure

1. First select the measuring point on the Detector at which you wish to  perform
the measurement. You can use the optional RFID reader for this  purpose (see
also ""Automatic assignment of RFID tags to measuring points" ").
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2. The  rotational  speed  is  determined  at  the  start  of  a  CM measurement  if  so
specified  in  the  Measuring  point  configuration .  If  the  rotational  speed  is
outside the defined band, the Detector displays  an  error  message.  Then  you
can  adopt  the  determined  rotation  speed.  If  no  signal  is  measured  for  the
rotational speed, you can enter the speed manually.

3. If active sensors  are used,  the  Detector  initializes  the  sensor  and  measures
the bias voltage. This must reach the defined range  within  10 s. Otherwise
the Detector cancels the measurement.

4. The Detector then uses the values last transferred by the Trendline software to
initialize the PGAs in the following order: main PGA -> demodulation PGA (also
see Analog branches  in  the Detector . If these values  are  not  suitable,  the
Detector defines new settings for the PGAs.

5. Measurement and determination of characteristic values: 

a) The Detector measures the specified channels. 

b) The time signals are used to calculate the FFT. 

c) The Detector uses the FFT to calculate the characteristic values.

6. If you selected the averaging function  for this  measuring point in  Trendline
the measurements are repeated according to the number selected: 

a) The average value of all  FFT  values  calculated  is  used  for  FTT  averaging.
This is then used as the basis for calculating the characteristic values. 

b) When averaging the characteristic values, the characteristic values  for each
measurement calculated first. The average value for all  characteristic values
calculated is then determined (steps 5a-5c are repeated). 

7. If you have set universal  characteristic values  in  the configuration, they will  be
queried sequential. The capture can be canceled by the Esc button.

8. Finally, the temperature is  measured providing this  has  been specified  in  the
configuration. The measurement can be canceled by the Esc button.

9. The measured values are displayed in an overview .

6.7.1 Selection of the measuring point

Using the menu Condition monitoring you decide first of all  if you want to  record
data  at  a  measuring  point  of  a  pre-configured  measuring  route  or  at  a  new
measuring  point  (see  "Free  measurement ").  In  the  lower  area  a  statistic
shows how many measurement points of the pre-configured measurement route
were already measured.
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Measuring at a pre-configured measuring point

Fix the sensor to the pre-determined point.

Start with the menu item Condition Monitoring > Select position.

If  you  have  marked  your  measuring  points  with  RFID  tags  (see  Automatic
assignment of RFID tags  to  measuring points ), the Detector  automatically
recognizes  the  measuring  point  as  soon  as  you  move  the  area  under  the
display near to the RFID tags.

If the Detector recognizes more than one RFID tag, it displays a list
of all  tags found for selection. If the configuration does not contain
one or more of the tags, the Detector displays an error message to
indicate this.

If no RFID tag is  available,  select  then  the  name  of  the  measuring  point  you
have fixed the sensor to using the subsequent menus.

Then mark Start measurement and

confirm your selection using the Enter key .

Starting the measurement after selecting a measuring point

A measuring point that has already been measured is indicated in  the menu with
the symbol .

When all measuring points in a sub-tree of a  configuration (e.g. a  machine) have
been  measured,  this  is  also  marked  like  this.  Is  the  subtree  only  partially
measured, then the Detector shows the symbol .

If a  line in  the menus  is  crossed  out,  a  data  error  has  occurred  at  this  point.  It
cannot be selected. For this, see "System  messages  and their meaning " as
well.

Are at the selected measuring point still  data from  the last measurement stored
in  Detector,  you  can  view  the  measuring  results  again  before  starting  the  new
measurement.
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In  addition,  you  can  mark  an  RFID  tag  as  defective  with  RFID  defective  if  the
Detector could not recognize it and you manually selected the measuring point.

6.7.2 Performing the measurement

The measuring procedure consists of several steps and runs off automatically as
described in CM-measurement .

Initialize the sensor and set the amplification factor

 

Record the time signals, calculate the FFTs and the characteristic values.

After the measurement is complete, the measured values are displayed .

6.7.3 Display of values measured

You can view measured time  signals  or  trends  directly once  the  measurement
has been carried out or by selecting previous measurements in the display. 

All  time  signals  used  to  calculate  the  characteristic  values  (depending  on  the
configuration) are available  directly after the measurement has  been carried out,
also  if  the  option  "Do  not  save  time  signals“  is  selected  in  the  configuration.
Depending  on  the  configuration,  it  is  possible  when  viewing  a  previous
measurement  to view certain time signals or trends.
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In  the  "Alarm"  line,  an  alarm  status  overview  of  all  characteristic  values  is
displayed. A scrollbar  is  displayed  on  the  right  of  the  display if  more  than  one
characteristic value exists. Characteristic values with exceeded main alarm  limits
are highlighted.

In the following table the used icons are explained:

Symbol Meaning

 
This characteristic v alue is OK.

No alarm occurred.

 
For this characteristic v alue the pre-alarm threshold has ex ceeded.

A pre-alarm occurred.

 
For this characteristic v alue the main alarm threshold has ex ceeded.

A main alarm occurred.

 
For this characteristic v alue the alarm status could not be assessed

(e.g. because of canceling the temperature measurement).

Press the time signal  button  to  switch to  the Time signals  or Trend display
. In the time signal display you can switch to the FFT display .

In the Detector, you now have the possibility to add a measurement comment:

Press the Function button .

In  the comment list, you can create a new comment or select an existing  one
(see  "Managing  comments  for  measurements ").  If  no  comments  exist  in
the list, the edit field  for  the  comment  input  is  shown.  To  change  comments
with the Detector key pad proceed as follows:

You can move the cursor into  the required position using the cursor keys   and

. You can set the the upper or lower case for each position by using the keys  

and  .  Additionally,  you  can  open  a  character  map  in  the  edit  field  with  the

function  button  .  You  can  enter  max.  49  characters,  which  are  shown  on  the
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Detector display in abbreviated form. Confirm your entry with the Enter button .

If  you  have  selected  a  comment,  it  will  be  shown  at  the  end  of  the
measurement view.

To save the measurement press the Enter button . If you want to  discard the

measurement press the Esc button .

If  you  have  set  "Comment  input  on  the  Detector"  in  the
Trendline  software,  the  comment  selection  will  appear
automatically.  If  you  selected  "Enforce  after  each  measurement"
you must select a comment to continue.

If you have already carried out a  measurement at this  point the Detector  asks
whether the last measurement should be overwritten (also following a multiple
measurement !)  or  whether  the  latest  measurement  should  be  saved  or
discard.

The measurement is saved. 

Once the characteristic values have been saved the Detector jumps  to  the Select
measuring  point  menu  item  to  enable  you  to  record  data  at  an  additional
measuring point on the same machine (see "Selection of measuring point ").

If no further measurements need to  be made to  the machine, you can switch the
device off and move on to the next machine.

Display previous measurements

If measurements of a  measurement point have been carried out earlier, you can
display the time signals and trends in the Detector.

Select Condition monitoring > Select position.

Select plant, machine and measurement position and 

select Previous data.

Select the desired measurement from the list and

press the Enter button .

The measurement view will  be displayed. The heading shows  date  and  time  of
the selected measurement.
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6.7.3.1 Display of time signals / trends

You can go to  the time signal/trend selection by pressing the time signal  button

  in the measured value view.

The  time  signal  and  trend  selection  is  availab le  when  time
signals or trends for at least one characteristic value exist.

Time signals and Trends are only  displayed  on  the  Detector  to
give a first  quality  assessment  of  measured  data.  The  detailed
analysis is performed with the Trendline software.

Display time signals

Select Time signals and

press the Enter button .

When viewing the time signal, press the cursor key  or  to switch between the
several time signals. A horizontal line in the diagram indicates the zero line. At the
top right side a character is  displayed (a for acceleration, v for velocity and  d  for
demodulation)  to  indicate  the  type  of  time  signal.  At  the  top  left  the  maximum
value of the highest peak of all measured values is displayed.

Pressing the time signal button   opens the FFT display .

Display trends

Select Trends and

press the Enter button .

On the Detector, a  Trend of 2  to  a  maximum  of  20  characteristic  values  can  be
shown. Once a characteristic  value  is  measured  at  least  twice,  a  trend  can  be
displayed.  If  you  want  to  show  a  trend  from  previous  measurements ,  the
selected  measurement  is  adopted  as  the  last  current  value.  Recent
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measurements are not included.

In addition, you can send the latest trend data from  the Trendline software to  the
Detector (see Communication settings ). The number is limited to a  maximum
of 10 values. These values are considered in the trend display ever! If you use for
example 10 values  from  the Trendline, there are remaining at most 9  values  for
previous measurements and 1 for the current measurement.

In  the  trend  view  you  can  use  the  cursor  key   or   to  switch  between  the
several  trends. A horizontal  line in  the diagram  indicates  the main alarm  limit.  A
horizontal  broken line indicates  the pre-alarm  limit. In  the  middle  of  the  window
number  and  type  of  the  characteristic  value  are  displayed.  Individual
measurement points ( ) are joined by lines.

Pressing the time signal  button   opens  a table  with  measured values  that
are used for the trend view. Table values  are sorted in  descending order by date,
time and measured value.

Press the Enter button  or the Esc button , to change to the trend view. 

If  you  canceled  measuring  of  temperature  or  the  "universal"
characteristic value, only the existing values are shown in the trend.
The  missing  value  is  shown  by  three  dashes  in  the  tab le  of
measured values.

  

6.7.3.2 FFT display

You can go to the FFT display by pressing the time signal button   in the time
signal view.
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The following data is displayed:

Symbol
position

Description

Top left The v alue of the highest peak is display ed in the current w indow .

Top center This show s the zoom factor, w hich can be changed by  pressing the Enter button 

(zoom in) and Esc button  (zoom out). The zoom factor can be set to 0.1x  – 0.4x  –

1x  – 2x  – 4x  – 8x . With a zoom factor of 8x  it is possible to read the frequency  v alue

for each peak. When pressing the Esc button  in the FFT ov erv iew  w indow  (zoom

factor 0.1x ), the Detector leav es the FFT display  and returns to the time signal display .

Top right

From the

middle

When the  sy mbol is display ed, the auto-scaling mode is enabled. If so, the peaks

in a w indow  are scaled in a w ay  to fit the largest peak in the display . If the sy mbol is

not show n, the scaling remains the same for all screens and zoom factors. Press the

function button  to enable/disable auto-scaling. When sw itching off auto-scaling, the

zoom factor is set back to 0.1x . 

Top right This character show s w hich FFT is display ed:

 a: acceleration

 v : v elocity  

 d: demodulation 

Below the FFT Here y ou can see the frequency  range of the w indow , w hich is currently  being

display ed. Press the cursor key   and  to scroll left or right resp. This does not

w ork w hen the zoom factor is 0.1x , because the w hole frequency  range is already

show n.

FFTs  are  only  displayed  on  the  Detector  to  give  a  first  quality
assessment of measured data. The detailed analysis is performed
with the Trendline software.

6.7.4 Multiple measurements

You can measure the same measuring point multiple  times  using the  Detector.
For this  select a  measurement which you have already measured and measure

again like described before. After the measurement, press  the Enter button  to
save the data. Then the following menu appears:



232

You can now choose from three options in this menu:

Overwrite old

data

The last sav ed measurement of this measuring point w ill be ov erw ritten. The time

signals that belong to the last measurement w ill also be ov erw ritten.

Save as extra

data

If y ou select this item and confirm w ith the Enter button , this measurement is

sav ed as an additional measurement. In the Trendline softw are it appears as an

additional measurement of the same measuring point. The time signals are also

sav ed, w hen this is required. 

Discard

measurement 

The measurement is not sav ed. This corresponds to pressing the Esc button 

immediately  after the measurement.

Bear  in  mind  that  multiple  measurements  can  be  saved  only  if
sufficient memory is availab le. If insufficient  space  is  availab le  in
the  memory  for  additional  time  signals  these  will  not  be  saved,
even  if  the  option  "Always  save  time  signals"  is  activated  in  the
configuration.  If  the  memory  no  longer  has  the  capacity  to  store
characteristic  values  it  will  not  be  possib le  to  save  the  values
obtained during multiple measurement.

6.7.5 Measuring with universal characteristic value

To  enter  a  characteristic  value  at  a  selected  measuring  point  that  is  not
measured by the vibration or temperature sensor, you can set up  a universal
characteristic  value  in  the  Trendline  software.  After  the  Detector  recorded  all
vibration  values,  you  will  be  requested  to  enter  a  value  for  the  universal
characteristic value.

Accept this  value by pressing the Enter button . If you have configured several
universal  characteristic  values  for  a  measurement,  they  will  be  requested
sequentially.
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Universal  characteristic  values  are  displayed  in  the  Detector
without  unit.  To  assign  later  what  has  been  measured  with  this
parameter, you should  entitle  the  characteristic  value  accordingly
(e.g. "Machine  temp.  [C]").  In  the  Trendline  software  you  can  edit
the  name  in  the  "General  settings"  tab.  On  the  Detector  you  can
only change the name in the settings of free measurements.

6.7.6 Measuring with temperature sensor

If  you  want  to  measure  the  temperature  of  a  selected  measurement  point  in
addition to  other characteristic values, the characteristic value Temperature  has
to be set up for this measuring point using the Trendline software.

First,  the  Detector  will  record  all  vibration  values.  Prior  to  measuring  the
temperature  you  will  be  prompted  to  connect,  or  switch  on  respectively,  the
temperature  sensor.  The  Detector  takes  about  5  seconds  between  connecting
and switching on for initializing the temperature sensor. The current temperature
value  is  displayed  during  the  measurement.  You  can  accept  this  value  by

pressing the Enter button .

  

The temperature sensor Raynger IP-M switches  itself off  automatically after  a
couple of minutes, even if the switch remains ON. If the display prompts  you to
turn on the temperature sensor, even though the switch is ON, turn it off and on
again.  If  that  does  not  help  either,  the  battery  of  the  temperature  sensor  is
probably dead. Please replace it.

You can see from the display that the Tecpel temperature sensor has  switched
itself off. You can switch this sensor back on immediately if required.

Further  information  about  the  temperature  sensor  in  the  manual
"Principles of non-contact temperature measurements". 

6.7.7 Using the headset

When using the headset, first the sensor is  initialized and  the  amplifier  set,  the
same as  with  any measuring procedure.  You  will  then  be  prompted  to  connect
the headset. The amplification factor of the signal  is  set automatically, shown in
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the display and can be adjusted manually by the cursor keys  or . If this  value
is shown with an exclamation mark and inverted, the amplifier is over range.

6.8 Balancing measurement
The  purpose  of  balancing  is  to  compensate  for  imbalances  in  rotating  parts
through  the  precision  attachment  of  balance  weights  in  order  to  extend  their
service life. You can use the Detector III to  quickly and reliably determine the best
location of up to two counterweights.

WARNING Damage due to balancing in the resonance range

If you are balancing a machine in  the resonance range,  even  the
smallest changes of weight may lead to  severe  fluctuations  of  the
vibration  amplitude.  This  may  cause  serious  damage  to  the
machine and operator injuries.

Therefore,  do  not  perform  balancing  in  the  machine  resonance
range.

If you do not know the resonance ranges,

ask  the manufacturer or consult the enclosed documents about
the resonance range of the device being monitored

or determine the resonance range by  means  of  a  run  up/coast
down (see "Determining the resonance range of a machine ").

If you use the weights suggested  by  the  Detector,  it  is  imperative
that you  check  the  plausib ility  of  these  weights.  In  the  balancing
settings,  ensure  that  you  have  entered  the  correct  values  for  the
rotor  mass  and  radius  because  these  are  factored  into  the
calculation.

Procedure for a balancing measurement

1. Measurement  of  rotational  speed :  The  Detector  initially  measures  the
rotational  speed of  the  component:  the  trigger  sensor  counts  the  revolutions
using a reflex mark which is attached to the component as a reference.

2. Reference  run :  During  the  referencing  measurement  the  amplitude  and
phase  of  the  existing  imbalance  is  measured  at  the  sensor  positions.  This
serves as the basis for the calculation of positions of weights.
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3. Trial run : plane 1 (additional test measurement at plane 2 where two-plane
balancing  is  carried  out):  During  the  test  measurement  the  response  of  the
rotor to  defined weights  is  analyzed. The imbalance in  the machine is  altered
by attaching the  test  weights.  The  Detector  now  determines  the  change  with
reference to  the last measurement (for the  first  trial  run,  this  is  the  reference
measurement) and calculates the coefficients  used to  determine the optimum
position of the balance weights.

4. Display of  coefficients  and  attachment  of  balance  weights :  The  Detector
displays  the calculated  influence  coefficients.  To  perform  the  trim  run,  attach
the weights at the positions calculated by the Detector.

5. Trim run : The Detector now performs  a measurement to  check whether or
not  the  vibration  caused  by  the  imbalance  exceeds  the  limit  defined  by
Trendline . If the balancing procedure was successful, the Detector displays
a table  of results  and exits  the balancing menu. If not, you can attach weights
using  the  existing  coefficients,  then  repeat  the  check  or  determine  new
coefficients by performing a new test measurement. 

The  Detector  guides  you  through  the  individual  steps  of  the  balancing
measurement and marks  the  menu  items  that  are  currently selectable.  If  the  
symbol  is  displayed in  front of the menu  item  it  can  be  selected,  otherwise  the
Detector shows a .

Important information

If a balancing measurement has been already carried out for a  component the
Trendline software sends  the coefficients  of  the  last  trim  run  to  the  Detector.
Once  the  reference  measurement  has  been  carried  out  you  can  decide
whether  you  wish  to  proceed  with  the  trial  run  in  order  to  determine  new
coefficients. Alternatively, you can view the "old" coefficients  directly and attach
the weights  accordingly. However, this  is  only possible  if the current rotational
speed  corresponds  to  the  speed  measured  during  the  previous  balancing
measurement.

If the test weights selected during the trial run are too small, the coefficients are
calculated inaccurately. The suggested balancing weight is  probably too large
in this case, which can result in  damage to  the machine during the trim  run. If,
however, the test weights selected are too large, damage can occur as early on
as  during  the  trial  run.  During  the  trial  run,  the  Detector  therefore  checks
whether  the  test  weights  being  used  effect  a  large  enough  change  in  the
vibration.  If  the  change  in  vibration  from  all  of  the  sensors  is  too  low,  the
Detector will return a warning message. You can then decide whether to  repeat
the trial  run with  larger weights  or accept these without  making  any changes.
Always check whether the test weights selected for your machine are plausible.

The Detector also calculates a suggested value for the test weights  if the rotor
mass  and radius  to  which the weights  can be attached  were  specified  in  the
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Balancing settings . In addition to the geometrical values, the Detector uses
the  imbalance  measured  in  the  previous  run  in  order  to  calculate  the
suggested value. This  is  a  reference or trim  run for Plane 1 and for Plane 2 if
the  test  weight  has  been  removed.  The  following  applies  for  Plane  2:  If  the
weight has not been removed from trial run 1, the Detector takes the imbalance
from Trial run 1 in order to calculate the suggested weight value.

The  Detector  compares  the  calculated  balance  weights  using  a  prescribed
safety limit  that  applies  to  the  test  weights.  If  the  values  calculated  for  the
weights exceed the safety limit, a warning message is displayed.

If the balancing measurement is  performed using  at  least  two  sensors,  after
each  trial  run  for  Plane  1  the  Detector  evaluates  whether  the  number  of
balancing  planes  should  be  modified.  In  the  Balancing  settings  a  value
greater  than  0  must  be  entered  for  the  balancing  threshold  (input  field
Balancing  OK at).  If  you  adjust  the  plane  number  based  on  the  Detector's
recommendation, the settings of the balancing measurement are copied along
with the reference run and trial  run into  a free measurement. This  then allows
you  to  continue  the  balancing  measurement.  For  the  transmission  to  the
Trendline you must sort this  measurement using the  Wizard  because  the
measurement can no longer be assigned to the machine automatically.

If  the  coefficients  determined  after  a  trial  run  are  used  multiple  times  with
different  balance  weights  for  the  trim  runs,  under  some  circumstances  they
may no  longer  be  meaningful.  The  Detector  therefore  checks  the  measured
result after each trim  run using the calculated expected values  and displays  a
warning message if these values deviate from one another by more than 20 %.
If this is the case, you should first perform a new trial run.

As  a general  rule  the amplitude units  you  specified  in  the  Trendline  program
settings  will  be displayed during balancing. If a  value in  the current unit  is
too large for the Detector display, the Detector will  round this  up automatically
to the next higher unit of measurement, for example, from 1050 m to 1.05 mm.

During balancing the internal amplifier is adapted to the input signal  before the
start  of  each  measuring  procedure  to  optimize  performance.  However,  if  the
signal  overmodulates  during  the  measurement,  the  Detector  displays  a
message  accordingly  and  reduces  the  amplification  factor.  This  message
remains  displayed  if  the  input  continues  to  overmodulate  once  the
amplification has been reduced. You will not be able to  save the measurement

and must cancel it using the Esc button .

Starting the balancing measurement

Select the Balance menu item in the Detector.

Select the measuring point with  the RFID Reader or manually (see "Selection
of measuring point ").
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The  Balancing  menu  is  shown.  Depending  on  the  status  of  the  balancing
process, you can only select certain  menu items. The Detector therefore  guides
you through the entire balancing process. You can only select lines preceded by a
  symbol  in  this  menu.  Lines  with  a   can  only  be  selected  later  during  the
balancing process.

Settings

You  can  use  this  menu  item  to  display  the  settings  you  specified  for  the
measuring point in the Trendline balancing configuration .

You can also restart the balancing measurement (menu item Restart balancing).
This resets all balancing measurement data.

Vector calculator

You can carry out calculations with vectors quickly and easily in the Detector using
the vector calculator to  distribute a weight across  different positions  or  combine
several distributed weights, for example.
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Split position

Divides the vector of a weight between two positions. In
relation  to  a  full  circle,  enter  the  number  of  possible
positions (at least 4), the angle of the first position and
the weight to  split. The Detector shows  where the  two
resulting weights must be attached.

Example:  Weights  can  be  attached  with  a  spacing  of  30°  between
weights, meaning that 12 positions are available. A weight of 10g and an
angle of 40° was  determined for the weight to  be attached. The Detector
determines the following: A weight of 6.8 g must be attached at position 2
(at 30°) and a second weight of 3.5 g attached at position 3 (at 60°).

Split angle
Divides one weight into two with  predefined angles. To
do  this  enter  both  new  angles  as  well  as  the  weight
and  angle  of  the  original  vector.  The  Detector
calculates  both  resulting  weights.  If  the  angle  of  the
original  vector is  not between the two new angles, the
Detector automatically jumps  to  the smaller of the two
angles so that you can correct your input.

Example: You have a fan with  18 blades, the first blade at 0°, the second
at 20°, etc. You want to attach a weight of 5 g at 30°, but you don't have any
room left at the 20° blade. Enter 0° at "Angle 1", 40° at "Angle 2" and 5 g at
30° at "Input" in  the Split  angle  function. The resulting weights  at  0°  and
40° are 1.4 g and 3.9 g, respectively.

Split weights
Split  one  weight  into  two  weights  with  predefined
weights. To do  this  enter  both  predefined  weights  as
well as the weight and angle of the original  vector. The
Detector  displays  where  the  two  predefined  weights
must be attached.

Example:  The  Detector  suggests  a  balancing  weight  that  you  cannot
select (e.g. 7  g  at 45°). You can, however, replace the suggested  weight
with  two  available  weights  (e.g.  5  and  10  g)  if  the  vectorial  addition
corresponds exactly to the suggested weight. In the function Split weights
, enter 5 g for "Weight 1", 10 g for "Weight 2" and 7 g at 45° for "Input". You
will obtain the weights 5 g in 156° and 10 g in 17° as a result.
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Sum

You can use this function to determine the sum of up to
three weights.

Example: You are balancing a shaft that allows  you to  screw on balance
weights  at  36  positions.  You  have  already  attached  several  weights
during the balancing process. The  Detector  suggests  that  an  additional
balance weight should be attached at a  position that is  already occupied.
You can now combine three existing weights  to  produce one new weight.
For example: you have 7.5 g at 10°, 5  g  at 20° and 7.5 g at 30°. The sum
function  then  produces  a  total  weight  of  19.8  g  at  20°.  You  can  then
remove the three  weights  at  10°,  20°  and  30°  and  replace  them  with  a
new weight of 19.8 g at 20°.

Assign RFID

Select this menu item to assign an RFID tag placed at the measuring point (see "
Automatic assignment of RFID tags to measuring points ").

In the next step you measure the rotational speed .

6.8.1 Measuring rotational speed

The  Detector  measures  the  rotational  speed  at  the  start  of  the  balancing
measurement via the trigger sensor. To do this, select Measure   rot. speed from
the balancing menu.

The Detector returns an error message if the acquired speed

is  outside the range defined in  the Trendline software (see "Rotational  speed
settings ")  (speed  out  of  range,  see  also  "System  messages  and  their
meaning "),

or is within a specified resonance frequency range (see "Resonance frequency
ranges ").

You can then cancel  the measurement or apply the  current  rotational  speed  as
new speed.
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Press the Enter button  to apply the rotational speed displayed.

If  you  repeat  balancing  using  a  balancing  configuration  and  the
rotational  speed  is  outside  of  the  selected  range,  the  calculated
coefficients are no longer meaningful. In this case, the Detector will
display a warning and you can use the differing speed or abort the
measurement. 

To use the differing rotational speed, confirm this by pressing the

Enter button . The coefficients can now no longer be used; you
must first perform a Trial run  for all planes.

To abort the measurement of the rotational speed, press the Esc

button . The Detector jumps to  the Balancing menu. Now you
can,  for  example,  bring  the  machine  to  the  correct  rotational
speed before repeating balancing procedure.

The rotational speed measurement is followed by the reference run .

6.8.2 Reference run

To perform the reference measurement, select Reference run from the balancing
menu.

The  rotational  speed  is  monitored  during  the  reference
measurement. If  this  falls  outside  the  defined  band,  the  Detector
displays an error message.

Attach the sensors to the component and connect these to the BNC connectors
of the Detector as specified in the balancing configuration .

The  Detector  guides  you  through  the  measurement  and  determines  the
amplitude and phase of the vibration  at  the  sensor  positions.  A bar  showing
mean variance displays  the stability of the values. You can reset the mean  by

pressing the function button  to restart mean calculation.
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Press  the Enter button   once  amplitude  and  phase  have  stabilized  after  a
time.

Once you have measured all  sensor positions, the results  are  displayed  in  a
table. If the measured values are OK, select the Values are OK menu item  and

press the Enter button  to save the measured values. If you are not satisfied

with a measured value, you can use cursor keys   and  to  select this  value

and the Enter button  to repeat this individual measurement.

At this  point, you can select a  comment. In  the comment list, you can create a
new  comment  or  select  an  existing  one  (see  "Managing  comments  for
measurements ").  If  no  comments  exist  in  the  list,  the  edit  field  for  the

comment input is shown. Confirm your settings with the Enter button .

The measured values obtained during the  reference  run  are  only
saved after you confirm by clicking Values are OK  by pressing the

Enter button . In  the tab le  of  results,  click  the  Esc  button   to
discard  the  measured  values  and  the  Detector  returns  the
Balancing menu. Repeat the reference run if necessary.

Now you can proceed with the trial run .

6.8.3 Trial run

To perform the trial run select Trial run from  the balancing menu. With  two-plane
balancing the Detector initially guides you through the test measurement at plane
1 then continues with plane 2. In  the trial  runs, apply a  known weight to  a  known
position.  With  this  information,  the  Detector  determines  the  change  between
reference  run  and  trial  run  and  can  thus  determine  the  influence  coefficients.
These indicate how machine imbalance changes  with  a  certain  weight  and  are
used calculate the balancing weights.

If the change in  vibration is  too little  because the test weights  selected were too
small  (see  also  "Important  information"  in  "Balancing  measurement" ,  the
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Detector will return an error message. You can then decide whether to  repeat the
trial run with larger weights or accept these without making any changes.

Attach the sensors to the component and connect these to the BNC connectors
of the Detector as specified in the balancing configuration .

Based on the geometrical  values  specified  in  the  balancing  configuration  as
well as the imbalance measured in the reference run, the Detector calculates  a
suggested  value  for  the  test  weight.  If  one  of  the  geometrical  values  or  the
measured imbalance is zero, no suggested value is calculated (display "--").

 

Enter  the  data,  attach  the  weights  and  confirm  this  on  the  Detector.  The
position of a test weight is counted from  the rising or falling edge of the trigger
mark (depending on which one you selected in  the configuration ). You can
check it up in the Balancing menu Settings  -> Trigger sensor  -> Trigger pos..
The  angle  of  the  weight  is  always  counted  AGAINST  the  direction  of  shaft
rotation. You can specify it in degrees or, if you have set discrete positions, as a
position number. Here, P1 is  the first position from  the trigger  mark  AGAINST
the direction of rotation, P2 the second, etc. When using discrete positions, you
can apply one or two test weights.

The Detector guides you through the measurement, determines  the amplitude
and phase of the vibration at the sensor positions and displays the values.

If the change in vibration is less  than 20% with  respect to  the reference run for
all sensors, the Detector will warn you that the test weights may be too small.
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For two-plane balancing, the Detector also checks whether the test weights  are
possible too small. In doing so, the change in vibration in Plane 2 is  calculated
with respect to the reference run if you have removed the test weight for Plane
1.  If  you  have  kept  the  test  weight  for  Plane  1,  the  change  in  vibration  is
calculated with respect to the first test run.

If the minimum required change in vibration is exceeded only at one sensor for
2-plane balancing in  the trial  run for Plane 1 and subsequently for  Plane  2,  a
defect is likely the cause. The Detector will return a warning if this is the case.

If  the  Detector  found  that  the  number  of  balancing  planes  was  probably
insufficient (1-plane balancing)  or  unnecessarily large  (2-plane  balancing),  a
warning message is  displayed. You can then modify the number of balancing
planes.  Please  note  that  the  measurement  is  resumed  as  a  free
measurement,  and  you  must  then  sort  this  with  the  wizard  when
transferring to the Trendline software. 

At this  point, you can select a  comment. In  the comment list, you can create a
new  comment  or  select  an  existing  one  (see  "Managing  comments  for
measurements ").  If  no  comments  exist  in  the  list,  the  edit  field  for  the

comment input is shown. Confirm your settings with the Enter button .

However, you can still  apply the  measured  values  or  repeat  the  trial  run  with
other weights. If you repeat the trial run, the weight used in the previous trial  will
be used as  the start value when entering the  weight.  Please  ensure  that  you
also take this  weight  into  consideration  when  repeating  the  trial  run  and  not
only the weights that have been added!

Then the Detector asks whether you want to remove the test weight. If you have
screwed the test weight on, it is  an advantage to  unscrew it so as  to  keep the
number of weights  on the shaft as  small  as  possible. If you welded it on, it is
easier to leave the test weight on the shaft. 

In two-plane balancing, you can specify what weights  you want to  remove after
the second trial run. You can 

keep both weights,

remove the weight last used, or

remove both test weights,

if  you  have  not  removed  the  test  weight  in  plane  1.  Otherwise,  you  can  only
choose whether to remove the weight in plane 2 or not.
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The measured values obtained during the trial  run  as  well  as  the
attached  test  weight  are  only  saved  once  you  have  provided  the

Values  are  OK  confirmation  with  the  Enter  button  .  Once  this
confirmation  has  been  given  this  step  of  the  balancing
measurement can be read out in Trendline.

After the last trial run, the program displays suggestions for weights to apply.

Next step: display coefficients and attach balance weights .

6.8.4 Display coefficients and apply balance weights

Display coefficients

The Detector displays  the influence coefficients  from  the  test  measurements  in
this overview. These are used to calculate the balance weights. They describe the
change in vibration in  relation to  a  weight and have vibration unit / weight unit as
their unit of measurement, for example µm/g. For 1-plane balancing, there is  only
one coefficient, while two coefficients  are determined per sensor position for two
planes.

Applying balance weights

WARNING Damage caused by balancing with weights that are too heavy

If you are operating a  machine  with  balance  weights  that  are  too
heavy, the resulting imbalance can cause severe damages to  the
machine  and  injuries  to  the  operating  personnel.  It  is  therefore
imperative that  you  observe  any  warnings  from  the  Detector  and
operate the machine only within the operating margins specified by
the manufacturer.

In  the  Apply  weight  menu  the  Detector  shows  which  balancing  weights  are
calculated  for  the  respective  plane.  If  the  suggested  values  exceed  the  safety
limits, the Detector will return a warning:

If the previous balancing procedure was a trial run and the test weight was  not
removed, the safety limit will be twice the weight of the test weights.

In all other cases, the safety limit is three times the weight of the test weights.
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You can now restrict the calculated suggested weight to the particular safety limit.
The following input of the weights actually applied remains unaffected by this.

Now  the  weights  have  to  be  attached.  If  you  attach  weights  different  from  the
suggested values  (e.g.  because  you  do  not  have  the  needed  weights),  please
enter the value of the weights  actually attached along with  their position. On a 2-
plane balancing job, this step is done separately for every plane. If you are using
discrete positions, the program always displays two weights. Together they equal
the required balancing weight.

You can abort input of weights at any time by pressing  the Esc button  in  order
to  use to  the vector calculator, for example. When you  click  Apply weight  again,
the previous inputs are still there, so you can continue at the same point.

Here again, weight positions are counted AGAINST the direction of
rotation starting from the set edge of the trigger mark.

The coefficients calculated and balance weights entered are saved
together as part of the subsequent Trim  run . This data can only
be read out using Trendline once the trim run has been carried out
and the Values are  OK  confirmation  has  been  provided  with  the

Enter button .

6.8.5 Trim run

To perform the trim run select Trim run.

Attach the sensors to the component and connect these to the BNC connectors
of the Detector as specified in the balancing configuration .

The  Detector  guides  you  through  the  measurement  and  determines  the
amplitude and phase  of  the  vibration  at  the  sensor  positions  as  well  as  the
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rotational speed. Next, it displays the resulting measurements.

Here you can enter a  comment, either accept these measurements  or discard
them and repeat the measurement.

For  balancing  you  will  usually  need  more  than  one  run.  If  the  result  is  not
sufficient after the trim  run, the Detector returns  to  the Balancing menu. You can
now reduce imbalance in two ways:

Use the existing influence coefficients  and apply balancing weights  calculated
with these coefficients again.

If  you  repeat  the  steps  of  applying  weights  and  trim  run  with
existing influence coefficients and you notice that the imbalance
does not improve, this is a sign that the influence coefficients are
no longer good and that you need  to  re-determine  them  with  a
new trial run.

If the  amplitudes  measured  at  all  sensor  positions  in  the  trial  run  are  smaller
than  the  balancing  threshold  defined  in  Trendline  (balancing  OK  at),  the
balancing  process  is  finished.  The  Detector  displays  the  table  of  results
displaying  the  last  measured  values  and  the  balancing  threshold.  Then,  the
Detector returns to the menu, where you can select a new measuring point.

The measured values obtained during the trim  run, the coefficients
calculated and attached weights  are  only  saved  once  the  Values

are OK confirmation has been provided using the Enter button .
Once this confirmation has been  given  this  step  of  the  balancing
measurement can be read out in Trendline.
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6.9 Run up/coast down (Determining the resonance range)

Background

Balancing a machine with  the aid  of the Detector  must  not  be  performed  in  the
resonance range as  the  vibration  amplitude  increases  severely and  the  phase
changes  considerably  when  the  machine  is  operated  at  or  near  resonant
frequencies.  Even  the  smallest  weight  changes  may lead  to  severe  amplitude
changes  so that, if the worst comes  to  the worst, a  balancing attempt may even
destroy the machine.

In  order  to  avoid  such  damage,  you  can  determine  the  resonant  ranges  of  a
machine using the Detector and the Trendline software. To do so, the machine is
started up and shut down in  a  controlled manner (run up/coast down test) while
the Detector continuously measures the amplitude and phase of the vibration and
rotational  speed  at  the  measuring  point.  The  data  measured  in  this  test  are
displayed in an amplitude/phase diagram.

For the measurement, you can specify a  rotational  speed range to  automatically
start and stop the measurement. Alternatively, you can start and stop measuring
manually.

WARNING Damage  due  to  operation  outside  manufacturer's
specifications

The  machine  must  be  operated  within  rotational  speed  limits
permitted  by  the  manufacturer  for  normal  operation  while
determining  resonant  ranges.  Therefore,  always  observe  these
rotational  speed  limits  when  performing  the  run  up/coast  down
test. Determination of resonant range is always performed at the
system operator's own risk!

Conditions

Run up/coast down must be set up in the configuration .

Other notes

The Detector performs the measurement with  only one vibration sensor. If you
want to determine the resonant ranges  at multiple  sensor positions, you must
repeat the entire run up/coast down procedure there.

Determining resonant range of a machine

Proceed as follows to carry out the measurement with  a  defined rotational  speed
range:

Select the Run up/coast down menu item in the Detector.
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Select the measuring point with  the RFID Reader or manually (see "Selection
of measuring point ").
The Run up/coast down menu is shown.

Press Start measurement.

Perform the run up/coast down test on the machine.

a) If  you  pre-set  the  rotational  speed  range,  the  Detector  automatically
measures in the defined rotational speed range.

b) Otherwise, press Start once the desired start speed has  been reached and
Stop once the desired end speed has been reached.

You  can  now  select  a  comment.  In  the  comment  list,  you  can  create  a  new
comment  or  select  an  existing  one  (see  "Managing  comments  for
measurements ").  If  no  comments  exist  in  the  list,  the  edit  field  for  the

comment input is shown. Confirm your settings with the Enter button .

Select  Finalize  measurement.  The  Detector  saves  the  measured  values.
Transfer the data from the Detector to the Trendline software.

Proceed as follows to perform the measurement manually:

Select the Run up/coast down menu item in the Detector.

Select the measuring point (see "Selection of measuring point ").

Perform the run up/coast down test on the machine.

Once the desired starting speed has been reached, press Start measurement
. The Detector starts measuring.

Once the desired ending speed has been reached, press Stop.

You  can  now  select  a  comment.  In  the  comment  list,  you  can  create  a  new
comment  or  select  an  existing  one  (see  "Managing  comments  for
measurements ").  If  no  comments  exist  in  the  list,  the  edit  field  for  the

comment input is shown. Confirm your settings with the Enter button .

Select  Finalize  measurement.  The  Detector  saves  the  measured  values.
Transfer the data from the Detector to the Trendline software.

For measurements below 300 RPM no results  are  displayed  or
stored on the Detector.

You  can  display  the  run  up/coast  down  settings  made  in  the
Trendline  software  in  the  Detector  by  pressing  Settings  after
selecting the measuring point.

Further information in the chapters Transferring the data to the Trendline software
 and Creating an amplitude/phase diagram in the Trendline software .
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6.10 Amplitude/phase measurement

Background

Experienced  users  can  use  the  amplitude/phase  measurement  to  determine
changes in the stiffness of a component that are caused by structural breakage in
the material, for example. To do this, you first use the Detector to perform vibration
measurements  at different points  along the component.  After  transferring  to  the
data to the Trendline software you can then analyze the amplitude/phase graph to
determine whether there are any changes  in  stiffness. For example, if the phase
jumps  180°  from  one  measuring  point  to  the  next,  this  indicates  structural
breakage between the two points. If, however, the phase values  of the particular
measurement  are  not  significant,  this  generally  means  that  there  is  only  an
imbalance running down the length of the entire component.

If  you  have  discovered  a  "critical"  spot,  you  can  narrow  it  down  by  performing
additional  measurements  between  the  two  originally  measured  points.  In  this
way you can "feel out" the damages of components step by step.

Conditions

Balancing must be enabled on the Detector (see "Balancing activation" ).

Other notes

The number of measuring points is limited to 255.

Starting the amplitude/phase measurement

Select the Amplitude/Phase menu item in the Detector.

Select the measuring point with  the RFID Reader or manually (see "Selection
of measuring point ").

The Amplitude/Phase menu is displayed.

New measuring point

Attach the sensor to the point provided for this purpose.

Name of the measuring point: The Detector suggests  the names  specified  in
the Trendline software (see "Setting up the amplitude/phase configuration" )
and adds a space and consecutively increasing number to  these (e.g. "MP 1).
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You can accept the suggested name or enter a different name.

Pitch: The pitch at the reference point is  needed to  display the  position  of  the
measuring point in the amplitude/phase graph. If at least two measuring points
are already available, the Detector automatically suggests  a  value  composed
of  the  pitch  of  the  last  measuring  point  and  the  pitch  between  the  two  last
measuring points. You can accept the suggestion or enter a different value.

The  measurement  is  started.  The  Detector  measures  the  rotational  speed  as
well  as  amplitude  and  phase  of  the  vibration.  A  bar  showing  mean  variance
displays  the  stability  of  the  values.  You  can  reset  the  mean  by  pressing  the

function button  to restart mean calculation.

Press  the Enter button   once  amplitude  and  phase  have  stabilized  after  a
time.

After completing the measurement, you can select a comment. In  the comment
list,  you  can  create  a  new  comment  or  select  an  existing  one  (see  "
Managing comments for measurements "). If no comments  exist in  the list,
the edit field  for the  comment  input  is  shown.  Confirm  your  settings  with  the

Enter button .

Select Values are OK.

The values  for the measuring point are saved along with  the comment. You can
now continue or stop the measurement at the next measuring point.

The  number  of  measuring  points  is  limited  to  255.  Once  this
number  is  reached,  the  Detector  displays  a  warning  and
automatically stops the measurement.

If there is not enough memory for an additional  measuring point,
the Detector also displays a warning and automatically stops the
measurement.

After completing the measurement, the Detector displays  all  measured values  in
a table.
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You  can  repeat  a  measurement  (completely or  at  particular  measuring  points)
before you transfer the measurement data to  the Trendline software. To do  this,
select  Repeat  measurement  in  the  Amplitude/phase  menu.  The  Detector
displays  a  table  containing  all  of  the  available  measuring  points.  A measuring
point that has already been measured is indicated in the menu with the symbol  
. Select the desired measuring point in order to repeat a measurement.

Settings

You  can  use  this  menu  item  to  display  the  settings  you  specified  for  the
measuring  point  in  the  Amplitude/phase  configuration  of  the  Trendline
software. In  the case of  a  free  measurement,  you  can  also  modify the  settings
from here as long as no measurement has been taken.

General

Select this  menu item  to  display the  amplitude/phase  and  the  rotational  speed
settings of the configuration.

Trigger sensor / vibration sensor

Select this menu item to display the particular sensor setting from  the Amplitude/
phase configuration .

Remove all

Select  this  menu  item  to  delete  all  previous  measured  values  as  well  as  the
name and pitches for this configuration.

Clear measured values

Select  this  menu  item  to  clear  all  previously  measured  values  for  this
configuration, i.e. amplitude/phase values, rotational  speed. Names  and pitches
are  not  deleted  such  that  you  can  repeat  the  measurement  at  all  measuring
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points without having to reenter names and pitches.

Delete measuring point

Select this menu item to delete particular measured values.

The Detector displays  a table  containing all  of the available  measuring points. A
measuring point that has  already been measured is  indicated in  the  menu  with
the symbol .

Select the measuring  points  you  would  like  to  delete  and  confirm  the  delete

process with the Enter button .

6.11 Free measurement
In addition to the planned route  measurements you can also use the Detector
to  carry  out  what  are  known  as  free  measurements.  For  CM,  balancing,
amplitude/phase measurements  and run up/coast down measurements,  select
the New measuring point menu item.

Example: You are in the process of taking a round of measurements. You
notice an unusual noise or unusually high temperature on a machine that
is  not  included  in  this  round  of  measurements.  You  can  use  the  New
position option to carry out an additional on-the-spot measurement.

In these situations measurement templates must be defined using the Trendline
- Software. The templates  you  create  depend  on  your  particular  circumstances.
The procedure for creating and transferring measurement templates is described
in detail  under "Create template ". If there isn't a  template  from  the  Trendline
software on your Detector, you can select a default template on the device.

The  Detector  displays  all  velocity  values  during  the  free
measurement.  These  values  are  in  the  units  selected  in  the
Trendline  software  for  the  template  being  used.  In  the  Settings
menu  you  can  also  change  almost  all  settings  during  the  free
measurement. 

Free CM measurement

Position the sensor at the desired measuring point.
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Select Condition monitoring > New position.

Then go to Select template  to  choose a suitable  template. You can select the
template of a previous measurement, alternatively.

      

In  the  next  menu  you  can  change  the  template  name  so  that  the  free
measurement  can  later  be  assigned  to  the  measuring  point  at  which  it  was
recorded. 

o If you accept the name without changing it, the free measurement is  assigned
the template name and also a reference number that  increases  by one  each
time a new measurement is taken using this template (<Name> 1, <Name> 2,
...).

o To change  the  name  select  Change  name  and  confirm  your  choice  with  the

Enter button . On the next screen, the name of the template selected and the
current order number are displayed, and a cursor is  positioned under the first
letter. Change the name as described in Key pad entries .

After changing the name select Continue.

Select Settings to adopt the configuration of the template.

      

When  carrying  out  a  free  measurement  all  other  values  can  be  changed  in
addition to  the template name. To do this, select the Settings  item  in  the menu.

You can now select the relevant values  using the Enter button . Depending on
the type of setting, you can now type in a new value directly, make a selection from
a  drop-down  menu  or  modify  an  item  of  text  as  described  above.  Leave  the

settings menu with the Esc button .

Select Start measurement to begin the measuring procedure.

From  this  point onwards  the sequence of the measuring process  is  identical  to
the Standard  measurement  process  (initialization  of  hardware,  recording  of
characteristic  values,  display  of  measuring  results  with  comment  selection,
storage of measured data). 
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Show previous measurements

In  order to  view the results  for free  measurements  previously carried  out  select
directly  after  the  measurement  Previous  data  and  select  the  desired
measurement from the list.

Multiple measurements

You can repeat a  free CM measurement just like a CM measurement. For more
information on multiple  measurements, see the section Multiple  measurements

.

Free balancing measurement

Position the sensor(s) at the desired measuring point.

Select Balancing > New measuring point.

Then go to Select template  to  choose a suitable  template. You can select the
template of a previous measurement, alternatively.

      

In  the  next  menu  you  can  change  the  template  name  so  that  the  free
measurement  can  later  be  assigned  to  the  measuring  point  at  which  it  was
recorded. 

o If you accept the name without changing it, the free measurement is  assigned
the template name and also a reference number that  increases  by one  each
time a new measurement is taken using this template (<Name> 1, <Name> 2,
...).

o To change  the  name  select  Change  name  and  confirm  your  choice  with  the

Enter button . On the next screen, the name of the template selected and the
current order number are displayed, and a cursor is  positioned under the first
letter. Change the name as described in Key pad entries .

After changing the name select Continue.

Select Settings to adopt the configuration of the template.
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When  carrying  out  a  free  measurement  all  other  values  can  be  changed  in
addition to  the template name. To do this, select the Settings  item  in  the menu.

You can now select the relevant values  using the Enter button . Depending on
the type of setting, you can now type in a new value directly, make a selection from
a  drop-down  menu  or  modify  an  item  of  text  as  described  above.  Leave  the

settings menu with the Esc button .

Select Measure rotation speed to begin the measuring procedure.

From  this  point onwards  the sequence for the measuring procedure is  identical
to the performing a balancing measurement .

If  you  modify  the  balancing  unit  while  performing  a  free
measurement  (Type  of  vibration  unit),  the  limit  value  for  the
balancing  measurement  (Balancing  OK  at)  is  reset  to  0.  The
previous value is no longer applicable for the new balancing  unit.
You should always adjust the limit value in this case; otherwise, the
Detector  will  never  be  ab le  to  complete  the  balancing
measurement  and  you  would  have  to  complete  balancing
manually.

You can change the settings for the  free  balancing  measurement
until  the  first  reference  run  has  been  completed  and  saved.
Afterwards,  your  settings  are  locked  and  can  no  longer  be
changed.

Continue balancing measurement

Once the Detector has  been switched on, you can resume a free  measurement
that was started previously. To do this, select Balance > New position > Previous
data and then the required measurement. You can now continue with  balancing
process as usual.

Free run up / coast down measurement

Position the sensor at the desired measuring point.

Select Run up / coast down > New measuring point.
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Then go to Select template  to  choose a suitable  template. You can select the
template of a previous measurement, alternatively.

      

In  the  next  menu  you  can  change  the  template  name  so  that  the  free
measurement  can  later  be  assigned  to  the  measuring  point  at  which  it  was
recorded. 

o If you accept the name without changing it, the free measurement is  assigned
the template name and also a reference number that  increases  by one  each
time a new measurement is taken using this template (<Name> 1, <Name> 2,
...).

o To change  the  name  select  Change  name  and  confirm  your  choice  with  the

Enter button . On the next screen, the name of the template selected and the
current order number are displayed, and a cursor is  positioned under the first
letter. Change the name as described in Key pad entries .

After changing the name select Continue.

Select Settings to adopt the configuration of the template.

      

When  carrying  out  a  free  measurement  all  other  values  can  be  changed  in
addition to  the template name. To do this, select the Settings  item  in  the menu.

You can now select the relevant values  using the Enter button . Depending on
the type of setting, you can now type in a new value directly, make a selection from
a  drop-down  menu  or  modify  an  item  of  text  as  described  above.  Leave  the

settings menu with the Esc button .

Select Start measurement to begin the measuring procedure.

As  of  here,  the  procedure  corresponds  to  the  run  up  /  coast  down  test  (see  "
Determining the resonant range of a machine ").

Continue free run up / coast down measurement

Once the Detector has  been switched on, you can resume a free  measurement
that  was  started  previously.  To  do  this,  select  Run  up  /  coast  down  >  New
position  >  Previous  data  and  then  the  required  measurement.  You  can  now
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continue with balancing process as usual.

Free Amplitude/Phase measurement

Position the sensor at the desired measuring point.

Select Amplitude/Phase > New position.

Then go to Select template  to  choose a suitable  template. You can select the
template of a previous measurement, alternatively.

      

In  the  next  menu  you  can  change  the  template  name  so  that  the  free
measurement  can  later  be  assigned  to  the  measuring  point  at  which  it  was
recorded. 

o If you accept the name without changing it, the free measurement is  assigned
the template name and also a reference number that  increases  by one  each
time a new measurement is taken using this template (<Name> 1, <Name> 2,
...).

o To change  the  name  select  Change  name  and  confirm  your  choice  with  the

Enter button . On the next screen, the name of the template selected and the
current order number are displayed, and a cursor is  positioned under the first
letter. Change the name as described in Key pad entries .

After changing the name select Continue.

Select Settings to adopt the configuration of the template.

      

When  carrying  out  a  free  measurement  all  other  values  can  be  changed  in
addition to  the template name. To do this, select the Settings  item  in  the menu.

You can now select the relevant values  using the Enter button . Depending on
the type of setting, you can now type in a new value directly, make a selection from
a  drop-down  menu  or  modify  an  item  of  text  as  described  above.  Leave  the

settings menu with the Esc button .

Select New measure point to begin the measuring procedure.

From  this  point onwards  the sequence of the measuring process  is  identical  to
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the Standard amplitude/phase measurement  process.

Multiple measurements

You  can  repeat  a  free  measurement  just  like  a  measurement.  For  more
information on multiple  measurements, see the section Multiple  measurements

.

6.12 Single measurements
With  the  Detector,  you  can  perform  single  measurements  to  the  ISO  10816
characteristic  value  determination,  for  "listening"  to  the  measurement  point,  for
temperature and rotational  speed measurements  as  well  as  for the ICP  sensor
test. 

Press on Single measurements in the main menu.

Please note that single measurements cannot be saved.

ISO 10816

This  menu item  allows  you to  perform  a  single  CM measurement  for  recording
characteristic values  as  per ISO 10816 (class  1-4). Please note that  you  cannot
save this measurement!

The  following  fixed  settings  are  used  to  perform  for  the  ISO  10816  single
measurement:

Class 1 Class 2 Class 3 Class 4

Pre-alarm threshold 1.8 mm/s 2.8 mm/s 4.5 mm/s 7.1 mm/s

Main alarm threshold 4.5 mm/s 7.1 mm/s 11.2 mm/s 18.0 mm/s

Sensitiv ity  of sensor [mV/g] 100

ISO 10816 classes
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A OK Ty pical for a new  machine.

B OK Condition of machine is suitable for continuous operation.

C Pre-alarm Condition of machine is no longer suitable for continuous operation;

limited operating duration possible in this state.

D Main alarm Hazardous v ibrational state, damage to the machine may  be

imminent.

(Source: ISO 10816-1)

Classes Explanation

I Components of motors and machines rigidly  connected w ith the complete machine

under the usual operating conditions (ty pical: driv e motor up to 15 kW output).

II Medium-sized machines (ty pical: 15 kW to 75 kW output) w ithout special foundations,

rigidly  constructed motors and machines (up to 300 kW) on special foundations. 

III Large motors and other large machines w ith rotating masses, constructed on rigid and

heav y  foundations that are relativ ely  stiff in the direction of the v ibration that is

measured. 

IV Large motors and other large machines w ith rotating masses, constructed on foundations

that are relativ ely  forgiv ing in the direction of the v ibration (e.g. turbo generating sets and

gas turbines w ith an output greater than 10 MW). 

Select Single measurements > ISO 10816 and then the desired class.

The  measurement  is  performed  accord  to  the  CM  measurement .  Finally  a
summary  of  the  results  including  the  alarm  status  is  displayed.  The
demodulation value is shown without alarm status.
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The measurement cannot be saved and you also cannot view any time  signals,
FFTs or Trends. You can, however, perform an additional measurement:

Press the Enter key  in order to take a measurement for the same class.

Press the Esc key  to select another class.

Headset

The headset function can be activated under Single measurements  > Headsets.
Here you can "listen to" a  measuring point and adjust the amplification factor for
this option. The headset cannot be used in the Detector during a measurement. 

In addition to headset, an analog recorder may also be connected to  the 3.5 mm
jack. Measurement with  headset is  described in  more detail  in  using a  headset

.

Temperature

The  temperature  can  be  measured  directly  via  Single  measurements  >
Temperature without requiring prior configuration. The procedure is  the same as
for a  normal  Temperature measurement . The only difference here is  that the
temperature cannot be saved.

Rotational speed

The  rotational  speed  can  be  measured  directly  by  selecting  Single
measurements  >  Rotational  speed.  The  Detector  shows  the  current  and  the

average rotational speed. If you want to set pulses per rotation, press  on  or 

or press the Enter button  and enter the number of pulses.
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ICP sensor test

The ICP sensor test checks the following cases  based on the bias  voltage of the
sensor connected to the BNC1 connector:

The voltage is within the specified range: The sensor is functional.

The  voltage  is  greater  than  maximum  sensor  voltage:  The  sensor  cable  is
defective or no sensor is connected.

The  voltage  is  between  0  and  minimum  sensor  voltage:  The  sensor  is
defective.

After starting the ICP sensor test, it may take a few seconds, until all
transient effects are concluded in the sensor.

6.13 Delete measured data
You  can  delete  the  measuring  data  of  a  CM,  balancing,  run  up/coast  down  or
amplitude/phase  measurement  on  the  Detector.  Therefore  select  the  desired
level  (hall,  machine  or  measuring  point)  or  mark  directly  a  measurement  to
delete.

Please note, that the measurement data will  be  irrevocably  lost  if
you confirm the deleting process. You cannot recover the data!

Delete measurement data on the Detector

Select the level below which the measured data should be deleted.

Press the function button .

Select Delete data and

confirm the deleting process with the Enter button .

The  following  table  describes  the  deleting  of  CM  measurement  data  on  each
level. The  deleting  procedure  is  the  same  for  balancing,  run  up/coast  down  or
amplitude/phase measurements.
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Level Step and description

Delete measurement data of a configured measurement point

Select position mark:

All measurement data of the associated measurement places w ill be

deleted.

Select position > Plant mark:

All measurement data of the selected hall w ill be deleted.

Select position > Plant > Machine mark:

All measurement data of the selected machine w ill be deleted.

Select position > Plant > Machine > Position mark:

All measurement data of the selected measurement place w ill be deleted.

Delete previous measurement data of a configured measurement point

Select position > Plant > Machine > Position > Prev ious data > Mark

measurement to be deleted:

All measurement data of the selected prev ious measurement w ill be

deleted.

Delete free measurement data

New position mark:

All measurement data of the associated free measurements w ill be deleted.

New  position > Prev ious data > Mark measurement to be deleted:

All measurement data of the selected free measurement w ill be deleted.
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In  balancing  measurements  the  last  coefficient  provided  by  the
Trendline will  be kept,  so  the  trial  run  will  not  be  restarted  at  the
next  balancing  process.  In  amplitude/phase  measurements  all
measurement  points  that  are  saved  to  a  configuration  or  free
measurement will be deleted also.

6.14 System messages and their meaning

Error message Description Cause of the fault / solution

Sensor error An error occurred during

the initialization phase of

the measuring process.

With activ e sensors: the

measured bias v oltage

is not w ithin the specified

range.

The sensor (or sensor cable) is defectiv e or not properly

connected.

If the v oltage is not w ithin the v alid range for activ e sensors,

this may  be because:

the sensor is not connected,

the sensor has short circuited,

the sensor has a defectiv e cable,

the set bias v oltages  are w rong for the sensor being

used.

For more detailed troubleshooting, perform a ICP sensor test

.

Measuring point is

crossed out

The current measuring

point has a data error.

You cannot start this

measurement. If y ou try

to start the

measurement, the "CRC

error" message is

display ed.

If there are still measured data sav ed in the Detector, use

Trendline to collect them. Only  those measurements are

transferred that do not hav e an data error. Measurements

w ith data errors are lost. The send a new  configuration to

the Detector.

Input

ov ermodulated!

Please measure

again.

The measurement

amplifier settings are

optimized before the

measurement is carried

out. If the strength of the

measured signal

increases after this

setting increases, the

input may  become

ov ermodulated. 

If this error occurs, y ou must repeat the measurement. If this

error occurs frequently  y ou are probably  carry ing out

measurements at a machine that is turning quite slow ly  (<

120 rev olutions per minute). The Detector is not designed to

carry  out these kinds of measurements.

Connect

temperature

sensor and sw itch

it on

Before performing a

temperature

measurement y ou w ill

be prompted to connect

If y ou are using a Ray tek sensor and its sw itch is ON,

sw itch it off and on again.

46
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Error message Description Cause of the fault / solution

or sw itch on the

temperature sensor.

Temperature too

high

The measured

temperature is bey ond

the technical limit of the

temperature sensor.

Temperature measurement range: -15 °C to +550 °C

No memory  left

for sav ing data

Cannot create any  more

measurement, balancing

step or new  data block

for run up/coast dow n

because memory  is full.

Transfer the data to Trendline and transfer the last balancing

configuration or route back to the Detector.

Warning: battery

low

The battery  is nearly

empty .

Please recharge  the accumulator before continuing to

w ork w ith the Detector. Otherw ise, the Detector could shut

dow n w ithout any  w arning so as to protect the accumulator.

The battery  is

empty  Please

charge

The battery  is empty ,

the Detector cannot be

sw itched on.

The battery  must be recharged .

No memory

allocated

No memory  has been

allocated for

configurations that hav e

been sent to the

Detector.

The Trendline database may  contain an error. Please

contact support@fis-serv ices.com.

No template

loaded

No balancing, CM or run

up/coast dow n template

has been sav ed.

You are try ing to perform a free measurement, but there is

no template is stored in the Detector. Templates are only

attached if y ou click in Trendline on Detector > Send route

.

No configuration

loaded!

No balancing, CM or run

up/coast dow n

configuration has been

sav ed.

You w ish to carry  out balancing, a CM measurement or a

run up/coast dow n procedure but hav e not y et transferred a

configuration to the Detector. In Trendline click on Detector

> Send configuration or Detector > Send route.

No free

measurements

sav ed

No free measurements

hav e been performed

y et.

You are attempting to v iew  free balancing, CM

measurements or run up/coast dow n measurements on the

Detector although neither of these ty pes of measurement has

been carried out.

No balancing

configuration

stored.

The Detector is

attempting to sav e time

signals but cannot

because of insufficient

memory .

Send a balancing configuration to the Detector (click in 

Trendline on Detector > Send configuration or

Detector > Send route) before y ou select a configuration

from the balancing menu of the Detector.

No memory

av ailable for time

The Detector is

attempting to sav e time

This can occur if y ou w ant to sav e only  those time signals

occurring in the ev ent of an alarm. It is also possible that

218
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Error message Description Cause of the fault / solution

signals signals but cannot as

there is not enough

memory .

y ou hav e taken multiple measurements at this measuring

point. The characteristic v alues are alw ay s sav ed, but none

or only  some of the time signals are sav ed.

Input

ov ermodulated!

The v ibration signal is

too large to be measured

by  the Detector.

There are tw o possible causes for this:

The input signal is v ery  large (>50 g). Use another

sensor (w ith a sensitiv ity  of 10 mV/g, for ex ample).

The strength of the signal increased after the amplifier

w as adjusted due to an impact on the machine, for

ex ample. The v ibrations must remain more or less

constant throughout the entire measurement.

No RPM signal! The rotational speed

signal is missing.

Possible causes:

The trigger sensor is not correctly  aligned w ith the reflex

mark.

The reflex  mark w as not glued on.

The trigger sensor is too close to the reflex  mark (<10

cm). Increase the distance.

The trigger sensor has been incorrectly  configured

in Trendline (incorrect supply  v oltage, for ex ample).

You hav e not connected the trigger sensor to the AUX

port  of the Detector.

Rotational speed

unstable!

The rotational speed

signal is fluctuating.

Possible causes:

The trigger sensor is not correctly  aligned w ith the reflex

mark.

The trigger sensor is too close to the reflex  mark (should

be at least 10 cm).

Machine rotational speed fluctuates.

The rotational

speed not w ithin

range.

The acquired speed is

outside the rotational

speed band defined in .

Reduce the speed of the machine or use the current

rotational speed as the new  nominal rotational speed.

No conf. for RFID No configuration found

for the RFID entry .

This error occurs w hen Trendline sends the RFID status for

a measuring point before a balancing, CM or run up/coast

dow n configuration w as sent. Make sure that there is a

configuration for the measuring point on the Detector. The

Trendline database may  contain an error. Please contact 

support@fis-serv ices.com.

Could not find at

least one

configuration

Detected RFID tags and

configured measuring

points do not match.

The Detector found at least one RFID tag w ithout a

measuring point configuration. The missing measuring point

is therefore not offered for selection for the measurement.

Multiple IDs read.

Please repeat

Tw o or more tags w ere

found w hile try ing to

assign an RFID tag.

The assignment is not possible as the Detector found at least

tw o tags in the RFID Reader read area. Remov e the

unnecessary  RFID tags from the read area.

45
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Error message Description Cause of the fault / solution

ID already  in use.

Please repeat

An RFID tag w as read

that is already  assigned

to another measuring

point.

Assign a new  RFID tag to the current measuring point.

Change sensor to:

…

The nex t measurement

must be performed w ith

a different sensor.

If y ou hav e configured sensors w ith different sensitiv ities for

measuring points, y ou may  need to change the sensor

betw een tw o measurements. In this case, the Detector tells

y ou w hich sensor y ou need to connect for the nex t

measurement.

Max imum number

of data reached!

Max imum number of

data points reached (in

run up/coast dow n).

The sy stem aborts after 65535 v alues in a run up/coast

dow n. The v alues measured so far are sav ed.

Resonant

 frequency !

Machine in resonant

range for balancing

measurement.

If y ou hav e defined one or more resonant ranges for a

machine in the Trendline softw are (see "setting up run up/

coast dow n " and "determining the resonant range of a

machine "), the Detector display s this message during

balancing if the current rotational speed is w ithin such a

resonant range. You can continue the balancing

measurement. How ev er, observ e the information giv en in 

balancing measurement .

Rotational speed

to high (low ) for

Autostart /

Autostop

Rotational speed already

ex ceeds the selected

autostart and/or autostop

speed at run up.

Or: Rotational speed is

already  low er than the

selected autostart and/or

autostop speed at coast

dow n.

Run up: If rotational speed is too high for an automatic start

and/or automatic stop, the sy stem stops the automatic

measurement start and/or stop. You can start and/or stop

manually  by  pressing Enter.

Coast dow n: If rotational speed is too low  for an automatic

start and/or automatic stop, the sy stem stops the automatic

measurement start and/or stop. You can start and/or stop

manually  by  pressing Enter.

HW0 to HW2

(backup battery )

Self-test error At start-up, the Detector performs a self-test to check internal

v oltages. If one of these three messages is display ed, y ou

must replace the backup battery . Please contact 

support@fis-serv ices.com and tell us the error number. We

w ill then giv e y ou further details on how  to replace the

battery . You can by pass the error message by  pressing

Enter.

HW3 to HW7

(Internal error)

Self-test error This is a critical error. Please contact support@fis-serv ices.

com and tell us the error number. We w ill then giv e y ou

further information.
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The Detector records error messages and additional  information in
a  log  file  that  you  can  open  with  the  Trendline  software  (see  "
Download log file from Detector" ).

6.15 Update firmware
The internal  software of the Detector is  saved in  what is  known as  the firmware.
FAG  Industrial  Services  is  constantly  expanding  and  improving  the  Detector
firmware.  You  should  therefore  update  this  in  the  Detector  as  soon  as  a  new
release becomes  available. The  current  version  is  available  for  download  from
our website at (www.fis-services.com).

ATTENTION Loss of measurement data is possible!

When you update  the  Detector  firmware,  all  data  will  be
deleted on the Detector!

Before you start...

1. All  data on the Detector is  deleted when the firmware is  updated.  You  should
therefore  transfer  your  data  from  the  Detector  to  the  Trendline  software,  as
described at Read measuring data from Detector .

2. Download the current firmware file from our website: www.fis-services.com.

3. Start the Detector FlashUpdater (in  the  start  menu  under  Programs  >   FIS  >
Detector  FlashUpdater3). If it is not installed, install it from the Trendline CD or
download it from our website.

4. Have a thin object to hand - an unbent paper clip for example.

5. Connect  the  Detector  to  your  Windows  computer  using  the  enclosed  serial
cable.  Alternatively,  you  can  use  the  USB  serial  adapter ,  although
communication is more reliable via a serial interface.

6. Ensure that the battery  is charged to at least 25% of its capacity.

Update the Detector firmware

Click  on  Start  >  Programs  >  FIS  >  DetectorFlashUpdater3  >  Detector  Flash
Updater  3  and  follow  the  instructions  given  by  the  program.  The  update
comprises the following steps:

1. Initialization of Detector

a) Remove the battery for at least three seconds.

b) Put the battery back in and connect the Detector to the PC.

125
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2. Select the interface connected to the Detector.

The  "Installing  USB  serial  adapter "  section  explains  how  to
determine the interface number of the USB serial adapter.

3. Select the downloaded firmware file  ("Detector_3_x_x.dup"). If you downloaded
the firmware  from  the  web  page,  you  must  also  unpack  the  zip  archive.  The
FlashUpdater displays  information  on  the  changes  made  since  the  previous
release.

4. Prepare the Detector

a) Switch off the Detector.

b) Insert  a  thin  object  (a  bent  open  paper  clip,  for  example)  into  the  small
opening on the left-hand side of the Detector, and hold it in  this  position until
it encounters resistance.

c) Switch the Detector  on  and  hold  down  the  power-on  button.  Wait  for  three
seconds before removing the paper clip. Now release the power-on button.

5. The  new  firmware  is  now  transferred  to  the  Detector.  This  may take  several
minutes depending on the speed of the interface.

You can abort the update as long as the firmware upload  has  not
begun. Click Cancel to abort.

49
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7 Special information

7.1 Characteristic values
Detector III can store up to 4  different (or same just as  well) characteristic values
per measuring point. The following characteristic values can be selected:

Characte
ristic
value

Meaning

ISO 10816 RMS v alue of v ibration v elocity

Frequency  range: 10 Hz to 1 kHz

Unit: mm/s

v
sel

RMS v alue of v ibration v elocity  w ith freely  selectable upper and low er limiting frequency

Frequency  range: 0.3 Hz to 20 kHz (depending on the low pass frequency )

Unit: mm/s

a
eff

RMS v alue of acceleration in v ibration

Frequency  range: 2 Hz to 20 kHz (depending on the low pass frequency )

Unit: g

a
sel

RMS v alue of acceleration in v ibration w ith freely  selectable upper and low er limiting

frequency

Frequency  range: 0.1 Hz to 20 kHz (depending on the low pass frequency )

Unit: g

d
eff

Demodulation signal of acceleration in v ibration w ith sw itchable low -pass 

Frequency  range: 0.1 Hz to 20 kHz (depending on the low pass frequency )

Unit: g

d
sel

RMS v alue of demodulation in v ibration w ith freely  selectable upper and low er limiting

frequency

Frequency  range: 0.1 Hz to 20 kHz (depending on the low pass frequency )

Unit: g

T Temperature

Range: -20°C to +550°C

Unit: °C

Crest factor Ratio betw een peak v alue and RMS v alue (Crest factor = peak v alue / RMS v alue)

Universal Univ ersal characteristic v alue

Range: 0 to 99999

Unit: none

In  addition  to  the  aforementioned  characteristic  values,  you  can
also measure rotational speed.
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7.2 Frequency selective characteristic values
For characteristic values designated by the "sel" code, you can define a frequency
band within a range. This is used for the value calculation.

In  Trendline the low pass  cutoff frequency up to  which measurements  are to  be
taken is  defined for each  channel.  The  sampling  rate  is  always  2.56  times  the
value of this cutoff frequency. The time signal  that is  recorded in  this  way is  used
to calculate a frequency spectrum  by means  of an  FFT  calculation.  This  is  then
used  to  recalculate  the  characteristic  values  within  the  defined  limits.  An  a

eff

value  of  between  2  kHz and  5  kHz is  therefore  calculated  for  a  low  pass  filter
setting of 5 kHz, for example.

Characteristic value Analog channel Frequency range 

a
eff

Acceleration 2 kHz - low pass acceleration channel

a
sel

Acceleration f
min_a

 - low pass a (both frequencies adjustable,

see table below )

ISO 10816 Speed 10 Hz - 1 kHz

v
sel

Speed f
min_v

 - low pass v elocity  channel (both frequencies

adjustable, see table below )

d
eff

Demodulation f
min

 - low pass demodulation channel

d
sel

Demodulation f
min

 - low pass demodulation channel (both

frequencies adjustable, see table below )

The low pass  and FFT length can  be  adjusted  for  each  channel.  Both  of  these
factors  affect the sampling rate, the minimum  possible  frequency and frequency
resolution.

Lowpass Sampling

rate

FFT-length  f
min

 f
min_v

(* ) Frequency resolution

200 Hz 512 SPS 1600 lines 0.125 Hz 0.375 Hz 0.125 Hz

200 Hz 512 SPS 3200 lines 0.1 Hz 0.19 Hz 0.0625 Hz

500 Hz 1.28 kSPS 1600 lines 0.3125 Hz 0.94 Hz 0.3125 Hz

500 Hz 1.28 kSPS 3200 lines 0.156 Hz 0.47 Hz 0.156 Hz

1 kHz 2.56 kSPS 1600 lines 0.625 Hz 1.875 Hz 0.625 Hz

1 kHz 2.56 kSPS 3200 lines 0.3125 Hz 0.94 Hz 0.3125 Hz

2 kHz 5.12 kSPS 1600 lines 1.25 Hz 3.75 Hz 1.25 Hz

271



271

Special information

2 kHz 5.12 kSPS 3200 lines 0.625 Hz 1.875 Hz 0.625 Hz

5 kHz 12.8 kSPS 1600 lines 3.125 Hz 9.375 3.125 Hz

5 kHz 12.8 kSPS 3200 lines 1.56 Hz 4.7 Hz 1.56 Hz

10 kHz 25.6 kSPS 1600 lines 6.25 Hz 18.75 Hz 6.25 Hz

10 kHz 25.6 kSPS 3200 lines 3.125 Hz 9.375 Hz 3.125 Hz

20 kHz 51.2 kSPS 1600 lines 12.5 Hz 37.5 Hz 12.5 Hz

20 kHz 51.2 kSPS 3200 lines 6.25 Hz 18.75 Hz 6.25 Hz

(SPS = Samples per second)

(*) In  the case of characteristic values  for  speed  the  minimum  frequency is  the
third line in the spectrum as the first lines may become overly large as  a result of
the integration.

7.3 Time signals
You can select in  Trendline software, which time signals  should be  stored.  The
Detector can save up to 300 time signals and up to  1600 measuring points. Give
careful consideration to what signals you need. You can select, when configuring
the measuring point (see "Create a measuring point" ), if a  certain  time signal
should be stored all  the  time,  or  only,  if  the  characteristic  value  shows  a  main
alarm.

If a  configuration or route is  sent to  the Detector, the Detector checks  how many
time  signals  have  to  be  stored  at  all  times.  For  these  time  signals  the  right
amount of memory is  allocated right after the data transfer  to  ensure  that  these
time signals are guaranteed to be stored. However, this automatically means  that
no  more  time  signals  than  the  Detector  memory  can  accommodate  must  be
marked  with  "Save  always"  in  a  configuration  or  route.  Before  sending  a
configuration  or  route  to  the  Detector,  the  Trendline  software  checks  if  the
available  memory of the Detector is  sufficient to  store the  data.  If  this  is  not  the
case, an error message is displayed and the data is not sent to the Detector.

For time signals that are to be stored only in  the event of an alarm, the Trendline
software cannot  check  whether  they would  fit  in  the  memory,  because  it  is  not
possible  to  know  how  many measuring  points  have  an  alarm.  In  an  extreme
case, one could click "Save in the event of alarm" for all  time signals. Even if one
of the characteristic values  has  an alarm  and a time  signal  therefore  has  to  be
saved, this is  stored only when sufficient memory is  actually available. If there is
not  enough  memory,  the  user  will  get  a  message  notifying  him  that  there  is
insufficient  memory  and  the  time  signal  was  not  stored.  You  can  find  more
information on this under "Dynamic memory management" .
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Bear  in  mind  that  a  time  signal  may  NOT  have  been  recorded
when an alarm was output for a characteristic value even if the field
"Save in the event of main alarm" was activated. Time signals that
should  be  saved  in  the  event  of  an  alarm  can  only  be  saved  if
sufficient memory is availab le.

The  recorded  time  signals  are  always  acceleration  signals,  which  are  each
filtered and  sampled  differently.  The  Detector  can  measure  three  different  time
signals. Here you can choose from three different measuring branches .

For  the  calculation  of  the  characteristic  velocity  values  ISO10816  and  V
sel

 the

transformation from the acceleration signal  into  the velocity signal  is  done in  the
frequency  domain.  Therefore,  for  these  characteristic  values  the  acceleration
signal  is  always  stored  and  displayed  for  the  time  signal.  The  time  signal
sampling rates are set for each channel by the lowpass settings.

7.4 Dynamic memory management
The  Detector  offers  dynamic  memory  management.  Because  of  this,  the
partitioning of the memory is  not defined in  the firmware. For  measuring  points,
time signals, etc. there is a memory block of 2.7 MB. You can set in  the Trendline
software whether  many configurations  or  many time  signals  are  needed  when
taking  the  next  measurements.  The  required  memory  can  be  calculated  as
follows: 

Memory element Memory usage

Configuration CM configuration: 572 by tes

Balancing configuration: 394 by tes

Run up/coast dow n: 272 by tes

Amplitude/phase configuration: 290 by tes

Free measurement CM measurement: 588 by tes

Balancing measurement: 408 by tes

Run up/coast dow n: 286 by tes

Amplitude/phase measurement: 304 by tes

Templates CM configuration: 588 by tes

Balancing configuration: 410 by tes

Run up/coast dow n: 288 by tes

Amplitude/phase configuration: 306 by tes

Time signal 8244 by tes (1600 lines), 16436 by tes (3200 lines)

Balancing step 244 by tes

Run up/coast dow n 94 by tes + (n * 12) by tes per Amplitude/phase v alue

(n = number of reference points)
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Amplitude/phase 92 by tes

Additionally,  the  following  memory  is  required  depending  on  the  Detector
configurations:

131  kilobytes  if  at  least  one  balancing  or  run  up/coast  down  configuration
exists on the Detector.

30 bytes for each unit used. As a rule 5-10 units are stored on the Detector.

54 bytes for each comment used. 

Example: 500 CM configurations are sent to  the Detector (500 *  572 bytes
= approx. 286 kB), leaving 2.7 MB - 0.286 MB = 2.414 MB for time signals
and  free  measurements.  This  means,  that  2,414  MB  /  16436  bytes  (@
3200 lines) = 146 time signals can still  be stored. The remaining memory
of about 14 kB can then be used for about 23 free CM measurements.

7.5 Analog branches in the Detector III
Depending  on  the  selected  characteristic  value  the  sensor  signals  are
preconditioned by different signal paths in the Detector.

The  measuring  signal  reaches  the  Detector  via  the  sensor  module  (BNC1  or
BNC2, see "Connectors" ), where it passes a highpass filter (0.1 Hz) when the
sensors are active. The signal is then amplified in a PGA  (

programmable gain amplifier

). After the amplifier the signal  is  subdivided into  three branches,  each  of  which
can have a different filter.

The acceleration and velocity branch both have their own lowpass  filter with  a
selectable corner frequency, so only the part of the signal  below this  frequency
can pass. In spite of its name, the acceleration is  what is  actually measured in
the velocity branch. This  signal  is  integrated into  the spectrum  to calculate the
characteristic velocity values.
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The  demodulation  signal  passes  through  a  high-pass  filter  first  (only
frequencies  higher  than  the  cut-off  frequency of  750Hz  can  pass).  Next,  the
signal  is  then  amplified  in  a  PGA,  then  rectified  and  finally low-pass  filtered.
The frequency of this  lowpass  filter can also be set  in  the  Trendline  software

. The signal  to  the headset connector is  branched off before that low-pass
filter.

The  Detector  can  measure  temperature  and  rotational  speed  via  the  AUX
connector  (see  "Connectors" ).  The  signal  from  the  temperature  sensor  is
amplified in a PGA and filtered with a cutoff frequency of 1 kHz in a lowpass.

7.6 Connecting
When connecting  to  the  Trendline  software  will  try to  connect  to  the  serial  port
used the last time with the baud rate used the last time. 

If  not  successful  it  searches  for  the  communication  parameters  by  itself  and
connects to the Detector.

If connection is not possible, it is due to the following causes:

The Detector is not switched on. Switch on the Detector.

The  data  cable  between  Detector  and  PC  is  not  connected.  Connect  the
Detector with the 9-pin data cable supplied to a serial interface at your PC.

The Detector is switched on and properly connected. If you still  cannot make a
connection,  it  may be  because  the  Detector  is  still  measuring  or  a  warning
message  on  the  display  waits  to  be  confirmed  by  you.  Wain  until  the
measurement  ends  or  confirm  the  warning  message.  If  there  is  still  no
communication possible, please turn the Detector off and on.

If  a  connection  can  be  established,  but  it  brakes  down  before  all  data  are
transferred,  the  accumulator  may be  empty.  For  sizeable  data  transfers  the
remaining charge in the battery should be at least 10 %.
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8 Maintenance and repairing

The  Detector  is  virtually maintenance-free.  If  a  defect  in  the  Detector  device  is
ascertained, please contact your customer adviser .

Cleaning

If necessary, you can make an external cleaning of the device.

Disconnect the accumulator from device.

Clean the device with a soft, lint-free cloth.

CAUTION Damage  to  the  device  can  result  from  improper
handling!

Do  not  use  any  chemical  solvents,  such  as  alcohol,
acetone, cellulose thinner or the like. These solvents can
dissolve the labeling or damage the housing.
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9 Taking out of service and disposal

Taking out of service

If danger-free operation of the Detector device is  no  longer  possible,  the  device
must  be  taken  out  of  service  and  secured  against  unintentional  operation.
Danger-free operation is no longer possible if the device

evidences visible damage

no longer functions

was stored under damage-inducing conditions

was subject to severe transport stresses.

Disposal

Neither the Detector device nor the associated components  may be disposed of
via domestic waste as they contain electronic components and accumulators  that
must be disposed of in  the proper manner. Please return them  to us  so that we
can  ensure  disposal  in  keeping  with  legal  and  environmental  requirements.
Returning used devices is an important contribution to environmental protection.
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Manufacturer / Support

10 Manufacturer / Support

Manufacturer

FAG Industrial Services GmbH

Kaiserstraße 100

52134 Herzogenrath

Germany

Tel.: +49 (0) 2407 9149-66

Fax: +49 (0) 2407 9149-59

Support hotline: +49 (0) 2407 9149-99 (free of charge*)

Internet: www.fis-services.com

Further information: info@fis-services.com

Sales: sales@fis-services.com

Please send postal mail directly to FAG Industrial Services GmbH.

Subsidiary of

Schaeffler Technologies GmbH & Co. KG

PO box 1260

97419 Schweinfurt

Germany

Georg-Schäfer-Straße 30

97421 Schweinfurt

Germany

Support free of charge

Hotline: +49 (0) 2407 9149-99  (*only the usual telephone charges are incurred)

E-Mail: support@fis-services.com

http://www.fis-services.com
mailto:support@fis-services.com
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11 Appendix

11.1 CE-Declaration of conformity

The manufacturer

F'IS, FAG Industrial Services GmbH, Kaiserstraße 100, 

D-52134 Herzogenrath

declares that the product

Detector III

Serial number: xxxxxx/F4 labelled w ithout "RFID"

meets the requirements, w hich have been set by the Electromagnetic Compatibility

Directive (2004/108/EG), if  the product is installed properly according to the installation

guidelines listed in the manual.

For assessment of the product the follow ing standards w ere used:

EN 61000-6-2:2001

EN 61000-6-4:2001

EN 55022:2003

Measuring device identif ier:  CE

Herzogenrath, 2010-01-22
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11.2 CE-Declaration of conformity (RFID)

Declaration of conformity as per the Radio and Telecommunication Transmitter Devices

Act (FTEG) and Directive 1999/5/EG (R&TTE)

The manufacturer

F'IS, FAG Industrial Services GmbH, Kaiserstraße 100, 

D-52134 Herzogenrath

declares that the product

Detector III

Serial number: xxxxxx/F4 labelled w ith "RFID"

Radio installation of device category 1

Purpose: RFID application

meets the requirements, w hich have been set by the Electromagnetic Compatibility

Directive (2004/108/EG) and by the standards on 1999/5/EG (R&TTE), if  the product is

installed properly according to the installation guidelines listed in the manual.

For assessment of the product the follow ing standards w ere used:

ETSI EN 300 330-2 V1.3.1 (2006-04)

ETSI EN 301 489-3 V1.4.1 (2002-08)

EN 55022:2003

EN 60950-1:2001 and A11:2004 + Corrigendum:2004

EN 61000-6-2:2005

FCC 47 Part 2 and Part 15

ANSI C63.4:2003

The Detector III w ith RFID application is a radio device that operates at 13.65 MHz. This

product may be operated in the countries of the European Union, Sw itzerland, USA,

Canada and Australia.

Measuring device identif ier:  CE

Herzogenrath, 2010-03-02



280

11.3 Principles of non-contact temperature measurement
(Dr.-Ing Gruner, Raytek)

Introduction

This  manual  was  written for people who are unfamiliar  with  noncontact  infrared
temperature measurement. A conscious  attempt has  been made to  present  the
subject matter as briefly and simply as possible. Readers who wish to  gain more
in-depth  knowledge  can  follow  the  suggestions  for  further  reading  in  the
bibliography.  This  manual  focuses  on  the  practical  operations  of  noncontact
temperature measurement devices  and IR thermometry, and answers  important
questions  that  may  arise.  If  you  plan  to  use  a  noncontact  temperature
measurement  device  and  require  further  advice,  send  us  the  completed
questionnaire (in the appendix) prior to use.

Advantages of using IR thermometers

Temperature is  the most frequently measured  physical  quantity,  second  only to
time. Temperature plays  an important  role  as  an  indicator  of  the  condition  of  a
product  or  piece  of  machinery,  both  in  manufacturing  and  in  quality  control.
Accurate  temperature  monitoring  improves  product  quality  and  increases
productivity. Downtimes  are decreased, since the manufacturing processes  can
proceed without interruption and under optimal conditions.

Infrared technology is  not a  new phenomenon - it has  been utilized successfully
in  industrial  and  research  settings  for  decades  -  but  new  innovations  have
reduced costs, increased reliability, and resulted in  noncontact infrared sensors
offering  smaller  units  of  measurement.  All  of  these  factors  have  led  infrared
technology to become an area of interest for new kinds of applications and users.

What are the advantages offered by noncontact temperature measurement?

It is  fast (in  the ms  range) - time  is  saved,  allowing  for  more  measurements
and accumulation of data (determination of temperature field).

It facilitates measurement of moving targets (conveyor processes).

Measurements  can be taken  of  hazardous  or  physically inaccessible  objects
(high-voltage parts, great measurement distance).

Measurements  of  high  temperatures  (greater  than  1300°C)  present  no
problems. In  similar cases, contact thermometers  cannot be used,  or  have  a
limited  life.  There  is  no  interference  -  no  energy is  lost  from  the  target.  For
example,  in  the  case  of  a  poor  heat  conductor  such  as  plastic  or  wood,
measurements  are extremely accurate with  no distortion of measured values,
as compared to measurements with contact thermometers.
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There is  no risk of contamination and no mechanical  effect  on  the  surface  of
the object; thus wear-free. Lacquered surfaces, for example, are not scratched
and soft surfaces can also be measured.

Having enumerated the advantages, there remains  the question of what to  keep
in mind when using an IR thermometer:

The target must be optically (infrared-optically) visible to the IR thermometer. High
levels of dust or smoke make measurement less  accurate. Concrete obstacles,
such as  a closed metallic reaction vessel, allow for only topical  measurement  -
the inside of the container cannot be measured.

The optics of the sensor must be protected from  dust and condensing liquids.
(Manufacturers supply the necessary equipment for this.)

Normally,  only  surface  temperatures  can  be  measured,  with  the  differing
emissivities of different material surfaces taken into account.

Summary: The main advantages of noncontact IR thermometry are speed, lack
of interference, and the ability to measure in high temperature ranges to 3000°
C. Keep in mind that only the surface temperature can be measured.

Infrared measuring system

An  IR  thermometer  can  be  compared  to  the  human  eye.  The  lens  of  the  eye
represents  the  optics  through  which  the  radiation  (flow  of  photons)  from  the
object  reaches  the  photosensitive  layer  (retina)  via  the  atmosphere.  This  is
converted  into  a  signal  that  is  sent  to  the  brain.  Fig.  1  shows  an  infrared
measuring system process flow.

Fig. 1 Infrared measuring system
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Target

Every form  of matter  with  a  temperature  (T)  above  absolute  zero  emits  infrared
radiation according to its  temperature. This  is  called characteristic radiation. The
cause of this is the internal  mechanical  movement of molecules. The intensity of
this  movement  depends  on  the  temperature  of  the  object.  Since  the  molecule
movement  represents  charge  displacement,  electromagnetic  radiation  (photon
particles)  is  emitted.  These  photons  move  at  the  speed  of  light  and  behave
according to  the known optical  principles. They can be deflected, focused with  a
lens, or reflected from  reflective surfaces. The spectrum  of this  radiation  ranges
from  0.7 to  1000 µm  wavelength. For this  reason, this  radiation cannot  normally
be seen with the naked eye. This area lies  within  the red area of visible  light and
has therefore been called "infra"-red after the Latin. (See Fig. 2).

Fig. 2 The electromagnetic spectrum, with range from around 0.7 to 14 µm useful for

measuring purposes

Fig. 3 shows the typical radiation of a body at different temperatures. As  indicated,
bodies at high temperatures still emit a small  amount of visible  radiation. This  is
why everyone can see objects  at very high temperatures  (above 600°C)  glowing
somewhere  from  red  to  white.  Experienced  steelworkers  can  even  estimate
temperature  quite  accurately from  the  color.  The  classic  disappearing  filament
pyrometer was  used in  the steel  and iron industries  from  1930 on. The invisible
part  of  the  spectrum,  however,  contains  up  to  100,000  times  more  energy.
Infrared measuring technology builds on this. It can likewise be seen in Fig. 3 that
the  radiation  maximum  move  toward  ever-shorter  wavelengths  as  the  target
temperature  rises,  and  that  the  curves  of  a  body  do  not  overlap  at  different
temperatures. The radiant energy in  the  entire  wavelength  range  (area  beneath
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each curve) increases  to  the power of 4  of the temperature. These relationships
were  recognized  by  Stefan  and  Boltzmann  in  1879  and  illustrate  that  an
unambiguous temperature can be measured from the radiation signal. /1/, /3/, /4/
and /5/.

Fig. 3 Radiation characteristics of a blackbody in relation to its temperature. /3/.

Looking at Fig. 3, then, the goal  should be to  set up the  IR  thermometer  for  the
widest  range  possible  in  order  to  gain  the  most  energy (corresponding  to  the
area  below  a  curve)  or  signal  from  the  target.  There  are,  however,  some
instances  in  which this  is  not always  advantageous. For  instance,  in  Fig.  3,  the
intensity  of  radiation  increases  at  2  µm  -  much  more  when  the  temperature
increases  than  at  10  µm.  The  greater  the  radiance  difference  per  temperature
difference, the more accurately the IR thermometer works. In  accordance with  the
displacement of the radiation maximum  to smaller wavelengths  with  increasing
temperature  (Wien's  Displacement  Law),  the  wavelength  range  behaves  in
accordance  with  the  measuring  temperature  range  of  the  pyrometer.  At  low
temperatures, an IR thermometer working  at  2  µm  would  stop  at  temperatures
below 600°C, seeing little  to  nothing  since  there  is  too  little  radiation  energy.  A
further reason for having devices for different wavelength ranges  is  the emissivity
pattern of some materials known as  non-gray bodies  (glass, metals, and plastic
films). Fig. 3  shows  the ideal  - the so-called "blackbody". Many bodies, however,
emit  less  radiation  at  the  same  temperature.  The  relation  between  the  real
emissive power and that of a  blackbody is  known as  emissivity å  (epsilon)  and
can  be  a  maximum  of  1  (body  corresponds  to  the  ideal  blackbody)  and  a
minimum of 0. Bodies with emissivity less  than 1 are called gray bodies. Bodies
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where emissivity is  also  dependent  on  temperature  and  wavelength  are  called
non-gray bodies. Furthermore, the sum  of emission is  composed  of  absorption
(A), reflection (R) and transmission (T) and is  equal  to  one. (See Equation 1 and
Fig. 4).

A + R + T = 1 (1)

Fig. 4 In addition to the radiation emitted from the target, the sensor also receives reflected

radiation and can also let radiation through.

Solid  bodies  have no transmission in  the infrared  range  (T  =  0).  In  accordance
with Kirchhof’s Law, it is  assumed that all  the radiation absorbed by a body, and
which has  led to  an increase in  temperature, is  then  also  emitted  by this  body.
The result, then, for absorption and emission is:

A <=> E = 1 - R (2)

The ideal blackbody also has no reflectance (R = 0), so that E = 1.

Many non-metallic  materials  such  as  wood,  plastic,  rubber,  organic  materials,
rock,  or  concrete  have  surfaces  that  reflect  very  little,  and  therefore  have  high
emissivities  between  0.8  and  0.95.  By contrast,  metals  -  especially those  with
polished or shiny surfaces  -  have  emissivities  at  around  0.1.  IR  thermometers



285

Appendix

compensate for this  by offering variable  options  for  setting  the  emissivity factor.
(See also Fig. 5).

 

Fig. 5 Specific radiation at various emississivity

11.3.1 Handling the pyrometer

Distance to spot size ratio

Distance to  spot ratio  (or field  of view) refers  to  the diameter of the spot that  the
probe is sensing at a  given distance. The closer you are to  the object (or target),
the smaller the area (or spot) the probe is  sensing. For example when the probe
is held at a 200 mm (8 in.) distance from the target, the spot size is  approximately
50 mm (2 in.); at 100 mm (4 in.) the spot size is approximately 25 mm  (1 in.), and
with  the  probe  held  at  50  mm  (2  in.)  distance  from  the  target,  the  spot  size  is
approximately 13 mm (½ in.).

Hot spots  can be missed if too large an area is  included in  the field  of  view,  so
get as close as possible! (See Fig. 6 and Fig. 7).



286

Fig. 6 Spot size

Fig. 7 Size of the measuring object

Emissivity

All  objects  emit  invisible  infrared  energy.  The  amount  of  energy  emitted  is
proportional  to  the  object's  temperature  and  its  ability  to  emit  IR  energy.  This
ability, called emissivity, is base upon the material  that the object is  made of and
its  surface finish. Emissivity values  range from  0.10 for a  very refective  object  to
1.00  for  a  black  body.  The  probe  senses  this  energy  and  calculates  the
temperature  base  on  the  amount  of  IR  energy  it  receives  and  the  factory  set
emissivity value of 0.95, which will cover 90% of typical applications.

Measurement considerations

If the surface to  measured is  small  [13 mm  (½ in.) or less], hold  the probe as
close as possible to the surface [no more than 50 mm (2 in.) away].

If the surface to  be measured is  covered by frost or other  material,  clean  it  to
expose the surface.

If the surface to be measured is highly refective, apply masking tape or a  matte
finish black paint to the surface.

If the probe seems to be giving incorrect readings  check the front of the probe.
There may be condensation or debris  obstructing the sensor; clean according
to maintenance instructions.
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Index

? (Help)     40

- 2 -
2D stacked, w aterfall charts [FIS View er]    

198

- 3 -
3D Areas, w aterfall charts [FIS View er]    

198

3D Mountains, w aterfall charts [FIS View er]

    198

3D Wireframe, w aterfall charts [FIS View er]

    198

- A -
Acceleration sensor     45, 82, 138

Acceleration signal     271

Access rights     24

Accumulator     214

charge and status     217

disposal     276

symbol     217

Active/passive sensor     45, 221

Adapter softw are     48

Administrator passw ord     31, 34, 91

Administrator permission     24

Akku     220

Alarm     117, 219, 226, 271

limits     87

Main alarm     13, 39, 87

Pre-alarm     13, 39, 87

Report     127, 132

Status     124

Symbols     39

thresholds     65

Alarm limit adjustment     87

Alarm limit adjustment reminder     58, 146

Alarm limit adjustment w ith the mouse     121

Alias, database name     93

Amplitude/phase    

configuration     249

diagram     249

report     134

Analog branches     273

Authentication, database     93

- B -
Back up database     102

Balancing measurement     82, 219

activate     48

Attach balance w eight     244

Determining resonance range     247

Display coeff icients     244

free     252

Measure rotational speed     239

procedure     234

Reference run     240

settings     234

Trial run     241

Trim run     245

Base cursor [FIS View er]     169

Base cursor, positioning of [FIS View er]    

178

Battery     214

Battery status     220

Baud rate     52

Bearing / Bearing database    

Add bearing     104

Add manufacturer     108

Back up database     102

Bearing database     102

Bearing list template     61

Close database     109

Damage frequencies     104

Edit / Delete manufacturer     109

Edit bearing     105
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Bearing / Bearing database    

Geometric data     104

import/export     106

Manage bearings     102

Manage groups     106

Manufacturer     104

Remove bearing     105

Search bearing     103

Select database     109

Template     58

Bearing database "cm_bearings"     29

Bias voltage     219, 222, 223, 263

Maximum value     45

BNC port     69, 216

- C -
Calculate spectrum [FIS View er]     170

Calibration     221

CE     278, 279

Change language    

Detector     219

Trendline     146

Characteristic value    

universal     232

Characteristic values     15, 269, 270

Cleaning     275

Clipboard, Settings  [FIS View er]     205

CM database     90, 93

CM measurement     223

free     252

cm_bearings     28, 109

cm_offlineDB0     28

cmuser user     91

Comment input on the Detector     58, 146

Comment, bearing     104

Comment, measurement     68

Comments [FIS View er]     191

Comments on the Detector     226

Comments, edit     213

Comments, measurement     117, 121, 127

Configuration     112, 127

Dynamic memory management     272

Measuring point     58

send     218

Configuration, create from template     112

Configuration, save as template     111

Configuration, set up     53

Connecting     274

Connections     216

Context menu     43

Contrast     220

Cursor information [FIS View er]     152, 158

Cursor tools [FIS View er]     169

Cursor type [FIS View er]     158

Cursor, positioning of base cursor [FIS

View er]     178

Cursor, Revolution cursor [FIS View er]    

188

Cursor, settings [FIS View er]     179

- D -
Data     150, 267

Bearing data     105

Data error     223, 263

delete     261

Import/export     136, 137, 138, 142

Load from Detector     115

receive     115

Sort     115

transfer     218

view      117, 121

Database     28

Administrator passw ord     28, 91

alias     93

back up     102

Bearing database     102

cmuser     28, 91

create     99
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Database     28

Database administration     95

database program     28

delete     101

Demo database     28

import data     142

installation     24

open     100

passw ords     91

sa     28, 91

select     93

server     22, 109

server instance     28, 91

Trendline-Database     148

update     35

user     28, 91

Database administration     95

attach database     96

detach database     98

Select database     93

update database     98

Date, show      219

Declaration of conformity     278, 279

Default user and passw ord, database     93

Delete    

data     124

Demo database "cm_offlineDB0"     29

Demodulation     270

Detector    

Analog branches     273

Calibration     219

characters     215

configure     52

Connecting     274

Delete data     218

delete measured data     261

Display     214, 215

dow nload log f ile     125

Dow nload measured data     115

enter comment     226

Info     219

Information     220

Keypad     212

Lighting     212

Measuring procedure     222

Menu     219

Pow er on/off     214

register new      52

RFID     21

Sensor cable, prepare for RFID     21

show  FFTs     230

show  time signals/trends     229

Symbols     215

Transfer data     218

Update f irmw are     267

Device menu     219

Device update     22

Diagram boundaries, change [FIS View er]    

186

Diagram infomration, copy [FIS View er]    

197

Diagram information [FIS View er]     159

Diagram information bar [FIS View er]     159

Diagram(s), export [FIS View er]     197

Diagram, modifying the appearance [FIS

View er]     161

Diagrams, display severals [FIS View er]    

161

Difference cursor [FIS View er]     172

Display     214

Display lighting     15, 220

Disposal     276

Dongle     50

- E -
Effective value     269

Elements, cut, copy, delete     43

Error messages     263

E-Service     126
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Export diagram(s) [FIS View er]     197

Export templates     144

- F -
Ferrite     21

FFT     223

display on Detector     230

lines     58

print     121, 127

FFTs (Fast Fourier Transformation) [FIS

View er]     152

FFTs, show  [FIS View er]     158

Firmw are installation     28

Firmw are update     22, 267

FIS View er    

Acceleration signal     161, 203

Base cursor     169, 178

Calculate spectrum     170

Change diagram boundaries     186

Change rotational speed     187

Characteristic values in trend diagram  

  190

Comments, insert     191

Copy diagram information     197

Copy diagram(s)     197

Copy measuring data     197

Cursor control w ith the mouse     164

Cursor information     152, 158

Cursor properties, general     179

Cursor settings     179

Cursor tools     169

Cursor type     158

Diagram     152

Diagram display     158, 161

Diagram info bar     152

Diagram information     159

Diagram information bar     159

Difference cursor     172

Display several diagrams     161

FFTs (Fast Fourier Transformation)    

152

Frequency bands     190

Harmonic cursor, properties     181

Harmonics, display     193

Highest peaks     192

HS cursor, properties     184

Introduction     152

Keyboard shortcuts     209

Kinematic frequencies     191

Maximum value     165

Maximum values (Maxima)     192

Measure cursor     170

Menu bar     153

Modify appearance of a diagram     161

Mouse control     164

Program settings     203

Revolutions cursor, properties     185

RMS/AMV cursor     173

Save diagram     197

show  FFT     203

show  FFTs     158

Sideband cursor, properties     183

Sidebands, display     194

Specify diagram dimensions     205

Synchronous zoom     164

time signals     152

Tool bar     153

Tools     152, 154, 185

Trend data     152

Units     204

Waterfall charts     198

Work interface areas     152

Zoom control w ith the mouse     164

Zoom tools     165

Flash Updater     267

Installation     24, 28

Uninstall     36

Update     35
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Free measurement    

Balancing measurement     252

CM measurement     252

Run up / coast dow n measurement    

252

Frequency     231, 273

kinematic     58

range     15, 230, 269, 271

resolution     15, 58, 270

Resonance frequency     263

selective characteristic values     270

Frequency bands, display [FIS View er]    

190

Functionality     12

- G -
General     12

Group, apply settings to [FIS View er]     186

GUID     136, 138

- H -
Harmonics [FIS View er]     193

Hazard symbols     11

Headset     15, 216, 219, 233, 260

Highest peaks [FIS View er]     192

Highpass     15, 45

Hot keys     43

- I -
ICP sensor    

Bias voltage     222

test     261

ICP sensor test     219

Imbalance     247

Balancing measurement     234

Balancing report     133

Test measurement     241, 245

Import templates     144

Information     11

Installation     22

System requirements     22

ISO 10816     258

ISO units [FIS View er]     204

- K -
Keyboard shortcuts [FIS View er]     209

Keypad (Detector)     212

Kinematic frequencies     58

Kinematic frequencies [FIS View er]     191

- L -
Language     220

LCD lighting     15, 220

Lighting, sw itch on/off     212

Listening     260

Log f ile Detector     263

Log f ile, save / dow nload     125

- M -
Maintenance     275

Manage groups     106

Manufacturer     108, 277

Manufacturer, edit / delete     109

Maximum value    

Bias voltage     45, 271

Time signal on Detector     271

Maximum value [FIS View er]     165

Maximum values, display [FIS View er]     192

Measure cursor [FIS View er]     170

Measurement    

add     231

at new  measuring point     252

Balancing measurement     234, 252

CM measurement     223, 252

discard     231

display on Detector     226

free     252
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Measurement    

Multiple measurements     231

perform     226

w ith RFID     54, 222

Measurement comments     117, 121, 127

Measurement data, delete     261

Measuring data, copy [FIS View er]     197

Measuring point    

automatically assign     54

Configure     58

Edit name     213

export     138

GUID     138

listening     260

manually assign     58

setup     138

Measuring point, cut, copy, delete     43

Measuring points     136

Memory management    

dynamic     272

on Detector     219

save     272

Memory manager     219, 220

Menu     40

Menu (Detector)     219

Menu item    

GUID     136

Micro steps, cursor settings [FIS View er]    

181

Mode of functioning     13

Mouse control [FIS View er]     164

MS SQL database program     22, 28

MS SQL database program, install     24

Multiple measurements     231

- N -
Names, edit     213

Nearest peaks, cursor properties [FIS

View er]     179

- O -
Order, change     43

- P -
Passw ords     91

Planning     109

Pow er dow n time     219, 222

Pow er on/off     214

Pre-alarm     65

alarm limit     87

Alarm threshold     226

Display     39

Report     127

Preferred units [FIS View er]     204

Previous measurements     226

Program installation     22

Program main menu     39

Program settings     145

Data view      150

Database     148

E-mail     149
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